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1 Introduction 
1.1 About this Manual 

This manual provides information on how to set and configure the device 
parameters of a netX based EtherNet/IP Adapter device within a FDT 
Framework using the EtherNet/IP Adapter DTM, and what can be read from 
the diagnosis panes. 

In a network project the EtherNet/IP Adapter DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a EtherNet/IP Scanner DTM. 
 

 
Note: This manual edition first provides information for the case if the 
EtherNet/IP Adapter DTM is dropped to the root line (Stand-Alone Slave) 
and in addition important information for the case if the EtherNet/IP 
Adapter DTM is dropped to the Master busline of a EtherNet/IP Scanner 
DTM. 
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1.1.1 Descriptions of the Dialog Panes 
The table below gives an overview for the individual dialog panes 
descriptions: 
 

Section Subsection Manual  
Page 

Settings Overview Settings  32 
 Driver 35 
 Device Assignment 45 
 Firmware Download 51 
Configuration Overview Configuration 57 
 General 61 
 Electronic Keying 64 
 Connection 65 
 Assembly 66 
 Signal Configuration 67 

 Device Settings 73 
Device Description Overview Description 75 
 Device Info 75 
Diagnosis Overview Diagnosis 82 
 General Diagnosis  83 
 Firmware Diagnosis 85 
Extended Diagnosis Overview Extended Diagnosis 86 
Tools Overview Tools  102 
 Packet Monitor 103 
 IO Monitor 106 

Table 1: Descriptions Dialog Panes 

1.1.2 Online Help 
The EtherNet/IP Adapter DTM contains an integrated online help. 

 To open the online help, click on Help or press F1. 
 
 
 
 

1.1.3 List of Revisions 
Index Date Version Chapter Revision 
13 20-01-28 1.1100 5.7      Section Signal Configuration added.  

Table 2: List of Revisions 
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1.1.4 Conventions in this Manual 

Notes, operation instructions and results of operation steps are marked as 
follows: 

Notes 
 
 

 

Important: <important note you must follow to avoid malfunction> 

 

 

Note:  <general note> 

 

 

<note, where to find further information> 

 

Operation Instructions 
 

1. <instruction> 

2. <instruction> 
 

or 
 

 <instruction> 

 

Results 
 

 <result> 
 
 
 

 

Langage Convention for EtherNet/IP 
The EtherNet/IP specification defines the term "Scanner" instead of 
"Master" and "Adapters" instead of "Slave". 
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1.2 Legal Notes 
 

Copyright 
© Hilscher Gesellschaft für Systemautomation mbH 

All rights reserved. 

The images, photographs and texts in the accompanying materials (in the 
form of a user's manual, operator's manual, Statement of Work document 
and all other document types, support texts, documentation, etc.) are 
protected by German and international copyright and by international trade 
and protective provisions. Without the prior written consent, you do not 
have permission to duplicate them either in full or in part using technical or 
mechanical methods (print, photocopy or any other method), to edit them 
using electronic systems or to transfer them. You are not permitted to make 
changes to copyright notices, markings, trademarks or ownership 
declarations. Illustrations are provided without taking the patent situation 
into account. Any company names and product designations provided in 
this document may be brands or trademarks by the corresponding owner 
and may be protected under trademark, brand or patent law. Any form of 
further use shall require the express consent from the relevant owner of the 
rights. 

Important notes 
Utmost care was/is given in the preparation of the documentation at hand 
consisting of a user's manual, operating manual and any other document 
type and accompanying texts. However, errors cannot be ruled out. 
Therefore, we cannot assume any guarantee or legal responsibility for 
erroneous information or liability of any kind. You are hereby made aware 
that descriptions found in the user's manual, the accompanying texts and 
the documentation neither represent a guarantee nor any indication on 
proper use as stipulated in the agreement or a promised attribute. It cannot 
be ruled out that the user's manual, the accompanying texts and the 
documentation do not completely match the described attributes, standards 
or any other data for the delivered product. A warranty or guarantee with 
respect to the correctness or accuracy of the information is not assumed. 

We reserve the right to modify our products and the specifications for such 
as well as the corresponding documentation in the form of a user's manual, 
operating manual and/or any other document types and accompanying 
texts at any time and without notice without being required to notify of said 
modification. Changes shall be taken into account in future manuals and do 
not represent an obligation of any kind, in particular there shall be no right 
to have delivered documents revised. The manual delivered with the 
product shall apply. 

Under no circumstances shall Hilscher Gesellschaft für Systemautomation 
mbH be liable for direct, indirect, ancillary or subsequent damage, or for 
any loss of income, which may arise after use of the information contained 
herein. 

Liability disclaimer 
The hardware and/or software was created and tested by Hilscher 
Gesellschaft für Systemautomation mbH with utmost care and is made 
available as is. No warranty can be assumed for the performance or 
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flawlessness of the hardware and/or software under all application 
conditions and scenarios and the work results achieved by the user when 
using the hardware and/or software. Liability for any damage that may have 
occurred as a result of using the hardware and/or software or the 
corresponding documents shall be limited to an event involving willful intent 
or a grossly negligent violation of a fundamental contractual obligation. 
However, the right to assert damages due to a violation of a fundamental 
contractual obligation shall be limited to contract-typical foreseeable 
damage. 

It is hereby expressly agreed upon in particular that any use or utilization of 
the hardware and/or software in connection with 

• Flight control systems in aviation and aerospace; 

• Nuclear fusion processes in nuclear power plants; 

• Medical devices used for life support and 

• Vehicle control systems used in passenger transport 

shall be excluded. Use of the hardware and/or software in any of the 
following areas is strictly prohibited: 

• For military purposes or in weaponry; 

• For designing, engineering, maintaining or operating nuclear systems; 

• In flight safety systems, aviation and flight telecommunications systems; 

• In life-support systems; 

• In systems in which any malfunction in the hardware and/or software 
may result in physical injuries or fatalities. 

You are hereby made aware that the hardware and/or software was not 
created for use in hazardous environments, which require fail-safe control 
mechanisms. Use of the hardware and/or software in this kind of 
environment shall be at your own risk; any liability for damage or loss due 
to impermissible use shall be excluded. 

Warranty 
Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that 
the software shall run without errors in accordance with the requirements 
listed in the specifications and that there were no defects on the date of 
acceptance. The warranty period shall be 12 months commencing as of the 
date of acceptance or purchase (with express declaration or implied, by 
customer's conclusive behavior, e.g. putting into operation permanently). 

The warranty obligation for equipment (hardware) we produce is 36 
months, calculated as of the date of delivery ex works. The aforementioned 
provisions shall not apply if longer warranty periods are mandatory by law 
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a 
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all 
due care taken, the delivered product should have a defect, which already 
existed at the time of the transfer of risk, it shall be at our discretion to 
either repair the product or to deliver a replacement product, subject to 
timely notification of defect. 

The warranty obligation shall not apply if the notification of defect is not 
asserted promptly, if the purchaser or third party has tampered with the 
products, if the defect is the result of natural wear, was caused by 
unfavorable operating conditions or is due to violations against our 
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operating regulations or against rules of good electrical engineering 
practice, or if our request to return the defective object is not promptly 
complied with. 

Costs of support, maintenance, customization and product care 
Please be advised that any subsequent improvement shall only be free of 
charge if a defect is found. Any form of technical support, maintenance and 
customization is not a warranty service, but instead shall be charged extra. 

Additional guarantees 
Although the hardware and software was developed and tested in-depth 
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall 
not assume any guarantee for the suitability thereof for any purpose that 
was not confirmed in writing. No guarantee can be granted whereby the 
hardware and software satisfies your requirements, or the use of the 
hardware and/or software is uninterruptable or the hardware and/or 
software is fault-free. 

It cannot be guaranteed that patents and/or ownership privileges have not 
been infringed upon or violated or that the products are free from third-party 
influence. No additional guarantees or promises shall be made as to 
whether the product is market current, free from deficiency in title, or can be 
integrated or is usable for specific purposes, unless such guarantees or 
promises are required under existing law and cannot be restricted. 

Confidentiality 
The customer hereby expressly acknowledges that this document contains 
trade secrets, information protected by copyright and other patent and 
ownership privileges as well as any related rights of Hilscher Gesellschaft 
für Systemautomation mbH. The customer agrees to treat as confidential all 
of the information made available to customer by Hilscher Gesellschaft für 
Systemautomation mbH and rights, which were disclosed by Hilscher 
Gesellschaft für Systemautomation mbH and that were made accessible as 
well as the terms and conditions of this agreement itself. 

The parties hereby agree to one another that the information that each 
party receives from the other party respectively is and shall remain the 
intellectual property of said other party, unless provided for otherwise in a 
contractual agreement. 

The customer must not allow any third party to become knowledgeable of 
this expertise and shall only provide knowledge thereof to authorized users 
as appropriate and necessary. Companies associated with the customer 
shall not be deemed third parties. The customer must obligate authorized 
users to confidentiality. The customer should only use the confidential 
information in connection with the performances specified in this 
agreement. 

The customer must not use this confidential information to his own 
advantage or for his own purposes or rather to the advantage or for the 
purpose of a third party, nor must it be used for commercial purposes and 
this confidential information must only be used to the extent provided for in 
this agreement or otherwise to the extent as expressly authorized by the 
disclosing party in written form. The customer has the right, subject to the 
obligation to confidentiality, to disclose the terms and conditions of this 
agreement directly to his legal and financial consultants as would be 
required for the customer's normal business operation. 
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Export provisions 
The delivered product (including technical data) is subject to the legal 
export and/or import laws as well as any associated regulations of various 
countries, especially such laws applicable in Germany and in the United 
States. The products / hardware / software must not be exported into such 
countries for which export is prohibited under US American export control 
laws and its supplementary provisions. You hereby agree to strictly follow 
the regulations and to yourself be responsible for observing them. You are 
hereby made aware that you may be required to obtain governmental 
approval to export, reexport or import the product. 
 

 

1.3 Registered Trademarks 
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1 
and Windows® 10 are registered trademarks of Microsoft Corporation. 

EtherNet/IP™ is a trademark of ODVA (Open DeviceNet Vendor 
Association, Inc). 

CODESYS® is a registered trademark of 3S-Smart Software Solutions 
GmbH, Deutschland. 

All other mentioned trademarks are property of their respective legal 
owners. 
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1.4 About EtherNet/IP Adapter DTM 
You can use the EtherNet/IP Adapter DTM to configure EtherNet/IP 
Adapter devices within a FDT Framework and to view the device diagnosis. 

In a network project the EtherNet/IP Adapter DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a EtherNet/IP Scanner DTM. 

 

Adapter DTM at the Root-Line (Stand-Alone Slave) 
Insert the EtherNet/IP Adapter DTM to the root busline if you intend to 
configure only one single EtherNet/IP Adapter device. 

Adapter DTM at the Master Busline 
Insert the EtherNet/IP Adapter DTM to the Scanner busline of the 
EtherNet/IP Scanner DTM if within the network project the Adapter device 
and the Scanner device are used, i. e. if you intend to configure the Adapter 
device and the Scanner device. 
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1.4.1 Requirements 

System Requirements 

• PC with 1 GHz processor or higher 

• Windows® XP SP3,  
Windows® Vista (32-Bit) SP2,   
Windows® 7 (32-Bit and 64-Bit) SP1,   
Windows® 8 (32-Bit and 64-Bit),  
Windows® 8.1 (32-Bit and 64-Bit),   
Windows® 10 (32-Bit and 64-Bit) 

• Administrator privilege required for installation 

• Internet Explorer 5.5 or higher 

• RAM: min. 512 MByte, recommended 1024 MByte 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 

• Restriction: Touch screen is not supported. 
 

 

Note: If the project file is used on a further PC,  

 this PC must also comply with the above system requirements, 

 the device description files of the devices used in the project must be 
imported into the configuration software SYCON.net on the new PC, 

 and the DTMs of the devices used in the project must also be installed 
on that further PC. 

 
 
 

Requirements EtherNet/IP Adapter DTM 
To configure the EtherNet/IP Adapter device with the EtherNet/IP Adapter 
DTM the following requirements have to be accomplished: 

• Completed hardware installation of a netX based DTM-compatible 
EtherNet/IP Adapter device, inclusive loaded firmware and loaded 
configuration file 

• Installed FDT/DTM V 1.2 compliant frame application 

• Installed EtherNet/IP Scanner DTM (If Adapter DTM is dropped to the 
Master busline.) 

• Loaded DTM in the Device Catalog of the FTD Framework 
 

 
Note: If the EtherNet/IP Adapter DTM and the EtherNet/IP Adapter device 
are installed on the same PC, the cifX Device Driver must be installed on 
that PC, as you can connect the DTM to the device.  

 

 

For more information to the hardware installation, please refer to the 
corresponding User Manual of your device.  
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1.5 Dialog Structure of the EtherNet/IP Adapter DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
DTM. 

 

 
Figure 1: Dialog Structure of the EtherNet/IP Adapter DTM 

 

 



Introduction 16/155 

DTM for EtherNet/IP Adapter Devices | Configuration of EtherNet/IP Adapter Devices  
DOC061202OI13EN | Revision 13 | English | 2020-01 | Released | Public  © Hilscher, 2006-2020 

1.5.1 General Device Information 
 

Parameter Meaning 
IO Device Name of the device 

Vendor Vendor name of the device 

Device ID Identification number of the device 

Vendor ID Identification number of the vendor 

Table 3: General Device Information 

 
 

1.5.2 Navigation Area 
The Navigation Area contains folders and subfolders to open the dialog 
panes of the DTM. 
 

 
Figure 2: Navigation Area 

 

 Select the required folder and subfolder. 

 The corresponding Dialog pane is displayed.  

Hide / display Navigation 
 

 Hiding the navigation area (above right side). 

 
Opening the navigation area (below left side). 
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1.5.3 Dialog Panes 
At the dialog pane the Settings, Configuration, Description, 
Diagnosis/Extended Diagnosis or the Tools panes are opened via the 
corresponding folder in the navigation area. 
 

Settings 
   Driver To establish a connection from the EtherNet/IP Adapter DTM to the EtherNet/IP 

Adapter device, on the pane Driver you can verify if the default driver is checked and 
respectively check another driver or multiple drivers. For further information, refer to 
section Driver on page 35. 

    Device Assignment On the pane Device Assignment you select the device and assign the device to the 
driver. For further information, refer to section Device Assignment on page 45. 

   Firmware Download The dialog on the pane Firmware Download is used to load a new firmware into the 
device. A detailed description can be found in section Firmware Download on page 51. 

Configuration 
   General On the pane General EtherNet/IP Adapter information is displayed. For ‘Quick 

Connect’ the Adpater devices must be configured as MDI oder MDIX. For further 
information, refer to section General on page 61. 

   Electronic Keying At the Electronic Keying pane for online validation of adapters an electronic keying 
method can be selected and the keying can be configured. For further information, refer 
to section Electronic Keying on page 64. 

   Connection At the Connection pane the connection can be parameterized. For further information, 
refer to section Connection on page 65 . 

   Assembly At the Assembly pane the configured input / output connections of the EtherNet/IP 
adapter are displayed. For further information, refer to section Assembly on page 66. 

   Signal Configuration In the Signal Configuration pane the data structure of the input and output data for the 
signal assignment is determined. For further information, refer to section Signal 
Configuration on page 67. 

   Device Settings At the Device Settings pane device related settings can be made. For further 
information, refer to section Device Settings on page 73. 

Description 

   Device Info The Device Info pane contains the manufacturer information about the device. For 
further information, refer to section Overview Description on page 75 . 

Diagnosis 

   Diagnosis/ 
   Extended Diagnosis 

At the Diagnosis panes information can be read for troubleshooting. For further 
information, refer to section Overview Diagnosis on page 82 or section Overview 
Extended Diagnosis on page 86. 

Tools 

   Packet Monitor/ 
   IO Monitor 

Under Tools the Packet Monitor and the IO Monitor are provided for test and 
diagnosis purposes. For further information, refer to section Packet Monitor on page 
103 or section IO Monitor on page 106. 

Table 4: Overview Dialog Panes 

 

 
Note: Accessing the Diagnosis panes of the EtherNet/IP Adapter DTM 
requires an online connection from the EtherNet/IP Adapter DTM to the 
EtherNet/IP Adapter DTM.  

 

For further information, refer to section Connecting/Disconnecting Device 
on page 77. 
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1.5.4 OK, Cancel, Apply and Help 
OK, Cancel, Apply and Help you can use as described hereafter. 
 

 Meaning 
OK To confirm your latest settings, click OK. All changed values will be applied on the frame application 

database.  
The dialog then closes. 

Cancel To cancel your latest changes, click Cancel.  
Answer to the safety query Configuration data has been changed. Do you want to save the data? 
by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on the frame application 
database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application 
database.  
The dialog remains opened. 

Help To open the DTM online help, click Help.  

Table 5: OK, Cancel, Apply and Help 

 

1.5.5 Table Lines 
In the DTM dialog pane table lines can be selected, inserted or deleted. 
 

 Meaning 

 
To select the first line of a table use First Line. 

 
To select the previous line of a table use Previous Line. 

 
To select the next line of a table use Next Line. 

 
To select the last line of a table use Last Line. 

 
Create a new Line inserts new lines into the table. 

 
Delete selected Line deletes the selected line from the table.  

Table 6: Selecting, inserting, deleting Table Line 
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1.5.6 Status Bar 
The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. download, is signaled graphically via icons in the 
status bar. 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

4 Changes directly made on the Device 
 

 
Load/configure diagnosis parameters: Diagnosis is activated. 

6 Device Diagnosis Status 

 
 

Save operation succeeded: The save operation has been successful. 

Further messages due to successful handling of device data. 
   Firmware Download: Firmware Download is running 

 
 

Save operation failed: The save operation has failed. 

Further fail operation messages due to incorrect communication due to 
malfunction in the field device or its peripherals. 

Table 7: Status Bar Icons [1] 

 

Offline State 
 

 
Save operation 
succeeded  

 
Firmware Download 

 
 

Firmware Download 
successful  

 
Online State and 
Diagnosis  

Figure 4: Status Bar Display Examples 
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2 Safety 
 
 

2.1 General Note 
The documentation in the form of a user manual, an operating instruction 
manual or other manual types, as well as the accompanying texts have 
been created for the use of the products by educated personnel. When 
using the products, all Safety Messages, Integrated Safety Messages, 
Property Damage Messages and all valid legal regulations must be obeyed. 
Technical knowledge is presumed. The user has to assure that all legal 
regulations are obeyed. 
 

2.2 Intended Use 
The EtherNet/IP Scanner DTM serves for configuration and diagnosis of 
EtherNet/IP Scanner devices.  
 

2.3 Personnel Qualification 
Personnel responsible for the application of the network system shall be 
aware of the system behavior and shall be trained in using the system. 
 
 

2.4 Safety Instructions 
To ensure your own personal safety and to avoid personal injury, you 
necessarily must read, understand, and comply with the safety instructions 
and safety messages in this manual before you install and operate your 
system. 

For cases if both, personal injury as well as property damage (damage of 
equipment or device) may occur together, you find the safety instructions in 
this section. 
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2.4.1 Communication Stop during Firmware or Configuration 
Download 

If you want to perform either a firmware update (as a download) or a 
configuration download, both via the EtherNet/IP Adapter DTM, be aware of 
the following: 

• Together with the firmware download, an automated reset to the device 
is performed that will interrupt all network communication and all 
established connections will drop. 

• If you download the configuration during bus operation, the 
communication between master and slaves is stopped. 

Possible faulty System Operation 

• An unpredictable and unexpected behavior of machines and plant 
components may cause personal injury and property damage. 

 Stop the application program, before starting the firmware update or 
before downloading the configuration. 

 Make sure that your equipment operates under conditions that prevent 
personal injury or property damage. All network devices should be 
placed in a fail-safe mode, before starting the firmware update or before 
downloading a configuration. 

Loss of Device Parameters, Overwriting of Firmware 

• Both the firmware download and the configuration download erase the 
configuration data base. The firmware download overwrites the existing 
firmware in the network device. 

 To complete the firmware update and to make the device operable 
again, re-load the configuration after the firmware update has been 
finished. 

• Device parameters that have been saved volatile, e. g. as the 
temporarily set IP address parameters, are getting lost during the reset. 

 In order to prevent loss of configuration data, make sure that your 
project configuration data are saved non-volatile, before you initiate a 
firmware update or download the configuration. 

 

2.4.2 Mismatching System Configuration 
Mismatching system configuration loaded into the device could result in 
faulty data mapping in the application program and thus unexpected 
equipment operation may cause personal injury or damage of equipment. 

 In the device use only a configuration suitable for the system. 
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2.5 Property Damage 
To avoid property damage and damage to your system or to your 
equipment, you necessarily must read, understand, and comply with the 
safety instructions and safety messages in this manual before you 
configure your system. 
 
 

2.5.1 Power Disconnect while dowloading Firmware or Configuration  
 

If during the process of downloading a firmware or configuration 

• the power supply to a PC with the software application is interrupted, 

• or the power supply to the EtherNet/IP Adapter device is interrupted, 

• or a reset to the device is performed, 

this may lead to the following consequences: 

Loss of Device Parameters, Firmware Corruption 

• The firmware download or the configuration download will be interrupted 
and remains incomplete. 

• The firmware or the configuration database will be corrupted and device 
parameters will be lost. 

• Device damage may occur as the device cannot be rebooted. 

Whether these consequences occur depends on when the power 
disconnect occurs during the download. 
 

Power Drop during Write and Delete Accesses in the File System 
The FAT file system in the netX firmware is subject to certain limitations in 
its operation. Write and delete accesses in the file system (firmware 
update, configuration download etc.) can destroy the FAT (File Allocation 
Table) if the accesses cannot be completed if the power drops. Without a 
proper FAT, a firmware may not be found and cannot be started. 

Make sure that the power supply to the device is not interrupted during 
write and delete accesses in the file system (firmware update, configuration 
download, etc.). 
 
 

2.5.2 Invalid Firmware 
Loading invalid firmware files could render your device unusable.  

 Only download firmware files to the device that are valid for this device. 

Otherwise you might be forced to return your device for repair. 
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2.6 Labeling of Safety Messages 
• The Section Safety Messages at the beginning of a chapter are 

pinpointed particularly and highlighted by a signal word according to the 
degree of endangerment. The type of danger is specified by the safety 
message text  

• The Integrated Safety Messages within an instruction description are 
highlighted with a signal word according to the degree of endangerment. 
The kind of danger is specified exactly by the safety message text.  

 

Signal Word Meaning (International) Meaning (USA) 

 Indicates a direct hazard with high risk, which 
will have a consequence of death or grievous 
bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, will result in death or serious injury. 

 Indicates a possible hazard with medium risk, 
which will have a consequence of death or 
(grievous) bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, could result in death or serious injury. 

 Indicates a minor hazard with medium risk, 
which could have a consequence of minor or 
moderate bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, may result in minor or moderate injury. 

 Indicates a property damage message. Indicates a property damage message. 

Table 8: Signal Words 

 

Note: The ANSI Z535.6 standard specifies in section 4.8: "Messages 
about hazards that could result in both, physical injury and property 
damage are considered safety messages, not property damage 
messages." Thus depending of the type of danger and its consequences, 
warning messages marked by a signal word DANGER, WARNING or 
CAUTION may include both, messages on physical injury and property 
damage. 

 

In this document all Safety Instructions and Safety Messages are designed 
according both to the international used safety conventions as well as to 
the ANSI Z535.6 standard, refer to safety reference [S1]. 
 

In this document the signal words ‘WARNING’, ‘CAUTION’ and ‘NOTICE’ are used 
according to ANSI Z535.6 standard. The meaning given in ISO/IEC 26514 [S4] section 
‘11.11 Contents of warnings and cautions’ is not relevant in this manual. 

2.7 References Safety 
 

[S1] ANSI Z535.6-2011 American National Standard for Product Safety Information in 
Product Manuals, Instructions, and Other Collateral Materials 

 
 

[S4] 26514-2010  -  IEEE Standard for Adoption of ISO/IEC 26514:2008 Systems and 
Software Engineering--Requirements for Designers and Developers of User 
Documentation 
 

 
 
 



Getting started 24/155 

DTM for EtherNet/IP Adapter Devices | Configuration of EtherNet/IP Adapter Devices  
DOC061202OI13EN | Revision 13 | English | 2020-01 | Released | Public  © Hilscher, 2006-2020 

3 Getting started 
 

3.1 Configuration Steps 
The following overview provides to you the step sequence on how to 
configure a netX based EtherNet/IP Adapter device with EtherNet/IP 
Adapter DTM as it is typical for many cases. At this time it is presupposed 
that the hardware installation was done. 

The overview lists all the steps in a compressed form. For detailed 
descriptions of each step refer to the sections noted in the column For 
detailed information see section. 

The following two cases are considered: 

• Adapter DTM at the Root-Line (Stand-Alone Slave)  

• and Adapter DTM at the Scanner busline.  
 

3.1.1 Adapter DTM at the Root-Line (Stand-Alone Slave) 
# Step Short Description For detailed information 

see section 
Page 

1 Load device 
catalog 

Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Create new 
project / 
Open existing 
project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

3 Insert Adapter 
into 
configuration 

Depending of the FDT Container: 
For netDevice: 
- in the Device Catalog under Gateway / Stand-
Alone Slave click to the Adapter, 
- and insert the Adapter via drag and drop  
to the root line in the network view. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

4 Open the 
Adapter DTM 
configuration 
dialog 

Open the Adapter DTM configuration dialog. 
- Double click to the device icon of the Adapter. 
- The Adapter DTM configuration dialog is 
displayed. 

- - 
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# Step Short Description For detailed information 
see section 

Page 

5 Verify or adapt 
Driver Settings 

In the Slave DTM configuration dialog: 
- select Settings > Driver. 

 
• Note! For PC cards cifX the cifX 

Device Driver is preset as a default 
driver. For all the other Hilscher devices 
the netX Driver is preset as a default 
driver.Use the cifX Device Driver if the 
EtherNet/IP Adapter DTM is installed on 
the same PC as the EtherNet/IP 
Adapter device. 

• Use the netX Driver to establish a 
USB, Serial (RS232) or TCP/IP 
connection from the EtherNet/IP 
Adapter DTM to the EtherNet/IP 
Adapter device. 

• The 3SGateway Driver for netX (V3.x) 
is used only in relationship with 
CODESYS. 

To search for devices you can check one 
or multiple drivers simultaneously. 

- Verify that the default driver is checked. 
- If necessary, check another driver or multiple 
drivers. 

Settings for Driver and 
Device Assignment 
and 
Driver  

33 
 
 
35 

6 Configure Driver If you use the netX Driver, you respectively must 
configure it. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 
Adjust the driver parameters netX Driver 
USB/RS232 only if they differ from the default 
settings. 

 

Note!  
• The cifX Device Driver requires no 

configuration. 
• The configuration of the 3SGateway 

Driver for netX (V3.x) is carried out via 
the CODESYS surface. 

 

 
Configuring netX Driver 
 
 

 
38 
 

7 Assign Adapter 
device (with or 
without 
firmware) 
 

Assign the device to this driver. 
In the Adapter DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Adapter device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select Apply. 

Selecting the Device (with 
or without firmware) 

48 

8 Select and 
download 
firmware 

If not yet a firmware was loaded to the device: 
- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage 
In the Adapter DTM configuration dialog: 
- select Settings > Firmware Download, 
- select Browse.., 
- select a firmware file, 
- select Open, 
- select Download and Yes. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Firmware Download 

31 
 
 
 
51 
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# Step Short Description For detailed information 
see section 

Page 

9 Assign Adapter 
device once 
more (with 
firmware and 
system chanal) 
For repeated 
download this 
step is omitted. 

In the Adapter DTM configuration dialog: 
- select Settings > Device Assignment, 
- select Scan, 
- select the Adapter device (with loaded firmware 
and defined system channel), 
- therefore check the appropriate checkbox, 
- select Apply, 
- close the Adapter DTM configuration dialog via 
OK. 

Selecting the Device once 
more (with Firmware) 

49 

10 Configure 
Adapter device 

Configure the Adapter device. 
- Double click to the device icon of the Adapter. 
- The Adapter DTM configuration dialog is 
displayed. 
In the Adapter DTM configuration dialog: 
- select Configuration > General  
(for configuration without scanner only). 
For ‘Quick Connect’ the Adapter devices must be 
configured as MDI oder MDIX. 
- Set the IP settings for the adapter device, 
- select Configuration > Electronic Keying, 
- select the keying method and configure it if 
necessary,  
- select Configuration > Connection, 
- configure the connection points,  
- select Configuration > Assembly, 
- configure Instance ID and Data length,  
- select Configuration > Signal Configuration, 
- proceed the signal configuration, 
- Select Configuration > Device Settings, 
- set the Device Settings, 
- configure the device settings, 
- close the Adapter DTM configuration dialog via 
OK. 

Configuring Adapter 
Parameters 
 
 
 
General 
 
 
 
 
Electronic Keying 
 
 
Connection 
 
Assembly 
 
Signal Configuration  
 
Device Settings   

58 
 
 
 
 
61 
 
 
 
 
64 
 
 
65 
 
66 
 
67 
 
73  

11 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

12 Connect 
Adapter device 

Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Connect. 

Connecting/Disconnecting 
Device 

77 

13 Download 
Configuration 

- Adhere to the necessary safety precautions to 
prevent personnel injury and property damagen. 
Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Adapter, 
- select Download. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Download Configuration  

31 
 
 
 
79   

14 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Diagnosis. 
- The Adapter DTM diagnosis dialog is displayed. 
(1) Check whether the communication is OK: 
Diagnosis > General Diagnosis > Device status 
"Communication" must be green! 
(2) "Communication" is green: Open thel IO 
Monitor and test the input or output data. 
(3) "Communication" is not green: Use Diagnosis 
and Extended diagnosis for troubleshooting. 
- close the Adapter DTM diagnosis dialog via OK. 

Overview Diagnosis 82 
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# Step Short Description For detailed information 
see section 

Page 

15 IO Monitor Depending of the FDT Container: 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Diagnosis,  
- select Tools > IO Monitor.  
- Check the input or output data, 
- close the IO Monitor dialog via OK. 

IO Monitor 106 

16 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Adapter, 
- select Disconnect. 

Connecting/Disconnecting 
Device 

77 

Table 9: Getting started - Configuration Steps (Adapter DTM at the Root-Line (Stand-Alone 
Slave)) 

 

3.1.2 Adapter DTM at the Master busline 
# Step Short Description For detailed information 

see section 
Page 

1 Load device 
catalog 

Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Create new 
project / 
Open existing 
project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See Operating Instruction 
Manual of the Frame 
Application) 

- 

3 Insert Scanner 
or Adapter into 
configuration 

For netDevice: 
- in the Device Catalog click to the Scanner, 
- and insert the device via drag and drop  
to the root line in the network view, 
- in the Device Catalog click to the Adapter, 
- and insert the device via drag and drop  
to the Master bus line in the network view. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

4 Open the 
Adapter DTM 
configuration 
dialog 

Open the Adapter DTM configuration dialog. 
- Double click to the device icon of the Adapter. 
- The Adapter DTM configuration dialog is 
displayed. 

- - 
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# Step Short Description For detailed information 
see section 

Page 

5 Verify or adapt 
Driver Settings 

In the Adapter DTM configuration dialog: 
- select Settings > Driver. 

 
• Note! For PC cards cifX the cifX 

Device Driver is preset as a default 
driver. For all the other Hilscher devices 
the netX Driver is preset as a default 
driver.Use the cifX Device Driver if the 
EtherNet/IP Adapter DTM is installed on 
the same PC as the EtherNet/IP 
Adapter device. 

• Use the netX Driver to establish a 
USB, Serial (RS232) or TCP/IP 
connection from the EtherNet/IP 
Adapter DTM to the EtherNet/IP 
Adapter device. 

• The 3SGateway Driver for netX (V3.x) 
is used only in relationship with 
CODESYS. 

To search for devices you can check one 
or multiple drivers simultaneously. 

 

- Verify that the default driver is checked. 
- If necessary, check another driver or multiple 
drivers. 

Settings for Driver and 
Device Assignment 
and 
Driver  

33 
 
 
35 

6 Configure Driver If you use the netX Driver, you respectively must 
configure it. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 
Adjust the driver parameters netX Driver 
USB/RS232 only if they differ from the default 
settings. 

 
Configuring netX Driver 
 
 

 
38 
 

6 Configure Driver 
(continued) 

 

Note!  
• The cifX Device Driver requires no 

configuration. 
• The configuration of the 3SGateway 

Driver for netX (V3.x) is carried out via 
the CODESYS surface. 

 

 
Configuring netX Driver 
 
 

 
38 
 

7 Assign Adapter 
device (with or 
without 
firmware) 

Assign the device to this driver. 
In the Adapter DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Adapter device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select Apply. 

Selecting the Device (with 
or without firmware) 

48 

8 Select and 
download 
firmware 

If not yet a firmware was loaded to the device: 
- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage 
In the Adapter DTM configuration dialog: 
- select Settings > Firmware Download, 
- select Browse.., 
- select a firmware file, 
- select Open, 
- select Download and Yes. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Firmware Download 

31 
 
 
 
51 
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# Step Short Description For detailed information 
see section 

Page 

9 Assign Adapter 
device once 
more (with 
firmware and 
system chanal) 
For repeated 
download this 
step is omitted. 

In the Adapter DTM configuration dialog: 
- select Settings > Device Assignment, 
- select Scan, 
- select the Adapter device (with loaded firmware 
and defined system channel), 
- therefore check the appropriate checkbox, 
- select Apply, 
- close the Adapter DTM configuration dialog via 
OK. 

Selecting the Device once 
more (with Firmware) 

49 

10 Configure 
Adapter device 

Configure the Adapter device. 
- Double click to the device icon of the Adapter. 
- The Adapter DTM configuration dialog is 
displayed. 
In the Adapter DTM configuration dialog: 
- select Configuration > Electronic Keying, 
- select the keying method and configure it if 
necessary,  
- select Configuration > Connection, 
- configure the connection points,  
- select Configuration > Assembly, 
- configure Instance ID and Data length,  
- select Configuration > Signal Configuration, 
- proceed the signal configuration, 
- select Configuration > Device Settings, 
- set the Device Settings. 
- configure the device settings, 
- close the Adapter DTM configuration dialog via  
OK. 

Configuring Adapter 
Parameters 
 
 
 
Electronic Keying 
 
 
Connection 
 
Assembly 
 
Signal Configuration  
 
Device Settings 

58 
 
 
 
 
64 
 
 
65 
 
66 
 
67 
 
73 

11 Configure 
Scanner device  

Configure the Scanner device via the EtherNet/IP 
Scanner DTM netX. 

(See Operating Instruction 
Manual DTM for 
EtherNet/IP Scanner 
devices) 

- 

12 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

13 Connect Adapter 
device 

Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Connect. 

Connecting/Disconnecting 
Device 

77 

14 Download 
Configuration 

- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage. 
Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Adapter, 
- select Download. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Download Configuration  

31 
 
 
 
79   

15 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Diagnosis. 
- The Adapter DTM diagnosis dialog is displayed. 
(1) Check whether the communication is OK: 
Diagnosis > General Diagnosis > Device status 
"Communication" must be green! 
(2) „Communication“ is green: Open thel IO 
Monitor and test the input or output data. 
(3) „Communication“ is not green: Use Diagnosis 
and Extended diagnosis for troubleshooting. 
- close the Adapter DTM diagnosis dialog via OK. 

Overview Diagnosis 82 
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# Step Short Description For detailed information 
see section 

Page 

16 IO Monitor Depending of the FDT Container: 
For netDevice: 
- right click to the device icon of the Adapter, 
- select Diagnosis,  
- select Tools > IO Monitor.  
- Check the input or output data, 
- close the IO Monitor dialog via OK. 

IO Monitor 106 

17 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Adapter, 
- select Disconnect. 

Connecting/Disconnecting 
Device 

77 

Table 10: Getting started - Configuration Steps (Adapter DTM at the Master busline) 
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3.2 Safety Messages on Firmware or Configuration Download 
If you perform a firmware download or a configuration download via the 
EtherNet/IP Adapter DTM be aware of the following: 
 

  
Communication Stop caused by Firmware or Configuration Download 
Initiating a firmware or configuration dowload process during bus operation 
will stop the communication and a subsequent plant stop may cause 
unpredictable and unexpected behavior of machines and plant 
components, possibly resulting in personal injury and damage to your 
equipment. 
The firmware download overwrites the existing firmware. The 
communication stop may cause loss of device parameters and possible 
device damage may occur. 
 Stop the application program, before you start the firmware or 

configuration dowload. 

 Make sure that all network devices are placed in a fail-safe condition. 
 
 

  
Mismatching System Configuration 
Mismatching system configuration loaded into the device could result in 
faulty data mapping in the application program and thus unexpected 
equipment operation may cause personal injury or damage of equipment. 
 In the device use only a configuration suitable for the system. 
 
 

 
 

 

 
Power Disconnect while dowloading Firmware or Configuration 
If the power supply to the PC or device is interrupted while the firmware or 
configuration is being downloaded, the download will be aborted, the 
firmware may be corrupted, the device parameters may be lost, and the 
device may be damaged. 
 During firmware or configuration download process do not interrupt the 

power supply to the PC, or to the device and do not perform a reset to 
the device! 

 
 
 

 

 

 
Invalid Firmware 
Loading invalid firmware files could render your device unusable. 
 Only proceed with a firmware version valid for your device. 
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4 Settings 
4.1 Overview Settings 

Settings Dialog Panes 
The table below gives an overview for the individual Settings dialog panes 
descriptions: 
 

EtherNet/IP Adapter 
DTM 

Folder Name / 
Section 

Subsection Manual 
Page 

 
Navigation Area – 
Settings (Example) 
Additional drivers can be 
displayed. 

Driver  35 

 Verify or adapt Driver Settings 35 

 cifX Device Driver 37 

 netX Driver 37 
  Configuring netX Driver 38 

Device Assignment  45 

 Scanning for Devices 45 

  Scanning for all Devices or for suitable only 47 

 Selecting the Device (with or without firmware) 48 

 Selecting the Device once more (with Firmware) 49 
Firmware Download  51 

Table 11: Descriptions of the Dialog Panes Settings 

 
 

 
Note: To edit the Settings dialog panes you need User Rights for 
“Maintenance”. 

 
 

 

Notice the descriptions in the section Settings for Driver and Device 
Assignment on page 33. 

 

To access to the online help with the descriptions of the drivers: 

 Select Settings > Driver > [Name of the assigned driver]. 

 Press the F1 key. 
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4.2 Settings for Driver and Device Assignment 
 
 

The following steps are needed to establish a connection from the 
EtherNet/IP Adapter DTM to the EtherNet/IP Adapter device: 

Verifying or adapting Driver Settings 
Verify the Driver Settings and adapt them if necessary. 
 

1. Open the DTM configuration dialog. 

 In the FDT container netDevice double click to the EtherNet/IP Adapter 
device icon. 

2. Verify that the default driver is checked and respectively check another 
or multiple drivers. 

 

 Select Settings > Driver. 
 

 
Note! For PC cards cifX the cifX Device Driver is preset as a default 
driver. For all the other Hilscher devices the netX Driver is preset as a 
default driver. 
 Use the cifX Device Driver if the EtherNet/IP Adapter DTM is installed 

on the same PC as the EtherNet/IP Adapter device. 
 Use the netX Driver to establish an USB, Serial (RS232) or TCP/IP 

connection from the EtherNet/IP Adapter DTM to the EtherNet/IP 
Adapter device. 
 The 3SGateway Driver for netX (V3.x) is used only in relationship with 

CODESYS. 
 To search for devices on the network you can check one or multiple 

drivers simultaneously. 
 

 Verify that the default driver for your device is checked. 

 If necessary, check another driver or multiple drivers. 

Configuring Driver 
 

 
Note! 
 The cifX Device Driver requires no configuration. 
 The configuration of the 3SGateway Driver for netX (V3.x) is carried 

out via the CODESYS surface. 
 

If you use the netX Driver, you respectively must configure it. 

3. Configure the netX Driver if necessary. 

For the driver netXDriver an individual driver dialog window can be opened 
where you can configure the driver. 

 Select Settings > Driver > netX Driver. 
 For netX Driver and communication via TCP/IP set the IP address of 

the device. 

Adjust the driver parameters netX Driver USB/RS232 only if they differ 
from the default settings. 
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Assigning the Adapter device to the DTM 
4. Scan for and select the devices (with or without firmware). 

 Select Settings > Device Assignment. 
 Under Device selection select suitable only or all and then Scan. 

 In the table check the required devices. 

 Select Apply. 

Selecting and downloading the Firmware 
5. If not yet a firmware was loaded to the device, select and download the 

firmware. 

 Select Settings > Firmware Download. 

 Select and download the firmware via Download. 

 Select Apply. 

6. Scan for and select the devices (with firmware and defined system 
channel) once more. 

For repeated download this step is omitted. 

 Select Settings > Device Assignment. 
 Select Scan. 

 In the table check the required device. 

7. Close the DTM configuration dialog via OK. 

Connecting the Device 
8. In netDevice put a right-click on the EtherNet/IP Adapter device icon. 

9. Select the Connect command from the context menu. 

 In the network view the device description at the device icon of the 
Adapter is displayed with a green colored background. The EtherNet/IP 
Adapter device now is connected to the EtherNet/IP Adapter DTM via 
an online connection. 

Further Information 

 

For descriptions about these steps refer to the sections following here-
after.  
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4.3 Driver 
The Driver dialog pane displays the drivers to be used for a EtherNet/IP 
Adapter DTM to establish a device communication connection.  
 

 
Note! A default driver is set in the configuration software.  

 

 
Figure 5: Default Driver ‚cifX Device Driver’ for PC cards cifX  

Parameter Meaning 
Driver Name of the driver (for more details see descriptions hereafter) 

Version  ODMV3 Version of the respective driver 

ID ID of the driver (driver identification) 

Table 12: Driver Selection List Parameters 

To establish a connection from the EtherNet/IP Adapter DTM to the 
EtherNet/IP Adapter device, verify if the default driver is checked and 
respectively check another driver or multiple drivers. 
 
 

4.3.1 Verify or adapt Driver Settings 
Proceed as follows: 

1. Select Settings > Driver in the navigation area. 

 The Driver dialog pane is displayed with the available drivers and the 
setting for the default driver.  

 
Figure 6: Default Driver ‚cifX Device Driver’ for PC cards cifX (example) 

 
Figure 7: Default Driver ‚netX Driver’ for Hilscher devices except for PC cards cifX (example) 

2. Verify that the default driver is checked. 
 

 Verify that the default driver for your device is checked. 
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Default Driver (Pre-settings in the Configuration Software): For PC cards 
cifX the cifX Device Driver is preset as a default driver. For all the other 
Hilscher devices the netX Driver is preset as a default driver. 
 

3. Respectively check another driver. 
 

 
Note! The driver used for the connection from the EtherNet/IP Adapter 
DTM to the EtherNet/IP Adapter device must be supported by the device 
and must be available for the device. 

 

• Use the cifX Device Driver if the EtherNet/IP Adapter DTM is installed 
on the same PC as the EtherNet/IP Adapter device. 

• Use the netX Driver to establish a USB, Serial (RS232) or TCP/IP 
connection from the EtherNet/IP Adapter DTM to the EtherNet/IP 
Adapter device. 

• The 3SGateway Driver for netX (V3.x) is used only in relationship with 
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH. 

 Check the checkbox for the driver in the selection list. 
 

4. Respectively check multiple drivers. 

To search for devices on the network you can check multiple drivers 
simultaneously. 

 
Figure 8: Manual Selection of multiple drivers (Example) 
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4.3.2 cifX Device Driver 
In the EtherNet/IP Adapter-DTM for the cifX Device Driver no driver dialog 
pane is available, since for the cifX Device Driver no driver settings are 
required. 

The cifX Device Driver will be used if the EtherNet/IP Adapter DTM is 
installed in the same PC as the EtherNet/IP Adapter device.  
 

 
Note: To establish a connection from a DTM to a Adapter device via the 
cifX Device Driver, the cifX Device Driver must be installed and the 
driver must have access to the Adapter device. 

 

 

 

4.3.3 netX Driver 
The netX Driver is used to connect the DTM to the device via different 
connection types. The DTM communicates with the device via an USB 
connection, a serial (RS232) connection or a TCP/IP connection. The netX 
Driver establishes 

• via the USB interface of the device and the USB port of the PC an USB 
connection to the device, 

• via the RS232 interface of the device and the COM port of the PC a 
serial connection (RS232) to the device 

• and via Ethernet a TCP/IP connection to the device. 
 

To connect the DTM to the physical layer of the device the netX Driver 
software works in combination with the software components: 

• “USB/COM connector” for the USB connection and for the serial 
connection (RS232) and  

• “TCP/IP connector” for the Ethernet connection. 
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4.3.4 Configuring netX Driver 
The following steps are required to configure the netX Driver: 

USB/RS232 Connection 
To set the driver parameters for an USB/RS232 connection note: 
 

 
Note: Adjust the driver parameters netX Driver USB/RS232 only if they 
differ from the default settings. After saving the changed driver 
parameters, these parameters are used for the device assignment when 
scanning devices. 

 

For setting the driver parameters for an USB connection or a serial 
connection: 

1. Select Settings > Driver > netX Driver > USB/RS232 Connection. 

 Set the driver netX Driver USB/RS232 parameters. 
 

TCP/IP Connection 
For setting the driver parameters for a TCP/IP connection: 

1. Select Settings > Driver > netX Driver > TCP Connection. 

2. Set IP Address of the device: 

 Add an IP Range via Select IP Range . 

3. Under IP Range Configuration > IP Address enter the IP Address of 
the device (Use IP Range is unchecked). 

Or 

4. Set IP Range: 

 Check Use IP Range. 

 Under IP Range Configuration > IP Address enter the start address 
(left side) and the ending address of the IP scanning range (right side). 

5. Click Save, to save the IP address or the IP range. 

 After saving the changed driver parameters, these parameters are used 
for the device assignment when scanning devices. 
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4.3.5 netX Driver - USB/RS232 Connection 
The communication from the DTM to the device via an USB/RS232 
Connection is used when the DTM is installed on a PC and between the 
PC and the device 

• an USB connection 

• or a serial connection (RS232) exists. 
 

The DTM accesses the device via the USB interface or via the RS232 
interface. This requires either to connect an USB port of the PC to the USB 
interface of the device using an USB cable or to connect a physical COM 
port of the PC to the RS232 interface of the device via a serial cable. 

The netX Driver / USB/RS232 Connection supports all physical and 
virtual COM ports available on the PC. 

Via the RS232 interface or USB interface, the device is configured or 
diagnosis is performed. 
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4.3.5.1 Driver Parameters for netX Driver - USB/RS232 Connection 

The settings of the driver parameters for the USB/RS232 connection are 
made via the netX Driver / USB/RS232 Connection configuration dialog. 

 Open the USB/RS232 Connection dialog via navigation area Settings 
> Driver > netX Driver.  

 The USB/RS232 Connection dialog is displayed: 

 
Figure 9: netX Driver > USB/RS232 Connection  

 

Parameter Meaning Range of Value / 
Default Value 

Enable USB/RS232 
Connector (Restart of 
ODM required) 

checked: The netX Driver can communicate via the 
USB/RS232 interface. 
unchecked: The netX Driver can not communicate via the 
USB/RS232 interface. 
If the check mark for Enable USB/RS232 Connector is set 
or removed, then the ODM server must be restarted1, to 
make the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click on  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked  

Select Port Depending on the COM ports (interfaces) available on the 
PC, they will be listed under Select Port. 

COM 1 to COM N 

Port Configuration 
Disable Port checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured USB/RS232 interface. 

checked,  
unchecked (Default) 

Baud rate Transfer rate: number of bits per second. 
The device must support the baud rate. 

9.6, 19.2, 38.4, 57.6 or 
115.2 [kBit/s]; 
Default (RS232): 115.2 
[kBit/s] 
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Parameter Meaning Range of Value / 
Default Value 

Stop bits Number of stop bits sent after the transfer of the send data 
for synchronization purposes to the receiver. 

Stop bit: 1, 1.5, 2; 
Default (RS232): 1 

Send Timeout Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 1000 ms 

Reset Timeout Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 5000 ms 

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit; 
Default (RS232): 8 Bit 

Parity In the error detection in data transmission using parity bits, 
"parity" describes the number of bits occupied with 1 in the 
transmitted information word. 
No Parity: no parity bit 
Odd Parity: The parity is "odd" if the number of bits occupied 
with 1 in the transmitted information word will be odd. 
Even parity: The parity is "even" if the number of bits 
occupied with 1 in the transmitted information word will be 
even. 
Mark Parity: if the parity bit is always 1, this will be named 
mark-parity (the bit does not contain any information). 
Space Parity: if the parity bit always 0, this will be named 
space-parity (the bit represents an empty space). 

No Parity,  
Odd Parity, 
Even Parity, 
Mark Parity, 
Space Parity; 
Default (RS232):  
No Parity 

Keep Alive Timeout The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism will be initiated after the set time has 
elapsed if the communication has failed. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 2000 ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save USB/RS232 Connection, i. e. only for the 
selected connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 13: Parameters netX Driver > USB/RS232 Connection 
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4.3.6 netX Driver - TCP/IP Connection 
The communication from the DTM to the device via a TCP/IP Connection 
is used in the following two typical applications: 

Application 1: The device has its own Ethernet interface. The DTM is 
installed on a PC and the TCP/IP connection is established from this PC to 
the stand-alone device. The IP address of the device is used. 

Application 2: The device is installed in a remote PC. The DTM is installed 
on an additional PC and the TCP/IP connection is established from this PC 
to the remote PC. The IP address of the remote PC is used. For the TCP/IP 
connection is made, on the remote PC the cifX TCP/IP server must be 
started. The cifX TCP/IP server allows the remote access to the device via 
a TCP/IP connection. 
 

 
Note: An exe file for the cifXTCP/IP server is provided on the product CD 
in the Tools directory. 

 

Via the TCP/IP interface of the device or of the remote PC, the device is 
configured or diagnosis is performed. 
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4.3.6.1 Driver Parameters for netX Driver - TCP/IP Connection 

The settings of the driver parameters for the TCP/IP connection are made 
via the netX Driver / TCP Connection configuration dialog. 

 Open the TCP Connection dialog via navigation area Settings > 
Driver > netX Driver.  

 The dialog netX Driver is displayed: 

 Select TCP Connection. 

 
Figure 10: netX Driver > TCP Connection  

 
 
 
 
 

Parameter Meaning Range of Value / 
Default Value 

Enable TCP Connector 
(Restart of ODM 
required) 

checked: The netX Driver can communicate via the TCP/IP 
interface. 
unchecked: The netX Driver can not communicate via the 
TCP/IP interface. 
If the check mark for Enable TCP Connector is set or 
removed, then the ODM server must be restarted1, to make 
the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click on  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked 

Select IP Range Via Select IP Range already created IP ranges can be 
selected. 

Via  an additional IP range can be added. 

Via  an IP range can be deleted. 
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Parameter Meaning Range of Value / 
Default Value 

Scan Timeout [ms] With Scan Timeout can be set, how long to wait for a 
response while a connection is established. 

10 … 10000 [ms]; 
Default: 100 ms 

IP Range Configuration 
Disable IP Range checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured TCP/IP interface. 

checked,  
unchecked (Default) 

IP Address (left) Enter the IP address of the device, (if Use IP Range is not 
checked). 
Enter the start address of the IP scanning range, (if Use IP 
Range is checked). 

valid IP address; 
Default: 192.168.1.1 

Use IP Range checked: An IP address range is used. 
unchecked: Only one IP address is used. 

checked,  
unchecked; 
Default: 
unchecked 

IP Address (right) Enter the ending address of the IP scanning range, (only if 
Use IP Range is checked). 

valid IP address; 
Default: 0.0.0.0 

Address Count Displays the scanning range address count, depending on 
the selected IP-start or IP-end address. (For this read the 
note given below.) 

recommended: 10  

TCP Port Identifies the endpoint of a logical connection or addresses a 
specific endpoint on the device or PC. 

0 - 65535; 
Default Hilscher device: 
50111 

Send Timeout [ms] Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (TCP/IP): 1000 
ms 

Reset Timeout [ms] Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Keep Alive Timeout 
[ms] 

The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism will be initiated after the set time has 
elapsed if the communication has failed. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save TCP/IP Connection, i. e. only for the selected 
connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 14: Parameters netX Driver > TCP Connection 

 

 

Note: Do not use large IP ranges in combination with a low scan timeout. Microsoft 
introduced in Windows® XP SP2 a limit of concurrent half-open outbound 
TCP/IPconnections (connection attempts) to slow the spread of virus and malware from 
system to system. This limit makes it impossible to have more than 10 concurrent half-
open outbound connections. Every further connection attempt is put in a queue and 
forced to wait. Due to this limitation a large IP range used in combination with a low scan 
timeout could prevent the connection establishment to a device. 
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4.4 Device Assignment 
 

 
Note: In the Device Assignment dialog pane you first must assign the 
EtherNet/IP Adapter device to the EtherNet/IP Adapter DTM by checking 
the check box. This is essential to establish an online connection from the 
EtherNet/IP Adapter DTM to the EtherNet/IP Adapter device later, as 
described in section Connecting/Disconnecting Device on page 77. 

 

Therefore in the Device Assignment dialog pane you scan for the 
EtherNet/IP Adapter device and select it.  

If the device did not get a firmware or shall get a new firmware: 

1. first you scan for the device (with or without firmware) and select the 
device,  

2. then you download a firmware to the device and 

3. subsequently you scan for the device (with firmware) once more and 
select the device again. 

 
 
 

4.4.1 Scanning for Devices 
 

1. Select Settings > Device Assignment in the navigation area. 

 The dialog pane Device Assignment is displayed. 

 
Figure 11: Device Assignment - detected Devices (* The name of the device class is 
displayed.) – Example for a device without firmware 

2. Under Device Selection select suitable only. 

3. Select Scan, to start the scanning process. 

 In the table all devices are displayed, which can be connected to the 
EtherNet/IP Adapter DTM via the preselected driver. 

 

 
Note: For devices, which have been found via the cifX Device Driver in 
the column Access path the indication …\cifX[0toN]_SYS is displayed. 
This is correct, as long as a device did not get a firmware. After the 
firmware download has been completed, in the column Access path the 
indication …\cifX[0toN]_Ch[0to3] is displayed. 
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Parameter Meaning Range of Value / 
Default Value 

Device selection Selecting suitable only or all devices. suitable only, all 

Device Device class of the EtherNet/IP Adapter devices.  

Hardware Port 
0/1/2/3 

Shows, which hardware is assigned to which communication interface.  

Slot number Shows the Slot Number (Card ID) preset at the PC card cifX via the Rotary 
Switch Slot Number (Card ID). 
The indication n/a means that no Slot-Nummer (Card ID) exists. This will 
occur if the PC card cifX is not equipped with a Rotary Switch Slot Number 
(Card ID) or for PC cards cifX equipped with a Rotary Switch Slot Number 
(Card ID) if the rotary switch is set to the value 0 (zero). 

1 to 9, 
n/a 
 

Serial number Serial number of the device  

Driver Name of the driver  

Channel Protocol Shows, which firmware is loaded to which device channel. 
The data for the used channel consists of the protocol class and the 
communication class. 
a.) For devices without firmware: Undefined Undefined, 
b.) For devices with firmware: Protocol name corresponding to the used 
Firmware 

 

Access path 
(last column on 
the right) 

Depending on the used driver in the column Access path different data to 
the device are displayed. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

Depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Access path  
(at the lower side 
of the dialog 
pane) 

If in the table a device is checked, under Access path (at the lower side of 
the dialog pane) the driver identification or depending on the used driver 
additional data to the device will be displayed. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

driver identification 
(ID) 
depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Table 15: Parameters of the Device Assignment 
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4.4.1.1 Scanning for all Devices or for suitable only 

all 
1. Under Device Selection select all. 

2. Select Scan. 

 
Figure 12: Device Assignment - detected Devices (* The name of the device class is 
displayed.) Example for Devices without Firmware 

 In the table all devices are displayed, which are attainable in the 
network and which can be connected to a single DTM each via the 
preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File all files from the selected folder are displayed, 
under Files of Type „All Files (*.*)“ is displayed and the check box 
Validate the selected firmware file. is unchecked. 

 
 

suitable only 
1. Under Device Selection select suitable only. 

2. Select Scan. 

 In the table all devices are displayed, which can be connected to the 
EtherNet/IP Adapter DTM via the preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File only firmware files from the selected folder are 
displayed, under Files of Type „Firmware Files (*.nxm)“ or „Firmware 
Files (*.nxf)“ is displayed and the check box Validate the selected 
firmware file. is checked. 
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4.4.2 Selecting the Device (with or without firmware) 
 

 
Note: A connection with the EtherNet/IP Adapter DTM can only be 
established with one EtherNet/IP Adapter device. 

 

To select the physical EtherNet/IP Adapter device (with or without 
firmware): 

1. Check the appropriate device. 

 
Figure 13: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device without firmware / one Device is selected  

 

 Under Access path (below in the dialog pane) the access path to the 
device, e. g. the driver identification, or depending on the used driver 
additional access data of the device are displayed. 

2. Select Apply, to apply the selection. 
 

 
Note: Before an online connection from the EtherNet/IP Adapter DTM to 
the EtherNet/IP Adapter device can be established, a firmware must be 
loaded to the device and the device must be selected once more. 

 
 

 

For further information refer to section to section Firmware Download on 
page 51 or to section Selecting the Device once more (with Firmware) on 
page 49. 
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4.4.3 Selecting the Device once more (with Firmware) 
 

 
Note: For repeated download this step is omitted. 

 

To select the EtherNet/IP Adapter device (with firmware and defined 
system channel) once more, proceed as described hereafter: 

all 
1. Under Device Selection select all. 

2. Select Scan. 

 In the table all devices are displayed, which are attainable in the 
network and which can be connected to a DTM via the preselected 
drivers. 

3. Check the appropriate device. 

 
Figure 14: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for Devices with and without Firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel 
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select Apply, to apply the selection.  

5. Or select OK, to apply the selection and to close the DTM interface 
dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 
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Or: 

suitable only 
1. Under Device Selection select suitable only. 

2. Select Scan. 

 In the table all devices are displayed, which can be connected to the 
EtherNet/IP Adapter DTM via the preselected drivers. 

3. Check the appropriate device. 

 
Figure 15: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device with firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel 
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select Apply, to apply the selection.  

5. Or select OK, to apply the selection and to close the DTM interface 
dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 

 

 

For further information how to establish an online connection from the 
EtherNet/IP Adapter DTM to the EtherNet/IP Adapter device, refer to 
section Connecting/Disconnecting Device on page 77. 
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4.5 Firmware Download 
Using the Firmware Download dialog a firmware can be transferred to the 
device. 

 
Note: Prior to the firmware download, you must select the driver and the 
Adapter device (with or without firmware) and the device must be 
assigned to the hardware. For further information refer to section 
Overview Settings on page 32. 

To load the firmware to the device: 

1. In the navigation area select Settings > Firmware Download. 

 The dialog Firmware-Download pane is displayed. 

 
Figure 16: Firmware Download 

Element Meaning 
Name The path and name of the firmware file selected are displayed. 

Version The version and build version of the firmware file selected are displayed. 

Browse… Via ‘Browse…’ you can select the firmware file for the download.  

Download Via ‘Download’ you can download the firmware to the device. 

Table 16: Parameter Firmware Download 

 Select Browse. 

Device is not assigned to the Hardware 
If the device is not assigned to the Hardware, the error message ‘The 
device is not assigned to the hardware!’ is displayed: 

 
Figure 17: Error Message ‘The device is not assigned to the hardware!’ 
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 Click OK and select and assign the Adapter device as described in 
section Device Assignment.  

Device is assigned to the Hardware 
 The selection window Select Firmware File is displayed. 

 Enlarge the selection window to view the columns Hardware and 
Version.  

 

 
Figure 18: Window ‘Select Firmware File’ (Example CIFX) 
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Parameter Meaning Range of Value / 
Default Value 

Column Name File name of the firmware file 
To sort the entries of the window Select Firmware File by name click to 
the column head . 

nxf, nxm 

Column 
Firmware 

Name of the firmware (consisting of the protocol name and protocol class)  

Column 
Hardware 

Device class of the associated hardware e. g. CIFX,  
COMX, COMX 51,  
NETJACK 10,  
NETJACK 50,  
NETJACK 51,  
NETJACK 100, 
NETTAP 50 (Gateway), 
NETTAP 100 (Gateway), 
NETBRICK 100 (Gateway) 

Column 
Version 

Firmware version x.x (build x) 

Tooltip  To view the tooltip information move with the mouse pointer over the 
selected firmware line. 

 

 

Files of Type „All Files (*.*)“ if before in the Device Assignment pane under Device 
selection all was selected.  
„ Firmware Files (*.nxm)“ or Firmware Files (*.nxf) if before in the Device 
Assignment pane under Device selection suitable only was selected. 

All Files (*.*), 
Firmware Files (*.nxm), 
Firmware Files (*.nxf) 

Recent folders Path of the recently opened folder  
Firmware As soon as the firmware file has been selected, under Firmware the 

name, the version and the build version as well as the device class for the 
selected firmware is displayed. 

Name, Version, Build 
Version, Device Class 
for the selected firmware 

Help Button, to open the online help of the DTM.  

Table 17: Parameters Select Firmware File 

 

Further descriptions to the selection window Select Firmware File are 
included in the context sensitive help (F1 key) of the Microsoft 
Corporation. 

 

 

Note: After in the Device Assignment pane under Device selection all or suitable only 
has been set, during a subsequent firmware download in the selection window Select 
Firmware File the following data are displayed or set: 

(for list box entry ) all suitable only 
In the selection window 
Select Firmware File: 

all files from the 
selected folder 

only firmware files from the 
selected folder 

Under Files of Type*: „All Files (*.*)“ „Firmware Files (*.nxm)“, 
„Firmware Files (*.nxf)“ 

Validation: A restricted validation 
will be performed if 
the selected firmware 
is applied for the 
download. 

A validation is made whether 
the firmware file is suitable for 
the EtherNet/IP Adapter DTM. 

*These settings in the selection window Select Firmware File can also be changed 
manually. 

3. In the selection window mark the firmware file to be loaded using the 
mouse. 

 In the selection window under Firmware the name and the version of 
the firmware are displayed. 
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4. In the selection window select the Open button. 

Validation 
 A validation is made, whether the selected firmware file is suitable for 

the EtherNet/IP Adapter device. 

Invalid Firmware 
 

  
Invalid Firmware 
Loading invalid firmware files could render your device unusable. 

  Only proceed with a firmware version valid for your device. 

 If a firmware file is selected, which is not valid for the assigned device, 
the request Select Firmware File will be displayed. 
‘Invalid firmware for assigned device!   
[detailed explication]  
Shall firmware file nevertheless be applied for the download?’ 

 
Figure 19: Request Select Firmware File - Example Invalid Firmware 

 Answer to the request with No and select a valid firmware. 

 The selection window is closed. 
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Valid Firmware 
 The selection window is directly closed (without dialog). 
 

5. Start firmware upgrade.   
 

  
Communication Stop caused by Firmware Update,  
faulty System Operation possible, Overwriting of Firmware or  
Loss of Device Parameters 
Before you initiate a firmware download process, while the bus is still in 
operation status: 
 Stop the application program. 

 Make sure that all network devices are placed in a fail-safe condition. 
 

  
Firmware Corruption or Loss of Parameters caused by Power 
Disconnect during Firmware Download 

  During firmware download process, do not interrupt the power supply to 
the PC, or to the device and do not perform a reset to the device! 

 In the dialog pane Firmware Download click to the Download button, 
to download the firmware. 

 The request Do you really want to download the firmware? is 
displayed. 

 
Figure 20: Request - Do you really want to download the firmware? 

6. Click Yes. 

 If you are sure, that you have selected the appropriate firmware file 
answer to the request with Yes otherwise with No.  

 During the download a progress bar is displayed (‘Download active, 
device performs initialization…’), in the status line a clock / green hook 
symbol is displayed and in the dialog pane Firmware Download 
Download is grayed out. 

 
Figure 21: Firmware Download - Progress Bar  
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Figure 22: Clock Symbol and Hook Symbol green 

 In the Firmware-Download dialog pane the path and name as well as 
the version of the selected firmware file are displayed. 

 
Figure 23: Firmware Download – Download 
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5 Configuration 
5.1 Overview Configuration 

Configuration Dialog Panes 
The table below gives an overview for the Configuration dialog panes 
descriptions: 
 

EtherNet/IP Adapter DTM Folder Name / Section Page 

 
Navigation Area - Configuration 

General 61 

Electronic Keying 64 

Connection 65 

Assembly 66 

Signal Configuration 67 

Device Settings  73 

Table 18: Descriptions of the Dialog Panes Configuration 

 

Notice the descriptions in the section Configuration Steps on page 24. 

 
 
 

 
Note: In order to transfer the configuration to the EtherNet/IP Adapter  
device, download the data of the configuration parameters in the 
EtherNet/IP Adapter device. See section Download Configuration on page 
79. 
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5.2 Configuring Adapter Parameters 
The steps provided in the following two sections are alternatively required 
for the two cases listed hereafter, to configure the parameters of the 
EtherNet/IP Adapter device using the EtherNet/IP Adapter DTM: 

Adapter DTM at the Root-Line (Stand-Alone Adapter)  

• and Adapter DTM at the Scanner busline. 
 

5.2.1 Slave DTM at the Root-Line (Stand-Alone Slave) 
If in the network project the EtherNet/IP Adapter DTM is dropped to the root 
busline, proceed as follows: 

General 
1. Set the IP settings of the Slave device: 

 Select Configuration > General in the navigation area.  

For ‘Quick Connect’ the Adapter devices must be configured as MDI oder 
MDIX. 

Electronic Keying 
2. Select the keying method and configure it if necessary: 

 Select Configuration > Electronic Keying in the navigation area. 

Connection 
3. Configure the connection points: 

 Select Configuration > Connection in the navigation area. 

Assembly 
4. Configure Instance ID and Data length: 

 Select Configuration > Assembly in the navigation area. 

Signal Configuration 
5. Proceed the Signal Configuration: 

 Select Configuration > Signal Configuration in the navigation area. 

Device Settings 
6. Set the Device Settings: 

 Select Configuration > Device Settings in the navigation area. 

 Under Start of Bus Communication > select Automatically by 
device or Controlled by application option.  

 Under Application Monitoring > set Watchdog time. 
 

Close Adapter DTM Configuration Dialog 
7. Click OK in order to close the Adapter DTM configuration dialog and to 

store your configuration. 
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Configuration Download to the EtherNet/IP Adapter Device 
 Adhere to the necessary safety precautions to prevent personnel injury 

and property damage.  
 

 
Note: In order to transfer the configuration to the EtherNet/IP Adapter 
device, download the data of the configuration parameters in the 
EtherNet/IP Adapter device. See section Download Configuration on page 
79. 

 
 

Further Information 

 

For more information refer to the sections hereafter. 

5.2.2 Adapter DTM at the Master busline 
If in the network project the EtherNet/IP Adapter DTM is dropped to the 
Master busline of the EtherNet/IP Scanner DTM: 

Electronic Keying 
1. Select the keying method and configure it if necessary: 

 Select Configuration > Electronic Keying in the navigation area. 

Connection 
2. Configure the connection points: 

 Select Configuration > Connection in the navigation area. 

Assembly 
3. Configure Instance ID and Data length: 

 Select Configuration > Assembly in the navigation area. 

Signal Configuration 
4. Proceed the Signal Configuration: 

 Select Configuration > Signal Configuration in the navigation area. 

Device Settings 
5. Set the Device Settings: 

 Select Configuration > Device Settings in the navigation area. 

 Under Start of Bus Communication > select Automatically by 
device or Controlled by application option.  

 Under Application Monitoring > set Watchdog time. 

Close Adapter DTM Configuration Dialog 
6. Click OK in order to close the Adapter DTM configuration dialog and to 

store your configuration. 
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Configuration Download to the EtherNet/IP Adapter Device 
 Adhere to the necessary safety precautions to prevent personnel injury 

and property damage.  
 

 
Note: In order to transfer the configuration to the EtherNet/IP Adapter 
device, download the data of the configuration parameters in the 
EtherNet/IP Adapter device. See section Download Configuration on page 
79. 

 
 

Further Information 

 

For more information refer to the sections hereafter. 
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5.3 General 
The General dialog pane shows the Description of the EtherNet/IP 
Adapter. The IP Address is set by the EtherNet/IP Scanner.  

 
Figure 24:  Configuration > General (with EtherNet/IP Scanner) 

 

Parameter Description 
Description Symbolic Name of the EtherNet/IP Adapter device. 

IP Settings of the EtherNet/IP Adapter device 

IP Address The IP address of the EtherNet/IP Adapter device is set in the EtherNet/IP Scanner DTM. Here it is 
only displayed.  
The EtherNet/IP Scanner device transmits the IP address of the EtherNet/IP Adapter during startup 
via the EtherNet/IP network to the EtherNet/IP Adapter and thereby configures the EtherNet/IP 
Adapter. 

Table 19:  General Pane Parameters 
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If the EtherNet/IP-Adapter is not configured to an EtherNet/IP Scanner, the 
dialog pane General displays further IP Settings. 

 
Figure 25:  Configuration > General (without EtherNet/IP Scanner) 

 

Parameter Description Range of Value / Value 
Description Symbolic Name of the EtherNet/IP Adapter device.  
IP Settings of the EtherNet/IP Adapter-device (editable) 
DHCP To set the IP address, activate/deactivate DHCP protocol.  
BootP To set the IP address, activate/deactivate BootP protocol.  
Fixed Addresses Activate/deactivate fix IP settings.  
IP Address IP address of the EtherNet/IP Adapter-device.  
Network Mask Network mask of the EtherNet/IP Adapter device.  
Gateway Address Gateway address of the EtherNet/IP Adapter- device.  
Port1 / Port 2 
Operation mode Operation mode of the EtherNet/IP Adapter Speed/Duplex mode/ 

Auto negotiation 
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Parameter Description Range of Value / Value 
MDI Mode MDI mode of the EtherNet/IP Adapter for Port 1 or Port 2 

According to EtherNet/IP specification [4] the following rules are 
valid: 
When in Quick-Connect mode, a port is configured for forced speed 
and duplex mode, the Quick-Connect devices shall not use Auto-
MDIX (detection of the required cable connection type). This 
detection may take more time than the allotted Quick-Connect 
system connection time. To enable the use of straight-thru cables 
when Auto-MIDX is disabled, the following rules shall be applied:  
1. On a device with only one port: the port shall be configured as 
MDI.  
2. On devices with 2 external Ethernet ports:  
a. The labels for the 2 external ports shall include an ordinal 
indication (e.g.: Port 1 and Port 2, or A and B).  
b. The port with the lower ordinal indication shall be configured as 
MDI.  
c. The port with the upper ordinal indication shall be configured as 
MDIX. 
Note: For DLR capable devices this requirement overrides the 
requirement that DLR capable devices shall have "forced Auto-
MDIX" when speed & duplex are fixed. 
MDI Mode options: 
‚Auto MDI-X‘: 
In the orperatin mode ‚Auto-Negotiation‘ the ‚MDI Mode‘ can not be 
clicked. In this case automatically ‚Auto MDI-X‘ is valid. 
‚MDI‘ und ‚MDI-X‘: 
The data directions RX an TX are assigned to the cable ends 
statically. This leads to the fact that IO connections are established 
much faster. A statical definition is used exclusively with Quick 
Connect  

‚Auto MDI-X‘, 
‚MDI‘ 
‚MDI-X‘ 

Table 20: General Pane Parameters 
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5.4 Electronic Keying 
The concept of Electronic Keying was introduced by Allen-Bradley, RA. 
EtherNet/IP scanner implements compatible concept. 

A set of attributes of an EtherNet/IP Adapter can be regarded as its 
electronic identity which can be used to differentiate adapters based on 
these attributes. EtherNet/IP scanner employs this electronic identity to 
build an Electronic Key and uses it to verify that an adapter connected to 
the network is the expected one. Electronic keying allows flexible online 
validation of adapters, provides a method for reliable network configuration. 

Attributes of the electronic identity that can be used in keying are as 
follows: Minor Revision, Major Revision, Product Code, Product Type and 
Vendor ID. 

 Select Configuration > Electronic Keying in the navigation area.  

 
Figure 26:  Configuration > Electronic Keying 

 Select a Keying method. 
Method Description 
Exact match To validate an EtherNet/IP adapter connected to the network all attributes for the electronic 

identity must correspond to the attributes of an expected device. 

Custom keying To validate an EtherNet/IP adapter connected to the network all attributes must correspond to the 
configured keying. 

No keying No validation of the device identity. 

Table 21:  Electronic Keying > Keying Method 

For Custom Keying: 

 Select Custom Keying and configure the keying attributes. 
Parameter Description 
Relaxed Match If checked: Restricted validation of the electronic identity for devices. To indicate relaxed match 

to an adapter, the scanner sets bit 7 in major revision. 

Minor Revision If checked: For electronic keying consistency to minor revision is relevant and gets verified.  

Major Revision If checked: For electronic keying consistency to major revision is relevant and gets verified. 

Product Code If checked: For electronic keying consistency to product code is relevant and gets verified. 

Product Type If checked: For electronic keying consistency to product type is relevant and gets verified. 

Vendor If checked: For electronic keying consistency to vendor ID is relevant and gets verified. 

Table 22:  Electronic Keying > Custom Keying 
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5.5 Connection 
At the Connection pane the connectin can be parameterized. Usually the 
settings are made as given in the EDS file in section connection manager. 

 
Figure 27:  Configuration > Connection 

Parameter Description Range of Value / Value 
Connection name Name of the connection, defined by the operator or 

by the EDS file. 
Standard: „Connect1“ 

Originator to Target (O2T) 

RT transfer format Real time transfer format for transfer direction 
originator to target  

Connection is pure data and is modeless, 
heartbeat, 
32-bit Run/Idle header 

Target to Originator (T2O) 

RT transfer format Real time transfer format for transfer direction target 
to originator 

Connection is pure data and is modeless, 
32-bit run/idle header 

Table 23:  Parameter Configuration > Connection 

Run/Idle Mode for RealtimeTransfer Format 
The Run/Idle header is a 32-bit field added to packets flowing in the O2T or 
T2O direction. In O2T direction It  contains several bits of status info. Of 
primary interest is the least significant bit, which reflects the mode of the 
connection originator. When this bit is set it means the originator is in Run 
mode, actively controlling I/O. When cleared this indicates that the 
originator is in Idle mode, not actively controlling the I/O. Run/Idle is not 
counted as part of the configured data size in the EDS Connection 
Manager section. It is counted in the FwdOpen Message O2T and T2O 
sizes however. 
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5.6 Assembly 
The Assembly dialog pane is used to configure and display the 
input/output connections of the EtherNet/IP Adapter. Here the parameters 
Instance ID and Data length can be configured. 

 Select Configuration > Assembly in the navigation area.  

 
Figure 28:  Configuration > Assembly 

 

Parameter Description Range of Value / 
Value 

IN/OUT Input or output connection configured to the EtherNet/IP Adapter. Connection type: 
IN (input) or  
OUT (output) 

Connection 
name 

Name of the input or output connection configured to the EtherNet/IP Adapter. 
Can be set in the configuration dialog Connection. 

Connection1 

Instance ID Instance ID of the connection (editable) 1-255, Default:  
100 for output data,  
101 for input data 

Data length Data length in Bytes (editable) 
The data length set here affects the signal configuration. If you increase the 
data length, a corresponding number of signals with the corresponding data 
type are added. If you decrease the data length, a corresponding number of 
signals is deleted. 

0 … 504 

Min. length Minimum data length in Bytes 0 

Max. length Maximum data length in Bytes 504 

Table 24:  Parameters Dialog Pane Assembly 
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5.7 Signal Configuration 
 

With the EtherNet/IP Adapter, the process data to be transmitted via the 
bus is configured at fieldbus level as the number of data for the 
connection. 

The application requires the information on the meaning and data type of 
the input and output data specified via the signals. 
 

 
Important: First, configure the length of the input and output data in the 
Assembly dialog pane. Do not perform the signal configuration steps until 
you have finished. 

 

In the Signal Configuration dialog you can define the data structure of the 
input or output data of your device and define the I/O data for your 
application 

• assign data types, 

• assign names or signal names, and 

• define data structures. 

The aim is to create a suitable signal configuration, which subsequently 
enables easy identification of the transmitted input and output data. This 
requires a structuring of the input and output data according to signals and 
the configuration of signal names or data types suitable for the individual 
application cases.  

Signal names 
The names assigned by default by the configuration software for the signals 
distinguish between input and output signals. You can replace these 
general names with suitable designations, such as "Setpoint" or "Status".  

Merging or splitting signals 
You can merge or split signals or data types by configuring the data type 
and the number of signals.  

Example: 1 "Word (input)" = 16 "Bit (input)".  

This means that 1 "word input data" corresponds to 16 signals with the data 
type "Bit".  

To identify split data types, the configuration software assigns appropriate 
suffixes to the signal names, which depend on the selected new data type, 
for example _Byte_0, _Byte_4 ... or _Bit_1, _Bit_2 ... 
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5.7.1 Signal Configuration Pane 
 Select Configuration > Signal Configuration in the navigation area. 

 The dialog pane Signal Configuration is displayed.  

 
Figure 29: Signal Configuration Pane 

 
 

Parameter Description Range of Value/ 
Value 

Slot Slot1 for connection1 Slot1 
Name Name of the input or output connection configured to the EtherNet/IP 

Adapter. Can be set in the configuration dialog Connection. 
Connect1 

Module Type 
Signal level 
Name Name of the input or output signal that can be set here. 

The configuration software assigns names by default: 
Output_Assembly, Input_Assembly 

String 

Type Data type of the input or output signal (depending on the configured size of 
the I/O data). 

bit, byte, signed8, 
unsigned8, word, 
signed16/24, 
unsigned16/24, dword, 
signed32/40/48/56, 
unsigned32/40/48/56, 
lword, signed64, 
unsigned64,  
real32, real64 

Offset Offset of the input or output signal, in relation to the data in the connection.  

Table 25:  Explanations Signal Configuration Pane 
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5.7.2 Create Signal Configuration 
In the Signal Configuration pane, you can edit the signal configuration in 
the lower table. 

Edit Signal 
 Right-click on the signal to be configured to open the context menu. 

 
Figure 30: Edit Signal 

 Click Edit Signal.  
 The Edit Signal dialog pane is opened. 

 
Figure 31: Edit Signal Dialog Pane 

Parameter Description Range of Value/ 
Value 

Name Here you can edit the signal name. String 
Original Type Input or output signal data type preconfigured by the configuration software 

or by the user. 
 

New Type Here you can edit the new data type for the input or output signal.  
Only permitted data types are displayed in the selection list. 

bit, byte, signed8, 
unsigned8, word, 
signed16/24, 
unsigned16/24, 
dword, 
signed32/40/48/56, 
unsigned32/40/48/56, 
lword, signed64, 
unsigned64,  
real32, real64 

Count Here you can set the number of signals with the data type "New Type".  
Apply as Array If checked, the signal is displayed as an array. If unchecked, the individual 

signals are displayed. 
Checked, 
unchecked, 
Default: checked 

Table 26:  Explanations Edit Signal Dialog Pane 
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 In the field Name edit the signal name. 

 Use New Type to define the new data type or Count to define the 
number of signals. 

 
Figure 32: Edit Signal (Example) 

 Click OK.  

 When splitting signals, the configuration software assigns suitable 
standard suffixes to the signal name to identify the subordinate signals. 

 
Figure 33: Signal Output_Assembly split (Example) 

 You can further split already split signals. 

 
Figure 34: Signal Output_Assembly_Byte_4 split again (Example) 

 Click Apply to save the created configuration. 
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Reset 

 
Note: As long as you have not applied the created signal configuration, 
you can undo the steps you have taken by clicking Reset. 

 Right-click on the configured signal to open the context menu. 

 
Figure 35: Reset 

 Click Reset. 
 The created signal configuration with a splitting of a signal is undone. 

Merge Signals 
 First, confirm a signal splitting with Apply. 

 Then press Shift and mark the signals to be merged with the mouse 
pointer. 

 Open the context menu by right-clicking on the marked signals. 

 
Figure 36: Merge Signals 

 Click Merge Signals. 

 The dialog pane Merge Signals opens. 
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Figure 37: Dialog Pane Merge Signals 

Parameter Description Range of Value/ 
Value 

Name Here you can edit the signal name. 
The name displayed here contains the suffix assigned by the configuration 
software, example "_Byte_0". 

String 

First in Group Shows the name of the first signal from which the merge will start.    
Last in Group Shows the name of the last signal up to which the merge is performed.    
New Type Here you can edit the new data type for the input or output signal.  

Only permitted data types are displayed in the selection list. 

bit, byte, signed8, 
unsigned8, word, 
signed16/24, 
unsigned16/24, 
dword, 
signed32/40/48/56, 
unsigned32/40/48/56, 
lword, signed64, 
unsigned64,  
real32, real64 

Count Shows the number of data types of the merged signal, which you can 
adjust here. 

 

Apply as Array An array is formed when merging. Allways checked 

Table 27:  Explanations Merge Signals Dialog Pane 

 For the signals that you want to merge, specify the name via Name, the 
data type via New Type or the number of data types of the merged 
signal via Count. 

 Click OK. 

 The signals are merged.  

 Click Apply to save the created configuration. 
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5.8 Device Settings 
 

At the Device Settings pane device related settings can be made. These 
settings are assigned after a download of the configuration. 
  

 

Information about the download you find in section Download 
Configuration on page 79). 

 

 Select Configuration > Device Settings in the navigation area.  
 

 
Figure 38: Configuration > Device Settings 

 

 
Note: The setting options at the dialog pane Device Settings for client 
specific variants of the configuration software can differ from the setting 
options displayed here. 
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5.8.1 Start of Bus Communication 

 
Figure 39: Device Settings > Start of Bus Communication 

 

If Automatically by device is selected, the EtherNet/IP Adapter device 
starts with the data exchange on the bus after the initialization has been 
ended.  

If Controlled by application is selected, the application program must 
activate the data exchange on the bus. 
 

 
Note: The setting options under Start of Bus Communication for client 
specific variants of the configuration software can differ from the setting 
options displayed here. 

 
 

5.8.2 Application Monitoring 

 
Figure 40: Device Settings > Application Monitoring 

 

The Watchdog time determines the time within which the device watchdog 
must be re-triggered from the application program while the application 
program monitoring is activated. When the watchdog time value is equal to 
0 the watchdog is deactivated and the application program monitoring is 
deactivated too. 

The permissible range of values of the watchdog time is 20 to 65535. By 
default the watchdog time value equals to 1000 ms.  
 

Watchdog time Range of Value / Value 
Permissible range of values 20 … 65535 ms 
Default 1000 ms 
The software watchdog is deactivated. 0 ms 

Table 28: Range of Value / Value for the Watchdog time 

 

 
Note: The setting options under Application Monitoring for client 
specific variants of the configuration software can differ from the setting 
options displayed here. 
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6 Description 
6.1 Overview Description 

Dialog Panes “Description” 
The table below gives an overview for the Description dialog panes 
descriptions: 
 

EtherNet/IP Adapter DTM Folder Name / Section Page 

 
Navigation Area - Description 

Device Info 75 

Table 29: Descriptions of the Dialog Panes ‘Description’ 

6.2 Device InfoThe Device Info pane displays manufacturer information about the 
device, which is defined in the EDS file.  

 Select Description > Device Info in the navigation area. 

 
Figure 41: Description > Device Info (Example) 

Parameter Description Range of Value/Value 
Vendor name Vendor name of the device  

Vendor ID Identification number of the manufacturer 0 ... 65535, Hilscher: 283 

Device type Device type of the EtherNet/IP Adapter device from the EDS file 0 ... 65535, Default: 12  

Device type 
name 

Device type name of the EtherNet/IP Adapter device from the EDS file Communication Adapter 

Product code Product code of the device as specified by the manufacturer 0 ... 65535, 
Default: 
CIFX RE/EIS: 257 
COMX 100XX-RE/EIS:259 
NJ 50X-RE/EIS: 278 
NJ 100XX-RE/EIS: 279 
NT 50-EN/EIS: 275 
NT 100-RE/EIS: 271 
NB 100-RE/EIS: 273  
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Parameter Description Range of Value/Value 
Product name Name of the device station as character string. 0 - 31 ASCII characters, 

Examples: CIFX RE/EIS, 
NT 50-EN/EIS,  
NT 100-RE/EIS, 
NB 100-RE/EIS 

Major revision Major revision of the EtherNet/IP Adapter device according to the 
EtherNet/IP specification. 

0 ... 255,  
Default: 1 

Minor revsion Minor revsion of the EtherNet/IP Adapter device according to the 
EtherNet/IP specification. 

0 ... 255,  
Default: 1 

Catalog Device name in the device catalog of the configuration software  

Icon file Storage path of the device icon file to be displayed in the configuration 
software 

 

Table 30: Descriptions about Description > Device Info 
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7 Online Functions 
 

7.1 Connecting/Disconnecting Device 
 
 

 
Note: Several EtherNet/IP Adapter DTM functions e. g. Diagnosis or the 
configuration download in the FDT Framework require an online 
connection from the EtherNet/IP Adapter DTM to the EtherNet/IP Adapter  
device. 

Connecting Device 
The following steps are needed to establish a connection from the 
EtherNet/IP Adapter DTM to a EtherNet/IP Adapter device: 

Under Settings in the Driver pane: 

1. Verify that the default driver is checked and respectively check another 
or multiple drivers. 

2. Configure the driver if necessary. 

Under Settings in the Device Assignment pane: 

3. Scan for the devices (with or without firmware). 

4. Select the device (with or without firmware) and apply the selection. 
 

 

Before you download the firmware adhere to the necessary safety 
precautions to prevent personnel injury and property damage. For more 
refer to section Safety Messages on Firmware or Configuration Download 
on page 31. 

Under Settings in the Firmware Download pane if not yet a firmware was 
loaded to the device: 

5. Select and download the firmware. 

Under Settings in the Device Assignment pane if not yet a firmware was 
loaded to the device: 
 

6. Scan for the device (with firmware) once more. 

7. Select the device (with firmware) once more. 
 

 

An overview of the descriptions for these steps you find in the section 
Overview Settings on page 32. 

 

8. In the DTM interface dialog select the OK button, to apply the selection 
and to close the DTM interface dialog. 

9. Put a right-click on the EtherNet/IP Adapter device icon. 

10. Select the Connect command from the context menu. 

 The EtherNet/IP Adapter device now is connected to the EtherNet/IP 
Adapter  DTM via an online connection. In the network view the device 
description at the device icon of the Adapter is displayed with a green 
colored background. 
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Disconnecting Device 
To disconnect an online connection from the EtherNet/IP Adapter device to 
a EtherNet/IP Adapter DTM take the following steps: 

1. In the DTM interface dialog select the OK button, to close the DTM 
interface dialog. 

2. Right-click on the EtherNet/IP Adapter device icon. 

3. Select the Disconnect command from the context menu. 

 In the network view the device description at the device icon of the 
Adapter is not any more displayed with a green colored background. 
Now the EtherNet/IP Adapter device is disconnected from the DTM. 
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7.2 Download Configuration 
The device configuration is created offline in the DTM (application 
program). A download to the device is required, to transfer the configuration 
with the parameter data to the device.  
 

 
Note: To download configuration parameter data to the EtherNet/IP 
Adapter device an online connection from the EtherNet/IP Adapter DTM to 
the EtherNet/IP Adapter device is required. Further information can be 
found in the Connecting/Disconnecting Device section on page 77. 

 

Safety Precautions 
If you plan to perform a configuration download via the EtherNet/IP Adapter 
DTM be aware of the following: 
 

  
Communication Stop due to Configuration Download,  
Faulty System Operation possible or Loss of Device Parameters  
Before you initiate a configuration dowload process, while the bus is still in 
operation status: 
 Stop the application program. 

 Make sure that all network devices are placed in a fail-safe condition. 
 

  
Mismatching System Configuration,  
faulty System or Device Operation possible 
 In the device use only a configuration suitable for the system. 
 

 
 
 

 
Loss of Parameters caused by Power Disconnect during 
Configuration Download 
 During configuration download process, do not interrupt the power supply 

to the PC, or to the device and do not perform a reset to the device! 

For more see next page. 
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Download Steps 
To transfer the configuration with the corresponding parameter data to the 
EtherNet/IP Adapter device you download the data using the frame 
application of the configuration software.  

For netDevice the download is made via Device > Download or use the 
context menu with Download. 

1. Select Download in the context menu of the device.  

 If the download is started as long as the Slave devices are connected to 
the Master device, the following message is displayed: ‘If you attempt to 
download during bus operation, communication between Master and 
Slaves is stopped. Do you really want to download?’ 

 
Figure 42: netDevice Message: Download 

 

Important: If the communication between the Master and the Slave 
devices is stopped, the data exchange between the Master device and the 
Slave devices is stopped. 

 

2. Click to Yes if you intend to download the configuration.  

 Then the current configuration in the application program is down 
loaded to the device. 

3. Otherwise click to No. 

 

 

 



Online Functions 81/155 

DTM for EtherNet/IP Adapter Devices | Configuration of EtherNet/IP Adapter Devices  
DOC061202OI13EN | Revision 13 | English | 2020-01 | Released | Public  © Hilscher, 2006-2020 

7.3 Start /Stop Communication 
You can manually start or stop the communication between a EtherNet/IP 
Scanner device and EtherNet/IP Adapter devices. 

• Start Communication can be enabled if the communication was 
stopped before or if the configuration requires this (Controlled release of 
communication). 

• Stop Communication can be enabled if the communication was star-
ted. 

 To start or to stop the communication, proceed as follows: 

Start Communication 
1. Connecting device: 
 

 
Note: To start the communication of the device at the bus manually, an 
online connection from the EtherNet/IP Scanner DTM to the EtherNet/IP 
Scanner device is required. Further information can be found in the 
Connecting/Disconnecting Device section on page 77. 

 
 

2. Select Additional Functions > Service > Start Communication from 
the context menu (right mouse click). 

 The device communicates at the bus.  

Stop Communication 
 

  

Faulty System Operation possible or Loss of Device Parameters 
 Before you stop the communication: 
  Stop the PLC program. 
  Make sure that all network devices are placed in a fail-safe condition. 

1. Select Additional Functions > Service > Stop Communication from 
the context menu (right mouse click). 

 The communication of the device at the bus is stopped.  
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8 Diagnosis 
8.1 Overview Diagnosis 

The dialog Diagnosis serves to diagnose the device behavior and 
communication errors. For diagnosis the device must reside in online state.  

Diagnosis Panes 
The table below gives an overview for the individual Diagnosis dialog 
panes descriptions: 
 

EtherNet/IP Adapter DTM Folder Name / Section Manual Page 

 
Navigation Area - Diagnosis 

General Diagnosis  83 

Firmware Diagnosis 85 

Table 31: Descriptions of the Diagnosis Panes 

Online Connection to the Device 

 
Note: Accessing the Diagnosis panes of the EtherNet/IP Adapter DTM 
requires an online connection from the EtherNet/IP Adapter DTM to the 
EtherNet/IP Adapter device. For further information refer to section 
Connecting/Disconnecting Device on page 77. 

 
 

How to proceed 
1. In the Adapter DTM diagnosis dialog check whether the communication 

is OK: 

Diagnosis > General Diagnosis > Device status "Communication" must 
be green! 

2. "Communication" is green: Open the IO Monitor and test the input or 
output data.. 

3. "Communication" is not green: Use Diagnosis and Extended 
diagnosis for troubleshooting. 

 
 

Extended Diagnosis 
The Extended Diagnosis helps to find communication and configuration 
errors, when default diagnosis fails. For further information refer to section 
Overview Extended Diagnosis on page 86. 
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8.2 General Diagnosis 
Information regarding the Device State and other general diagnosis 
parameters are displayed in the General Diagnosis dialog. 

 
Figure 43: General Diagnosis 

LED Meaning Color State 

Device State 

Communication Shows whether the EtherNet/IP device executes the 
network communication. 

 (green) In COMMUNICATION 
state 

 (gray) Not in 
COMMUNICATION state 

Run Shows whether the EtherNet/IP device has been 
configured correctly. 

 (green) Configuration OK 

 (gray) Configuration not OK 

Ready Shows whether the EtherNet/IP device has been 
started correctly. The EtherNet/IP device waits for a 
configuration. 

 (yellow) Device READY 

 (gray) Device not READY 

Error Shows whether the EtherNet/IP device records a 
device status error. For further information about the 
error characteristics and the number of counted 
errors refer to the extended diagnosis. 

 (red) ERROR 

 (gray) No ERROR 

Network State 

Operate Shows whether the EtherNet/IP device is in data 
exchange. In a cyclic data exchange the input data 
or the output data of the EtherNet/IP Adapter are 
transmitted to the EtherNet/IP Scanner. 

 (green) In OPERATION state 

 (gray) Not  
in OPERATION state 

Idle Shows whether the EtherNet/IP device is in idle 
state. 

 (yellow) In IDLE state 

 (gray) Not in IDLE state 
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LED Meaning Color State 

Stop Shows whether the EtherNet/IP device is in Stop 
state: There is no cyclic data exchange at the 
EtherNet/IP network. The EtherNet/IP device was 
stopped by the application program or it changed to 
the Stop state because of a bus error. 

 (red) In STOP state 

 (gray) Not in STOP state 

Offline  The EtherNet/IP Adapter is offline as long as it does 
not have a valid configuration. 

 (yellow) In OFFLINE state 

 (gray) Not in OFFLINE state 

Configuration State 

Configuration 
locked 

Shows whether the EtherNet/IP device configuration 
is locked, to avoid the configuration data are typed 
over. 

 (yellow) Configuration LOCKED 

 (gray) Configuration not 
LOCKED 

New Configura-
tion pending 

Shows whether a new EtherNet/IP device 
configuration is available. 

 (yellow) New Configuration 
pending 

 (gray) No new Configuration 
pending 

Reset required Shows whether a firmware reset is required as a 
new EtherNet/IP device configuration has been 
loaded into the device. 

 (yellow) RESET required 

 (gray) No RESET required 

Bus ON Shows whether the bus communication was started 
or stopped. I. e., whether the device is active on the 
bus or no bus communication to the device is 
possible and no response telegrams are sent. 

 (green) Bus ON 

 (gray) Bus OFF 

Table 32: Indication General Diagnosis 

 
 

Parameter Meaning 
Communication Error Shows the name of the communication error. If the cause of error is resolved, the value will be 

set to zero again. 

Watchdog time Shows the watchdog time in ms. 

Error Count This field holds the total number of errors detected since power-up, respectively after reset. 
The protocol stack counts all sorts of errors in this field no matter whether they were network 
related or caused internally. 

Table 33: Parameter General Diagnosis 
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8.3 Firmware Diagnosis 
In the dialog Firmware Diagnosis the current task information of the 
firmware is displayed.  

Under Firmware or Version the name of the firmware and version 
(including the date) are indicated. 

 
Figure 44: Firmware Diagnosis (Example) 

Task Information: 
The table Task Information is listing the task information of the single 
firmware tasks. 
 

Column Meaning 
Task Task number  

Name of task Name of the task 

Version Version number of the task 

Prio Priority of the task 

Description Description of the task 

Status Current status of the task 

Table 34: Description Table Task Information 
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9 Extended Diagnosis 
9.1 Overview Extended Diagnosis 

The Extended Diagnosis of the EtherNet/IP Adapter DTM helps to find 
communication and configuration errors. Therefore it contains a list of 
diagnosis structures as online counter, states and parameters.  

Dialog Panes “Extended Diagnosis” 
The table below gives an overview for the Extended Diagnosis dialog 
panes descriptions: 
 

EtherNet/IP Adapter DTM Folder Name in the 
Navigation Area 

Subsection Page 

 

RX-SYSTEM Task Information  87 

 IniBatch Status 88 

DPM_COMO_SMBX
 Task Information  87 

DPM_COMO_RMBX
 Task Information  87 

TLR_TIMER Task Information  87 

EIS_CL1_TASK Task Information  87 
EIS_ENCAP_TASK Task Information  87 

 Encap Command Counter  90 

 Code Diagnosis 89 

EIS_OBJECT_TASK Task Information  87 

 Object Request   91 
 Outgoing Connection 92 

 Ingoing Connection 92 

 Code Diagnosis 89 

EIS_TCPUDP Task Information  87 

 IP Information  93 

 IP Paket Counter 94 
 IP Code Diagnosis 95 

 TCP_UDP Information 96 

 TCP_UDP Code Diagnosis 97 

EIS_AP_TASK Task Information  87 

 Common Diagnosis  98 

 General State 98 
 Code Diagnosis 89 

EIS_DLR_TASK Task Information  87 

 DLR Object Diagnosis 99 

 DLR Objekt Counter 101 

 Code Diagnosis 89 

MARSHALLER Task Information  87 
ETH_INTF Task Information  87 

PACKET_ROUTER Task Information  87 

Table 35: Descriptions of the Dialog Panes Extended Diagnosis 
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Online Connection to the Device 

 
Note: Accessing the Extended Diagnosis dialog panes of the 
EtherNet/IP Adapter DTM requires an online connection from the 
EtherNet/IP Adapter DTM to the EtherNet/IP Adapter device. For further 
information refer to section Connecting/Disconnecting Device on page 77. 

 
 
 

9.2 Task Information 

 
Figure 45: Extended Diagnosis > [Folder Name] > Task Information Example Display 

Name Description 
Identifier Identification number of the task 

Major version Task version, contains incompatible changes 

Minor version Task version, contains compatible changes 

Maximum packet size Maximum packet size, which the task sends 

Default Queue Queue handle, which is accessible via DPM by mailbox. 

UUID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g. to a stack 
(therein different identification data are coded in). 

Init result Error Code, 0= no Error 
The description of the error codes can be found in this manual or in the corresponding 
software reference manuals. 

Table 36: Extended Diagnosis > [Folder Name] > Task Information 
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9.3 IniBatch Status 

 
Figure 46: Extended Diagnosis > [Folder Name] > IniBatch Status Example Display 

Name Description 
Communication Channel Number of the communication channel used by the device. 

Current State Idle; 
IniBatch packets in progress; 
Retrying to send last packet; 
Error 

IniBatch Result Ok; 
No DBM file; 
No Packet table; 
No data set available;  
Data set is shorter than packet length; 
Packet Buffer is shorter than Packet length; 
Invalid packet destination; 
Logical queue not defined 
Send packet failed; 
Too many retries; 
Error in confirmation packet status 

OpenDbm Result Error when opening the IniBatch data base 
Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM 
file" (1) is. 

SendPacket Result Error when sending a packet 
Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send 
packet failed" (8) is. 

Confirmation Result Confirmation error when sending packets 
Under "Confirmation Result" the packet specific error code from the ulSta is typed in, when 
"IniBatch Result " == "Error in confirmation packet status" (10) is. 

Last Packet Number Value depends by the communication system. 

Last Packet Command Value depends by the communication system. 

Last Packet Length Value depends by the communication system. 

Last Packet Destination Value depends by the communication system. 

Table 37:  Extended Diagnosis > [Folder Name] > IniBatch Status 

The task status "Confirmation Result" is bus specific. The other task 
statuses are rcx-related error codes. 
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9.4 Code Diagnosis 

 
Figure 47: Extended Diagnosis > [Folder Name] > Code Diagnosis 

 

Name Description 
Info Counter Counter for information reports 

Warning 
Counter 

Counter for warning reports 

Error Counter Counter for errors 

Error Level Level of the last occurred error 

Error Code Code of the last occurred error 

Parameter Additional information to the error 

Line number Line number inside the software module  

Module Software module 

Table 38: Extended Diagnosis > [Folder Name] > Code Diagnosis 
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9.5 EIS_ENCAP_TASK 
 

9.5.1 Encap Command Counter 

 
Figure 48: Extended Diagnosis > EIS_ENCAP_TASK > Encap Command Counter 

 

Name Description 
NOP Counter incoming encapsulation telegrams 

List Target Counter incoming encapsulation telegrams 

List Identity Counter incoming encapsulation telegrams 

List Services Counter incoming encapsulation telegrams 

List Interfaces Counter incoming encapsulation telegrams 

Register Session Counter incoming encapsulation telegrams 

Unregister Session Counter incoming encapsulation telegrams 

Process data Unit Date RR Data telegrams 

Unknown Command Counter incoming encapsulation telegrams 

Good Reply Counter incoming encapsulation telegrams 

Error Reply Counter incoming encapsulation telegrams 

Table 39: Extended Diagnosis > EIS_ENCAP_TASK > Encap Command Counter 
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9.6 EIS_OBJECT_TASK 
 

9.6.1 Object Request Counter 

 
Figure 49:  Extended Diagnosis > EIS_OBJECT_TASK > Object Request Counter 

The Object Request Counter table indicates the respective number of 
services sent to different objects. 
 

Name  Description  
Identity Get Attribute Single Counter for the Get Attribute Single services to the identity object. 

Identity Get Attribute All Counter for the Get Attribute All services to the identity object. 

Identity Reset Counter for the Reset services to the identity object. 

Identity unknown Command  Counter for the Unknown Command services to the identity object. 

Assembly Get Attribute Single Counter for the Get Attribute Single services to the assembly object. 

[Object] [Service] Counter for the [Object] services to the [Service] object. 

Table 40: Extended Diagnosis > EIS_OBJECT_TASK > Object Request Counter 
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9.6.2 Outgoing Connection 

 
Figure 50: Extended Diagnosis > EIS_OBJECT_TASK > Outgoing Connection 

 

Name Description 
Issue Open Counter for open issues 

Issue Close Counter for closed issues 

Open Connections Actual open connection 

Last error instance Last error instance 

Last GRC Last General Status Code 

Last ERC Last Extended Status Code 

Table 41: Extended Diagnosis > EIS_OBJECT_TASK > Outgoing Connection 

 

9.6.3 Ingoing Connection 

 
Figure 51:Extended Diagnosis > EIS_OBJECT_TASK > Ingoing Connection 

 

Name Description 
Last Errors Address IP Address 

Last GRC Last General Status Code 

Last ERC Last Extended Status Code 

Actual Connection Actual open connection 

Table 42: Extended Diagnosis > EIS_OBJECT_TASK > Ingoing Connection 
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9.7 EIS_TCPUDP 
 

9.7.1 IP Information 

 
Figure 52: Extended Diagnosis > EIS_TCPUDP >IP Information 

 

Name Description 
Task State Actual state of the protocol process: 

0 = Task not initialized 
1 = Task is running 
2 = Task initialized 
3 = Initialization error 

Error Counter Counter for errors 

Last Error Last occurred error (Description see appropriate Application Programming Manual) 

IP Address IP address of the Adapter station. 

Net Mask Network mask of the Adapter station. 

Gateway Gateway address of the Adapter station. 

IP config source IP configuration is done through the following sources: 
None (receive no configuration), 
DHCP server, 
BOOTP server, 
Database, warm-start packet, 
ICMP (ping) (not supported), 
Hilscher NetIdent protocol 

Table 43: Extended Diagnosis > EIS_TCPUDP > IP Information 
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9.7.2 IP Paket Counter 

 
Figure 53: Extended Diagnosis > EIS_TCPUDP > IP Packet Counter  

 

Name Description 
Packet Recv TCP Counter for received TCP packets 

Packet Recv UDP Counter for received UDP packets 

Packet Recv ICMP Counter for received ICMP packets 

Packet Recv IP Header Err Counter for received IP packets with errors 

Packet Recv ARP Counter for received ARP packets 

Packet Recv Unknown Counter for received packets of an unknown type 

Table 44: Extended Diagnosis > EIS_TCPUDP > IP Packet Counter 
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9.7.3 IP Code Diagnosis 

 
Figure 54: Extended Diagnosis > EIS_TCPUDP > IP-Code Diagnosis 

 

Name Description 

Info Counter Counter for information reports 

Warning Counter Counter for warning reports 

Error Counter Counter for errors 

Severity Level Level of the last occurred error 

Code Code of the last occurred error 

Parameter Additional information to the error 

Module Software module 

Line number Line number inside the software module  

Table 45: Extended Diagnosis >  EIS_TCPUDP > IP-Code Diagnosis 
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9.7.4 TCP_UDP Information 

 
Figure 55: Extended Diagnosis > EIS_TCPUDP > TCP_UDP 

 

Name Description 
Task State Actual state of the protocol process: 

0 = Task not initialized 
1 = Task is running 
2 = Task initialized 
3 = Initialization error 

Error Count Counter for errors 

Last Error Last occurred error (Description see appropriate Application Programming Manual) 

Table 46: Extended Diagnosis > EIS_TCPUDP > TCP_UDP Information 
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9.7.5 TCP_UDP Code Diagnosis 

 
Figure 56: Extended Diagnosis > EIS_TCPUDP > TCP_UDP Code Diagnosis  

 

Name Description 
Info Counter Counter for information reports 

Warning Counter Counter for warning reports 

Error Counter Counter for errors 

Severity Level Level of the last occurred error 

Code Code of the last occurred error 

Parameter Additional information to the error 

Module Software module 

Line number Line number inside the software module  

Table 47: Extended Diagnosis > EIS_TCPUDP > TCP_UDP Code Diagnosis 
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9.8 EIS_AP_TASK 
 

9.8.1 Common Diagnosis 

 
Figure 57: Extended Diagnosis > EIS_AP_TASK > Common Diagnosis 

 

Name Description 
Status field Communication change of state 

Bus state Communication state 

Communication Error Unique Error Code according to protocol stack  
(not supported yet) 

Version Version number of this diagnosis structure 

Watchdog time Configured watchdog time 

Protocol Class Protocol class:  
MASTER, SLAVE, CLIENT, SERVER, GATEWAY 

Error Counter Total number of detected error since power-up or reset 

Table 48: Extended Diagnosis > EIS_AP_TASK > Common Diagnosis 

 

9.8.2 General State 

 
Figure 58: Extended Diagnosis > EIS_AP_TASK > General State 

 

Name Description 
Error Code Code es zuletzt aufgetretenen Fehlers 

Table 49: Extended Diagnosis >  EIS_AP_TASK > General State 
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9.9 EIS_DLR_TASK 
 

9.9.1 DLR Object Diagnosis 

 
Figure 59: Extended Diagnosis > EIS_DLR_TASK > DLR Object Diagnosis 

 

Name Description 
Network Topology Possible Values: Linear or Ring 
Network Status Possible Values: Normal, Ring fault, Unexpected loop detected, Partial network fault, 

Rapid fault/Restore cycle 
Ring Supervisor Status Possible Values: Backup, Active ring supervisor, Normal ring node, None DLR 

device, Current supervisor parameters not supported 
Ring Supervisor Mode  Possible Values: Deactivated, Activated 
Ring Supervisor Precedence Precedence value assigned to a ring supervisor, and transmitted in Beacon frames 

(further see www.odva.org) 
Beacon-Interval 
(Mikro-Sek) 

Ring interval at which the supervisor sends beacon frames (further see 
www.odva.org) 

http://www.odva.org/
http://www.odva.org/
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Name Description 
Beacon-Timeout 
(Mikro-Sek) 

Amount of time nodes will wait before timing out reception of Beacon frames and 
taking the appropriate action (depending on wether supervisor or normal ring node). 
(further see www.odva.org) 

VLAN-ID VLAN ID used when sending DLR protocol frames. 
Ring faults count Counts Ring faults  
MAC of last active  
node port 1 

MAC Address of last active node at port 1 

IP of last active  
node port 1 

IP Address of last active nodeat  port 1 

MAC of last active 
node port 2 

MAC Address of last active node at port 2 

IP of last active  
node port 2 

IP Address of last active node at port 2 

Ring participants count Ring participants count 
MAC of active ring 
supervisor 

MAC Address of active ring supervisor 

IP of active ring supervisor IP Address of active ring supervisor 
Precedence of active ring 
supervisor 

The precedence the supervisor has in the ring. 

Capability Flags Indicates which capabililties the supervisor has. 
MAC Node 1 MAC Address Node 1 
IP Node 1 IP Address Node 1 
to  
MAC Node 10 MAC Address Node 2 
IP Node 10 IP Address Node 2 

Table 50: Extended Diagnosis > EIS_DLR_TASK > DLR Object Diagnosis 

 

http://www.odva.org/
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9.9.2 DLR Objekt Counter 

 
Figure 60: Extended Diagnosis > EIS_DLR_TASK > DLR Object Counter 

 

Name Description 
[Service] Diagnosis counter of the encapsulation layer. Indicates the services processed. 

(The services of the single packets are described in the API manual.) 

Table 51: Extended Diagnosis >  EIS_DLR_TASK > DLR Object Counter 
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10 Tools 
10.1 Overview Tools 

Under Tools the Packet Monitor and the IO Monitor are provided for test 
and diagnosis purposes.  

Tools Panes 
The table below gives an overview for the individual Tools dialog panes 
descriptions: 

EtherNet/IP Adapter DTM Folder Name / Section Manual Page 

Navigation Area - Tools 

Packet Monitor 103 

IO Monitor 106 

Table 52: Descriptions of the Diagnosis Panes 

Online Connection to the Device 
Note: Accessing the Tools dialog panes of the EtherNet/IP Adapter DTM 
requires an online connection from the EtherNet/IP Adapter DTM to the 
EtherNet/IP Adapter device. For further information refer to section 
Connecting/Disconnecting Device on page 77. 
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10.2 Packet Monitor 
The Packet Monitor serves for test and diagnosis purposes.  

Data packets, i. e. messages are self-contained blocks of defined data 
length. The packets are used to communicate with the firmware and they 
are exchanged between the application (configuration software) and the 
firmware in the device. Packets can be sent once or cyclically to the 
connected device controlled by the user and packets received can be 
displayed. 

Data packets comprise from a Packet Header and the Send Data or from 
a Packet Header and the Receive Data. The packet header can be 
evaluated by the receiver of the packet and contain the sender and receiver 
address, the data length, an ID number, status and error messages and the 
command or response code. The minimum packet size amounts 40 Byte 
for the packet header. The sending and receiving data are added. 
 

 

For further information to the packet description refer to the Protocol API 
Manual.  

 Open the Packet Monitor via Tools > Packet Monitor. 

 
Figure 61: Packet Monitor 

Display Mode switches the representation of the send and reception data 
between decimal and hexadecimal. 

 Select Reset Counter to reset the packet counter. 
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10.2.1 Sending Packet 

 
Figure 62: Send > Packet Header and Send Data 

Packet Header 
Under Send > Packet Header the elements of the packet header of the 
sending packet are displayed, which is transmitted from the application 
(configuration software) to the device. The packet header of the sending 
packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task 

queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).  
Dest 
ID 

Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the 
firmware to the application (configuration software).  

Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 53: Descriptions Packet Header 

 

 Under Dest select the receiver (destination task queue). 

 Under Cmd select the command identification (Request). 

Auto Increment ID is an increment for the identifier of the data packets 
and increments the ID by 1 for each newly sent packet. 

Send Data 
 Under Send > Send data enter the send data of the packet, which shall 

be transmitted from the application (configuration software) to the 
mailbox of the device. The meaning of the transmitted data depends on 
the command or response code. 
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Sending Packets once or cyclic 
 To send packet once, select Put packet. 
 To send packet cyclic, select Put cyclic. 
 

10.2.2 Receiving Packet 

 
Figure 63: Packet Header and Receive Data 

Packet Header 
Under Receive > Packet Header the elements of the packet header of the 
receiving packet are displayed, which are transmitted back from the device 
to the application (configuration software). The packet header of the 
receiving packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task 

queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).  
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from 

the firmware to the application (configuration software).  
Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 54: Descriptions Packet Header 

Receive Data 
Under Receive > Receive Data the receiving data of the packet, which is 
transmitted back from the device to the application (configuration software) 
are displayed. 
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10.3 IO Monitor 
The IO Monitor serves for test and diagnosis purposes. It provides to view 
data of the process data image and to change output data easily. The 
display is always in a Byte manner.  
 

 
Note: Only change and write output data if you know that no plant 
disturbances are caused by this. All output data written by the IO Monitor 
are transmitted at the bus and have effect on subordinate drives, IO etc. 

 

 
Figure 64: IO Monitor 

Columns switches the number of columns.  

Display mode switches the representation of the input and output data 
between decimal and hexadecimal. 

Offset / Go moves the indication of the data to the entered offset value. 

 Enter the output value and select Update.  

 Always the data of the process image are displayed, also when these 
Bytes have not been reserved by the configuration.  
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11 Error Codes 
11.1 Error Code Definition 

For COM based application, like the ODM Server and ODM drivers, a 
common error definition is used, similar to the Microsoft Windows® 
HRESULT definition. 

Error Code Structure: 

COM Errors are HRESULTs, which are 32 bit values using the following 
layout: 

 3 3 2 2 2 2 2 2 2 2 2 2 1 1 1 1 1 1 1 1 1 1 

 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 

+---+-+-+-----------------------+-------------------------------+ 

|Sev|C|R|     Facility          |               Code            | 

+---+-+-+-----------------------+-------------------------------+ 

 

where 

Sev       - is the severity code: 

       00 - Success 

       01 - Informational 

       10 - Warning 

       11 - Error 

C         - is the Customer code flag 

R         - is a reserved bit 

Facility  - is the facility code 

Code      - is the facility's status code 

In this common error definition, several error code regions are already 
reserved by Windows® itself, the ODM and some other modules.  
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11.2 Overview Error Codes 
 
 

Overview Error Codes Range 

General Hardware Errors 
RCX Operating System 

RCX General Task: 0xC02B0001 to 0xC02B4D52 

RCX Common Status & Errors Codes: 0x00000000 to 0xC002000C 

RCX Status & Error Codes: 0x00000000 to 0xC0000008 

EtherNet/IP Adapter /  
Packet Status& 
Packet Errors 

Error Codes Ethernet/IP Encapsulation - EipEncap:0xC01E0001L to 0xC01EFFFFL 

Error Codes Ethernet/IP Object - EipObject Error: 0xC01F0001L to 0xC01FFFFFL 

Error Codes Ethernet/IP Application Task: 0xC0590001 to 0xC059000F 

TCP Error Codes: 0xC0070001L to 0xC008FFFFL 

Status & Error Codes TCP_IP-Task: 0xC0070034L to 0xC0080315L 

EtherNet/IP  
General CIP Errors 

General Error CIP Codes: 00 to D0-FF 

CIP Connection 
Manager Object Instance 
Extended Status Codes 

CIP Connection-Manager-Object-Instance Codes zum Erweiterten Status:  
General Status: 0x01 to 0x15 and  
Extended Status: 0x0000 to 0xFCFF 

ODM Server General ODM Error Codes: 0x8004C700 to 0x8004C761 

General ODM Driver Error Codes: 0x8004C7A0 to 0x8004C7C2 

ODM Drivers cifX Driver Specific ODM Error: 0x8004C001 to 0x8004C0A4 

cifX Device Driver  
and netX Driver 

Generic Error: 0x800A0001 bis 0x800A0017 

Generic Driver Error: 0x800B0001 bis0x800B0042 

Generic Device Error: 0x800C0010 bis0x800C0041 

netX Driver CIFX API Transport: 0x800D0001 bis 0x800D0013 

CIFX API Transport Header State Error: 0x800E0001 bis 0x800E000B 

DBM ODM Error Codes: 0xC004C810 to 0xC004C878 

Table 55: Overview Error Codes and Ranges 

 
 

 

The fieldbus specific error codes are described in the manuals of the 
corresponding protocol tasks. 
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11.3 General Hardware Error Codes 
 

11.3.1 RCX General Task Errors 
 

Error Code (Definition) Value Description 
RCX_E_QUE_UNKNOWN 0xC02B0001 Unknown Queue 
RCX_E_QUE_INDEX_UNKNOWN 0xC02B0002 Unknown Queue Index 
RCX_E_TASK_UNKNOWN 0xC02B0003 Unknown Task 
RCX_E_TASK_INDEX_UNKNOWN 0xC02B0004 Unknown Task Index 
RCX_E_TASK_HANDLE_INVALID 0xC02B0005 Invalid Task Handle 
RCX_E_TASK_INFO_IDX_UNKNOWN 0xC02B0006 Unknown Index 
RCX_E_FILE_XFR_TYPE_INVALID 0xC02B0007 Invalid Transfer Type 
RCX_E_FILE_REQUEST_INCORRECT 0xC02B0008 Invalid File Request  
RCX_E_TASK_INVALID 0xC02B000E Invalid Task 
RCX_E_SEC_FAILED 0xC02B001D Security EEPROM Access Failed 
RCX_E_EEPROM_DISABLED 0xC02B001E EEPROM Disabled 
RCX_E_INVALID_EXT 0xC02B001F Invalid Extension 
RCX_E_SIZE_OUT_OF_RANGE 0xC02B0020 Block Size Out Of Range 
RCX_E_INVALID_CHANNEL 0xC02B0021 Invalid Channel 
RCX_E_INVALID_FILE_LEN 0xC02B0022 Invalid File Length 
RCX_E_INVALID_CHAR_FOUND 0xC02B0023 Invalid Character Found 
RCX_E_PACKET_OUT_OF_SEQ 0xC02B0024 Packet Out Of Sequence 
RCX_E_SEC_NOT_ALLOWED 0xC02B0025 Not Allowed In Current State 
RCX_E_SEC_INVALID_ZONE 0xC02B0026 Security EEPROM Invalid Zone 
RCX_E_SEC_EEPROM_NOT_AVAIL 0xC02B0028 Security EEPROM Eeprom Not Available 
RCX_E_SEC_INVALID_CHECKSUM 0xC02B0029 Security EEPROM Invalid Checksum 
RCX_E_SEC_ZONE_NOT_WRITEABLE 0xC02B002A Security EEPROM Zone Not Writeable 
RCX_E_SEC_READ_FAILED 0xC02B002B Security EEPROM Read Failed 
RCX_E_SEC_WRITE_FAILED 0xC02B002C Security EEPROM Write Failed 
RCX_E_SEC_ACCESS_DENIED 0xC02B002D Security EEPROM Access Denied 
RCX_E_SEC_EEPROM_EMULATED 0xC02B002E Security EEPROM Emulated 
RCX_E_INVALID_BLOCK 0xC02B0038 Invalid Block 
RCX_E_INVALID_STRUCT_NUMBER 0xC02B0039 Invalid Structure Number 
RCX_E_INVALID_CHECKSUM 0xC02B4352 Invalid Checksum 
RCX_E_CONFIG_LOCKED 0xC02B4B54 Configuration Locked 
RCX_E_SEC_ZONE_NOT_READABLE 0xC02B4D52 Security EEPROM Zone Not Readable 

Table 56: RCX General Task Errors 
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11.3.2 RCX Common Status & Errors Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK 0x00000000 Success, Status Okay 
RCX_E_FAIL 0xC0000001 Fail 
RCX_E_UNEXPECTED 0xC0000002 Unexpected 
RCX_E_OUTOFMEMORY 0xC0000003 Out Of Memory 
RCX_E_UNKNOWN_COMMAND 0xC0000004 Unknown Command 
RCX_E_UNKNOWN_DESTINATION 0xC0000005 Unknown Destination 
RCX_E_UNKNOWN_DESTINATION_ID 0xC0000006 Unknown Destination ID 
RCX_E_INVALID_PACKET_LEN 0xC0000007 Invalid Packet Length 
RCX_E_INVALID_EXTENSION 0xC0000008 Invalid Extension 
RCX_E_INVALID_PARAMETER 0xC0000009 Invalid Parameter 
RCX_E_WATCHDOG_TIMEOUT 0xC000000C Watchdog Timeout 
RCX_E_INVALID_LIST_TYPE 0xC000000D Invalid List Type 
RCX_E_UNKNOWN_HANDLE 0xC000000E Unknown Handle 
RCX_E_PACKET_OUT_OF_SEQ 0xC000000F Out Of Sequence 
RCX_E_PACKET_OUT_OF_MEMORY 0xC0000010 Out Of Memory 
RCX_E_QUE_PACKETDONE 0xC0000011 Queue Packet Done 
RCX_E_QUE_SENDPACKET 0xC0000012 Queue Send Packet 
RCX_E_POOL_PACKET_GET 0xC0000013 Pool Packet Get 
RCX_E_POOL_GET_LOAD 0xC0000015 Pool Get Load 
RCX_E_REQUEST_RUNNING 0xC000001A Request Already Running 
RCX_E_INIT_FAULT 0xC0000100 Initialization Fault 
RCX_E_DATABASE_ACCESS_FAILED 0xC0000101 Database Access Failed 
RCX_E_NOT_CONFIGURED 0xC0000119 Not Configured 
RCX_E_CONFIGURATION_FAULT 0xC0000120 Configuration Fault 
RCX_E_INCONSISTENT_DATA_SET 0xC0000121 Inconsistent Data Set 
RCX_E_DATA_SET_MISMATCH 0xC0000122 Data Set Mismatch 
RCX_E_INSUFFICIENT_LICENSE 0xC0000123 Insufficient License 
RCX_E_PARAMETER_ERROR 0xC0000124 Parameter Error 
RCX_E_INVALID_NETWORK_ADDRESS 0xC0000125 Invalid Network Address 
RCX_E_NO_SECURITY_MEMORY 0xC0000126 No Security Memory 
RCX_E_NETWORK_FAULT 0xC0000140 Network Fault 
RCX_E_CONNECTION_CLOSED 0xC0000141 Connection Closed 
RCX_E_CONNECTION_TIMEOUT 0xC0000142 Connection Timeout 
RCX_E_LONELY_NETWORK 0xC0000143 Lonely Network 
RCX_E_DUPLICATE_NODE 0xC0000144 Duplicate Node 
RCX_E_CABLE_DISCONNECT 0xC0000145 Cable Disconnected 
RCX_E_BUS_OFF 0xC0000180 Network Node Bus Off 
RCX_E_CONFIG_LOCKED 0xC0000181 Configuration Locked 
RCX_E_APPLICATION_NOT_READY 0xC0000182 Application Not Ready 
RCX_E_TIMER_APPL_PACKET_SENT 0xC002000C Timer App Packet Sent 

Table 57: RCX Common Status & Errors Codes 
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11.3.3 RCX Status & Error Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK  0x00000000 SUCCESS, STATUS OKAY  
RCX_S_QUE_UNKNOWN  0xC02B0001 UNKNOWN QUEUE  
RCX_S_QUE_INDEX_UNKNOWN  0xC02B0002 UNKNOWN QUEUE INDEX 
RCX_S_TASK_UNKNOWN 0xC02B0003 UNKNOWN TASK  
RCX_S_TASK_INDEX_UNKNOWN 0xC02B0004 UNKNOWN TASK INDEX  
RCX_S_TASK_HANDLE_INVALID 0xC02B0005 INVALID TASK HANDLE  
RCX_S_TASK_INFO_IDX_UNKNOWN 0xC02B0006 UNKNOWN INDEX  
RCX_S_FILE_XFR_TYPE_INVALID 0xC02B0007 INVALID TRANSFER TYPE  
RCX_S_FILE_REQUEST_INCORRECT 0xC02B0008 INVALID FILE REQUEST  
RCX_S_UNKNOWN_DESTINATION 0xC0000005 UNKNOWN DESTINATION  
RCX_S_UNKNOWN_DESTINATION_ID 0xC0000006 UNKNOWN DESTINATION ID  
RCX_S_INVALID_LENGTH 0xC0000007 INVALID LENGTH  
RCX_S_UNKNOWN_COMMAND 0xC0000004 UNKNOWN COMMAND  
RCX_S_INVALID_EXTENSION 0xC0000008 INVALID EXTENSION  

Table 58: RCX Status & Error Codes 

 

11.3.3.1 RCX Status & Error Codes Slave State 
 

Error Code (Definition) Value Description 
RCX_SLAVE_STATE_UNDEFINED 0x00000000 UNDEFINED 
RCX_SLAVE_STATE_OK 0x00000001 OK 
RCX_SLAVE_STATE_FAILED 0x00000002 FAILED (at least one slave) 

Table 59: RCX Status & Error Codes Slave State 
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11.4 Status & Error Codes EtherNet/IP Adapter 
 

11.4.1 Error Codes Ethernet/IP Encapsulation - EipEncap Error 
 
 

 

Status & Error Codes EtherNet/IP - EipEncap Error 
Error Code (Definition) Value Description 
TLR_E_EIP_ENCAP_COMMAND_INVALID 0xC01E0001 Invalid command received. 
TLR_E_EIP_ENCAP_NOT_INITIALIZED 0xC01E0002 Encapsulation layer is not initialized. 
TLR_E_EIP_ENCAP_OUT_OF_MEMORY 0xC01E0003 System is out of memory. 
TLR_E_EIP_ENCAP_OUT_OF_PACKETS 0xC01E0010 Task runs out of empty packets at the local 

packet pool. 
TLR_E_EIP_ENCAP_SEND_PACKET 0xC01E0011 Sending a packet failed. 
TLR_E_EIP_ENCAP_SOCKET_OVERRUN 0xC01E0012 No free socket is available. 
TLR_E_EIP_ENCAP_INVALID_SOCKET 0xC01E0013 Socket ID is invalid. 
TLR_E_EIP_ENCAP_CEP_OVERRUN 0xC01E0014 Connection could not be open. No 

resource for a new Connection Endpoint 
available. 

TLR_E_EIP_ENCAP_UCMM_OVERRUN 0xC01E0015 Message couldn't send. All Unconnect 
Message Buffers are in use. 

TLR_E_EIP_ENCAP_TRANSP_OVERRUN 0xC01E0016 Connection couldn't be opened. All 
transports are in use. 

TLR_E_EIP_ENCAP_UNKNOWN_CONN_TYP 0xC01E0017 Received Message include an unknown 
connection typ. 

TLR_E_EIP_ENCAP_CONN_CLOSED 0xC01E0000 Connection was closed. 
TLR_E_EIP_ENCAP_CONN_RESETED 0xC01E0019 Connection is reseted from remote device. 
TLR_S_EIP_ENCAP_CONN_UNREGISTER 0x001E001A We closed the conncetion successful. With 

an unregister command. 
TLR_E_EIP_ENCAP_CONN_STATE 0xC01E001B Wrong connection state for this service. 
TLR_E_EIP_ENCAP_CONN_INACTIV 0xC01E001C Encapsulation sesson was deactivated 
TLR_E_EIP_ENCAP_INVALID_IPADDR 0xC01E001D received an invalid IP address. 
TLR_E_EIP_ENCAP_INVALID_TRANSP 0xC01E001E Invalid transport typ. 
TLR_E_EIP_ENCAP_TRANSP_INUSE 0xC01E001F Transport is still in use. 
TLR_E_EIP_ENCAP_TRANSP_CLOSED 0xC01E0020 Transport is closed. 
TLR_E_EIP_ENCAP_INVALID_MSGID 0xC01E0021 The received message has a invalid 

message ID. 
TLR_E_EIP_ENCAP_INVALID_MSG 0xC01E0022 invalid encapsulation message received. 
TLR_E_EIP_ENCAP_INVALID_MSGLEN 0xC01E0023 Received message with invalid length. 
TLR_E_EIP_ENCAP_CL3_TIMEOUT 0xC01E0030 Class 3 connection runs into timeout. 
TLR_E_EIP_ENCAP_UCMM_TIMEOUT 0xC01E0031 Unconnected message gets a timeout. 
TLR_E_EIP_ENCAP_CL1_TIMEOUT 0xC01E0032 Timeout of a class 3 connection. 
TLR_W_EIP_ENCAP_TIMEOUT 0x801E0033 Encapsulation service is finished by 

timeout. 
TLR_E_EIP_ENCAP_CMDRUNNING 0xC01E0034 Encapsulation service is still running. 
TLR_E_EIP_ENCAP_NO_TIMER 0xC01E0035 No empty timer available. 
TLR_E_EIP_ENCAP_INVALID_DATA_IDX 0xC01E0036 The data index is unknown by the task. 

Please ensure that it is the same as at the 
indication. 

TLR_E_EIP_ENCAP_INVALID_DATA_AREA 0xC01E0037 The parameter of the data area are invalid. 
Please check length and offset. 
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Status & Error Codes EtherNet/IP - EipEncap Error 
Error Code (Definition) Value Description 
TLR_E_EIP_ENCAP_INVALID_DATA_LEN 0xC01E0038 Packet length is invalid. Please check 

length of the packet. 
TLR_E_EIP_ENCAP_TASK_RESETING 0xC01E0039 Ethernet/IP Encapsulation Layer runs a 

reset. 

Table 60: Status & Error Codes EtherNet/IP - EipEncap Error 

 

11.4.2 Error Codes Ethernet/IP Object - EipObject Error 
 

Error Code (Definition) Value Description 
TLR_E_EIP_OBJECT_COMMAND_INVALID 0xC01F0001 Invalid command received. 
TLR_E_EIP_OBJECT_OUT_OF_MEMORY 0xC01F0002 System is out of memory. 
TLR_E_EIP_OBJECT_OUT_OF_PACKETS 0xC01F0003 Task runs out of empty packets at the local 

packet pool. 
TLR_E_EIP_OBJECT_SEND_PACKET 0xC01F0004 Sending a packet failed. 
TLR_E_EIP_OBJECT_AS_ALLREADY_EXIST 0xC01F0010 Assembly instance already exist. 
TLR_E_EIP_OBJECT_AS_INVALID_INST 0xC01F0011 Invalid Assembly Instance. 
TLR_E_EIP_OBJECT_AS_INVALID_LEN 0xC01F0012 Invalid Assembly length. 
TLR_E_EIP_OBJECT_CONN_OVERRUN 0xC01F0020 No free connection buffer available 
TLR_E_EIP_OBJECT_INVALID_CLASS 0xC01F0021 Object class is invalid. 
TLR_E_EIP_OBJECT_SEGMENT_FAULT 0xC01F0022 Segment of the path is invalid. 
TLR_E_EIP_OBJECT_CLASS_ALLREADY_EXIST 0xC01F0023 Object Class is already used. 
TLR_E_EIP_OBJECT_CONNECTION_FAIL 0xC01F0024 Connection failed. 
TLR_E_EIP_OBJECT_CONNECTION_PARAM 0xC01F0025 Unknown format of connection parameter 
TLR_E_EIP_OBJECT_UNKNOWN_CONNECTION 0xC01F0026 Invalid connection ID. 
TLR_E_EIP_OBJECT_NO_OBJ_RESSOURCE 0xC01F0027 No resource for creating a new class 

object available. 
TLR_E_EIP_OBJECT_ID_INVALID_PARAMETER 0xC01F0028 Invalid request parameter. 
TLR_E_EIP_OBJECT_CONNECTION_FAILED 0xC01F0029 See also General Error Code and 

Extended Error Code for more details. 
TLR_E_EIP_OBJECT_PACKET_LEN 0xC01F0030 Packet length of the request is invalid. 
TLR_E_EIP_OBJECT_READONLY_INST 0xC01F0031 Access denied. Instance is read only. 
TLR_E_EIP_OBJECT_DPM_USED 0xC01F0032 DPM address is already used by an other 

instance. 
TLR_E_EIP_OBJECT_SET_OUTPUT_RUNNING 0xC01F0033 Set Output command is already runnning. 
TLR_E_EIP_OBJECT_TASK_RESETING 0xC01F0034 Ethernet/IP Object Task is running a reset. 

Table 61:  Status & Error Codes EtherNet/IP - EipObject Error 
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11.4.3 Error Codes Ethernet/IP Application Task 
 

Error Code (Definition) Value Description 
TLR_E_EIP_APS_COMMAND_INVALID    0xC0590001 Invalid command received. 
TLR_E_EIP_APS_PACKET_LENGTH_INVALID 0xC0590002 Invalid packet length. 
TLR_E_EIP_APS_PACKET_PARAMETER_INVALI
D 

0xC0590003 Parameter of the packet are invalid. 

TLR_E_EIP_APS_TCP_CONFIG_FAIL  0xC0590004 Configuration of TCP/IP failed. 
TLR_E_EIP_APS_CONNECTION_CLOSED  0xC0590005 Existing connection is closed. 
TLR_E_EIP_APS_ALREADY_REGISTERED 0xC0590006 A application is already registered. 
TLR_E_EIP_APS_ACCESS_FAIL 0xC0590007 Command is not allowed. 
TLR_E_EIP_APS_STATE_FAIL 0xC0590008 Command not allowed at this state. 
TLR_E_EIP_APS_IO_OFFSET_INVALID  0xC0590009 Invalid offset for I/O data. 
TLR_E_EIP_APS_FOLDER_NOT_FOUND   0xC059000A Folder for database not found. 
TLR_E_EIP_APS_CONFIG_DBM_INVALID 0xC059000B Configuration database invalid. 
TLR_E_EIP_APS_NO_CONFIG_DBM  0xC059000C Configuration database not found. 
TLR_E_EIP_APS_NWID_DBM_INVALID   0xC059000D network database invalid. 
TLR_E_EIP_APS_NO_NWID_DBM 0xC059000E network database not found. 
TLR_E_EIP_APS_NO_DBM  0xC059000F no database found. 

Table 62:  Status & Error Codes EtherNet/IP - Application Task 
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11.4.4 TCP Error Codes 
 

 

Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_IP_ERR_INIT_NO_ ETHERNET_ADDR 0xC0070034 There is no Ethernet address (MAC 

address) available. 
TLR_E_IP_ERR_INIT_INVALID_ FLAG 0xC0070036 The start parameters contains one or more 

unknown flags. 
TLR_E_IP_ERR_INIT_INVALID_ IP_ADDR 0xC0070037 The start parameters contains an invalid IP 

address. 
TLR_E_IP_ERR_INIT_INVALID_ NETMASK 0xC0070038 The start parameters contains an invalid 

subnet mask. 
TLR_E_IP_ERR_INIT_ UNKNOWN_HARDWARE 0xC007003B The device type is unknown. 
TLR_E_IP_ERR_INIT_NO_IP_ ADDR 0xC007003C Failed to obtain an IP address from the 

specified source(s). 

TLR_E_IP_ERR_INIT_DRIVER_ FAILED 0xC007003D The initialisation of the driver layer (EDD) 
is failed. 

TLR_E_IP_ERR_INIT_NO_IP_ ADDR_CFG 0xC007003E There is no source for an IP address 
(BOOTP, DHCP, IP address parameter) 
specified. 

TLR_E_IP_ERR_ETH_ADDR_ 
INVALID_IP_CMD_SET_PARAM 

0xC007007C The Ethernet address (MAC address) 
abEthernetAddr in command 
TCPIP_IP_CMD_SET_PARAM_REQ is 
invalid. Invalid means, abEthernetAddr is 
equal to the broadcast address FF-FF-FF- 
FF-FF-FF. 

TLR_E_IP_ERR_ARP_CACHE_ 
FULL_IP_CMD_SET_PARAM 

0xC0070083 The command 
TCPIP_IP_CMD_SET_PARAM_REQ 
could not be executed, because the ARP 
cache is full. The ARP cache has per 
default configuration 64 entries. 

TLR_E_IP_ERR_ARP_ENTRY_ 
NOT_FOUND_IP_CMD_SET_ PARAM 

0xC0070086 The specified ARP entry in command 
TCPIP_IP_CMD_SET_PARAM_REQ 
could not be deleted. The ARP entry was 
not found in ARP cache. 

TLR_E_IP_ERR_ARP_ENTRY_ 
NOT_FOUND_IP_CMD_GET_ PARAM 

0xC0070087 The requested ARP information in 
command 
TCPIP_IP_CMD_GET_PARAM_REQ 
could not be delivered. The ARP entry was 
not found in ARP cache. 

TLR_E_IP_ERR_DELAYED 0xC00700FE Special internal error code returned by 
IpStart function. 

TLR_E_IP_ERR_GENERIC 0xC00700FF Special internal error code returned by 
IpStart function. 

TLR_E_TCPIP_TCP_TASK_ COMMAND_INVALID 0xC0080001 Invalid command received. 
TLR_E_TCPIP_TCP_TASK_ 
PROCESS_CANCELED 

0xC0080002 Cancel process is in progress, command 
can not be executed. 

TLR_E_TCP_ERR_INIT_IP_ TASK_NOT_READY 0xC0080032 The IP layer is not ready. 
TLR_E_TCP_ERR_INIT_IP_ TASK_FAILED 0xC0080034 The initialization of IP layer has failed. 
TLR_E_TCP_ERR_INIT_ CREATE_INFO_FIELD 
 

0xC0080040 The creation of an information field (task 
state) has failed. 

TLR_W_TCP_ERR_INIT_TPIF_ INIT_REQ_PCKT 0x80080043 Warning: A pending application packet has 
discarded (because of a new application 
packet). 
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_INIT_OS_ CYCLETIME 0xC0080044 The configured oper-ating system 

cycletime is out of range (0.1 ms ... 20 
ms). 

TLR_E_TCP_ERR_INIT_OS_ 
AND_TCPUDP_CYCLETIME 

0xC0080045 The combination of configured operating 
system cycletime and TCP/IP stacks 
cycletime (startup-parameter 
ulTcpCycleEvent) is not possible. The 
operating system cycletime must be 
smaller or equal than the TCP/IP stacks 
cycletime. 

TLR_E_TCP_ERR_SOCKET_ INVALID 0xC0080070 The socket handle ulDestId is invalid. A 
further reason for this error: The command 
(Mode) is not applicable on this socket 
type (TCP/UDP). 

TLR_E_TCP_ERR_OPTION_ 
NOT_SUPPORTED_TCP_ CMD_SEND 

0xC0080074 The option parameter ulOptions in 
command TCPIP_TCP_CMD_SEND_REQ 
is invalid. 

TLR_E_TCP_ERR_ PARAMETER_INVALID_ 
TCP_UDP_CMD_SET_ SOCK_OPTION 

0xC0080075 The parameter ulTtl (ulMode = 
TCP_SOCK_TTL) or ulMulticastTtl 
(ulMode = TCP_SOCK_MULTICAST_TTL) 
or ulMulticastLoop (ulMode = 
TCP_SOCK_MULTICAST_LOOP) in 
command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid. 

TLR_E_TCP_ERR_CONN_ CLOSED 0xC0080078 The connection has closed (Graceful 
close). 

TLR_E_TCP_ERR_CONN_ RESET 0xC0080079 The Connection has closed by reset (Hard 
close). 

TLR_E_TCP_ERR_PROTOCOL 
_UNKNOWN_TCP_UDP_CMD_ OPEN 

0xC008007A The protocol parameter ulProtocol in 
command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid. 

TLR_E_TCP_ERR_NO_ SOCKETS_TCP_UDP_ 
CMD_OPEN 

0xC008007B Command 
TCPIP_TCP_UDP_CMD_OPEN_REQ: 
There are no socket handles available. 

TLR_E_TCP_ERR_MAX_ 
PCKT_CNT_EXCEEDED_ UDP_CMD_SEND 

0xC0080084 Command 
TCPIP_UDP_CMD_SEND_REQ: The 
maximum number of queued packets ( = 
TCPHDL_RCX_PCKT_QUEUED_MAX (6) 
) has exceeded. The request command 
was rejected. The application must wait for 
at least one confirmation command from 
stack before sending the next request 
command. 

TLR_E_TCP_ERR_MAX_ 
GROUP_EXCEEDED_TCP_ 
UDP_CMD_SET_SOCK_ OPTION 

0xC0080085 Command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ, ulMode = 
TCP_SOCK_ADD_MEMBERSHIP: The 
maximum number of IP multicast groups 
has exceeded (Default configuration = 64). 

TLR_E_TCP_ERR_DISCARD_ KEPT_REQ_CMD 0xC0080086 A kept request command has discarded. 
This confirmation has no further meaning 
for the application, unless the application 
must give back this packet to their 
resource pool! 

TLR_E_TCP_ERR_UNEXP_ ANSWER 0xC0080095 An unexpected/unknown confirmation 
command has received. 
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_TASK_F_ MESSAGESIZE 0xC0080097 The packet length parameter ulLen is 

invalid. The correct packet lenght depends 
on the command parameter ulCmd. 

TLR_E_TCP_TASK_F_ MESSAGECOMMAND 0xC0080098 The command ulCmd is unknown. 
TLR_E_TCP_TASK_F_ 
MESSAGECOMMANDRUNNING 

0xC008009E The command cannot be executed, 
because the previous command is still 
running. 

TLR_E_TCP_TASK_F_NOT_ INITIALIZED 0xC00800C8 The task is not initialized. 
TLR_E_TCP_TASK_F_BUSY 0xC00800C9 The task is busy (intern). 
TLR_E_TCP_TASK_F_ DATABASE 0xC00800D2 The configuration database is not 

available. 
TLR_E_TCP_TASK_F_ DATABASE_READ 0xC00800D4 Error while reading configuration database. 
TLR_E_IP_ERR_IP_ADDR_ 
INVALID_IP_CMD_PING 

0xC0070100 The IP address parameter ulIpAddr in 
command TCPIP_IP_CMD_PING_REQ is 
invalid. This means, the IP address 
ulIpAddr is equal to the TCP/IP stacks own 
IP address. 

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_TCP_UDP_CMD_ OPEN 

0xC0080101 The IP address parameter ulIpAddr in 
command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid. The parameter ulIpAddr must be 
zero (0.0.0.0) or equal to the TCP/IP 
stacks own IP address. 

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_TCP_CMD_ CONNECT 

0xC0080102 The IP address parameter ulIpAddr in 
command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid. The parameter ulIpAddr must be 
unequal to the TCP/IP stacks own IP 
address. 

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_UDP_CMD_SEND 

0xC0080103 The IP address parameter ulIpAddr in 
command 
TCPIP_UDP_CMD_SEND_REQ is invalid 
or doesn't match to the local sub network. 
This error occurs, if the IP address is zero 
(0.0.0.0) or equal to the address of the 
local subnet. 

TLR_E_TCP_ERR_IP_ADDR_I 
NVALID_TCP_UDP_CMD_ SET_SOCK_OPTION 

0xC0080104 The parameter ulMulticastGroup (ulMode 
= TCP_SOCK_ADD_MEMBERSHIP or 
TCP_SOCK_DROP_MEMBERSHIP) in 
command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid. The parameter 
ulMulticastGroup must be a valid Multicast 
address. Valid Multicast addresses are 
224.0.0.1 ... 239.255.255.255 (224.0.0.0 is 
reserved as Base-multicast address). 

TLR_E_TCP_ERR_PORT_ 
INVALID_TCP_UDP_CMD_ OPEN 

0xC0080110 The port parameter ulPort in command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid or not available. The parameter 
ulPort must be in range 0 ... 65535. 

TLR_E_TCP_ERR_PORT_ INVALID_TCP_CMD_ 
CONNECT 

0xC0080111 The port parameter ulPort in command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid or not available. The parameter 
ulPort must be in range 1 ... 65535. 
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_PORT_ 
INVALID_UDP_CMD_SEND 

0xC0080112 The port parameter ulPort in command 
TCPIP_UDP_CMD_SEND_REQ is invalid 
or not available. The parameter ulPort 
must be in range 0 ... 65535. 

TLR_E_IP_ERR_TIMEOUT_ 
INVALID_IP_CMD_PING 

0xC0070120 The timeout parameter ulTimeout in 
command TCPIP_IP_CMD_PING_REQ is 
invalid. 

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ CLOSE 

0xC0080121 The timeout parameter ulTimeout in 
command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ is 
invalid. Consider the distinction between 
TCP and UDP sockets! For UDP sockets, 
ulTimeout must be zero. 

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ CLOSE_ALL 

0xC0080122 The timeout parameter ulTimeout in 
command 
TCPIP_TCP_UDP_CMD_CLOSE_ALL_ 
REQ is invalid. 

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_CMD_WAIT_ CONNECT 

0xC0080123 The timeout parameter ulTimeoutSend 
and/or ulTimeoutListen in command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ is invalid. 

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_CMD_ CONNECT 

0xC0080124 The timeout parameter ulTimeoutSend 
and/or ulTimeoutConnect in command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid. 

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ SET_SOCK_OPTION 

0xC0080125 The timeout parameter ulTimeoutSend 
(ulMode = TCP_SOCK_SEND_TIMEOUT) 
or ulTimeoutInactive (ulMode = TCP_ 
SOCK_INACTIVE_TIMEOUT) or 
ulTimeoutKeepAlive (ulMode = 
TCP_SOCK_KEEPALIVE_TIMEOUT) in 
command TCPIP_TCP_UDP_CMD_ 
SET_SOCK_OPTION_REQ is invalid. 

TLR_E_IP_ERR_MODE_ 
UNKNOWN_IP_CMD_SET_ PARAM 

0xC0070130 The mode parameter ulMode in command 
TCPIP_IP_CMD_SET_PARAM_REQ is 
invalid. 

TLR_E_IP_ERR_MODE_ 
UNKNOWN_IP_CMD_GET_ PARAM 

0xC0070131 The mode parameter ulMode in command 
TCPIP_IP_CMD_GET_PARAM_REQ is 
invalid. 

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_TCP_UDP_CMD_ 
SET_SOCK_OPTION 

0xC0080132 The mode parameter ulMode in command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid. 

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_TCP_UDP_CMD_ 
GET_SOCK_OPTION 

0xC0080133 The mode parameter ulMode in command 
TCPIP_TCP_UDP_CMD_GET_SOCK_ 
OPTION_REQ is invalid. 

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_FATAL_DUMMY 

0xC0080134 Internal fatal error in module 
TcpipTcphdlPckt.c! 

TLR_E_TCP_ERR_MAX_ 
DATA_LEN_EXCEEDED_ TCP_CMD_ SEND 

0xC0080140 The maximum TCP data count n in 
command TCPIP_TCP_CMD_SEND_ 
REQ has exceeded. See parameter ulLen.  
The maximum value for n is 
TCPIP_MAX_TCP_DATA_CNT (1460). 
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_MAX_ 
DATA_LEN_EXCEEDED_ UDP_CMD_ SEND 

0xC0080141 The maximum UDP data count n in 
command TCPIP_UDP_CMD_SEND_ 
REQ has exceeded. See parameter ulLen. 
The maximum value for n is 
TCPIP_MAX_UDP_DATA_CNT (1472). 

TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_WAIT _CONNECT 

0xC0080200 The command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ cannot be executed, because the 
socket is in an inappropriate state. 

TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_CONNECT 

0xC0080201 The command 
TCPIP_TCP_CMD_CONNECT_REQ 
cannot be executed, because the socket is 
in an inappropriate state. 

TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_SEND 

0xC0080202 The command 
TCPIP_TCP_CMD_SEND_REQ cannot be 
executed, because the socket is in an 
inappropriate state. 

TLR_E_TCP_ERR_NO_FREE_ 
QUEUE_ELEMENT_TCP_ CMD_ SEND 

0xC0080210 The TCP send command 
TCPIP_TCP_CMD_SEND_REQ must be 
rejected, because the list of free queue 
elements is empty. Remark: Per default 
configuration, the initial size of this list is 
128. Every send command 
(TCPIP_TCP_CMD_SEND_REQ or 
TCPIP_UDP_CMD_SEND_REQ) occupy 
one queue element, until the confirmation 
command is given back to the application. 
To avoid this resource problem, the 
application must reduce the count of open 
send jobs over all sockets. 

TLR_E_TCP_ERR_NO_FREE_ 
QUEUE_ELEMENT_UDP_ CMD_SEND 

0xC0080211 The UDP send command 
TCPIP_UDP_CMD_SEND_REQ must be 
rejected, because the list of free queue 
elements is empty. Remark: Per default 
configuration, the initial size of this list is 
128. Every send command 
(TCPIP_TCP_CMD_SEND_REQ or 
TCPIP_UDP_CMD_SEND_REQ) occupy 
one queue element, until the confirmation 
command is given back to the application. 
To avoid this resource problem, the 
application must reduce the count of open 
send jobs over all sockets. 

TLR_E_TCP_ERR_NO_ETH_ 
OUT_BUFFER_UDP_CMD_ SEND 

0xC0080212 The UDP send command 
TCPIP_UDP_CMD_SEND_REQ must be 
rejected, because all outgoing Ethernet 
buffers are occupied. 

TLR_E_TCP_ERR_MCAST_ CREATE 0xC0080220 Failed to create an IP Multicast group. 
TLR_E_IP_ERR_DEST_ 
UNREACHABLE_IP_CMD_ PING 

0xC0070300 The target IP address ulIpAddr in 
command TCPIP_IP_CMD_PING_REQ is 
not reachable. 

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_UDP_ CMD_CLOSE 

0xC0080301 Command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ: 
The destination (host, network, or port) is 
unreachable. 
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_UDP_ CMD_CLOSE_ALL 

0xC0080302 Command 
TCPIP_TCP_UDP_CMD_CLOSE_ALL_ 
REQ: The destination (host, network, or 
port) is unreachable. 

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_CMD_ WAIT_CONNECT 

0xC0080303 Command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ: The destination (host, network, or 
port) is unreachable. 

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_CMD_ CONNECT 

0xC0080304 Command 
TCPIP_TCP_CMD_CONNECT_REQ: The 
destination (host, network, or port) is 
unreachable. 

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_UDP_CMD_ SEND 

0xC0080305 Command 
TCPIP_UDP_CMD_SEND_REQ: The 
destination (host, network, or port) is 
unreachable. 

TLR_E_IP_ERR_TIMEOUT_ IP_CMD_PING 0xC0070310 The specified timeout ulTimeout in 
command TCPIP_IP_CMD_PING_REQ 
has expired. The specified host is not 
reachable. 

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_UDP_CMD_CLOSE 

0xC0080311 The TCP Close timeout has expired. A 
connection to the remote host could not be 
closed gracefully within this time. For this 
timeout, see command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ, 
parameter ulTimeout. 

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_UDP_CMD_CLOSE_ALL 

0xC0080312 The TCP Close timeout has expired. One 
or more connections to remote host(s) 
could not be closed gracefully within this 
time. For this timeout, see command 
TCPIP_TCP_UDP_CMD_CLOSE_ ALL_ 
REQ, parameter ulTimeout. 

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_CMD_WAIT_CONNECT 

0xC0080313 The TCP Connect timeout has expired. No 
remote host has connected within this 
time. For this timeout, see command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ, parameter ulTimeoutListen. 

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_CMD_CONNECT 

0xC0080314 The TCP Connect timeout has expired. A 
connection to the specified remote host 
could not be established within this time. 
For this timeout, see command 
TCPIP_TCP_CMD_CONNECT_REQ, 
parameter ulTimeoutConnect. 

TLR_E_TCP_ERR_TIMEOUT_ TCP_CMD_SEND 0xC0080315 The TCP Send timeout has expired by 
sending TCP data with command 
TCPIP_TCP_CMD_SEND_REQ. The 
remote host has not answered within the 
Send Timeout. The TCP Send timeout is 
set in command TCPIP_TCP_CMD_ 
WAIT_CONNECT_REQ or 
TCPIP_TCP_CMD_CONNECT_REQ, 
parameter ulTimeoutSend (Default = 31 s). 

Table 63: TCP Error Codes 
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11.4.5 Status & Error Codes TCP_IP-Task 
 

 

Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_S_OK  0x00000000 Status ok 
TLR_E_IP_ERR_INIT_NO_ ETHERNET_ADDR 0xC0070034 There is no Ethernet address (MAC 

address) available.  
TLR_E_IP_ERR_INIT_INVALID_ FLAG  0xC0070036 The start parameters contain one or more 

unknown flags.  
TLR_E_IP_ERR_INIT_INVALID_ IP_ADDR  0xC0070037 The start parameters contain an invalid IP 

address.  
TLR_E_IP_ERR_INIT_INVALID_ NETMASK  0xC0070038 The start parameters contain an invalid 

subnet mask.  

TLR_E_IP_ERR_INIT_ UNKNOWN_HARDWARE  0xC007003B The device type is unknown.  
TLR_E_IP_ERR_INIT_NO_IP_ ADDR  0xC007003C Failed to obtain an IP address from the 

specified source(s).  
TLR_E_IP_ERR_INIT_DRIVER_ FAILED  0xC007003D The initialization of the driver layer (EDD) 

is failed.  
TLR_E_IP_ERR_INIT_NO_IP_ ADDR_CFG  0xC007003E There is no source for an IP address 

(BOOTP, DHCP, IP address parameter) 
specified.  

TLR_E_IP_ERR_ETH_ADDR_ 
INVALID_IP_CMD_SET_PARAM  

0xC007007C The Ethernet address (MAC address) 
abEthernetAddr in command 
TCPIP_IP_CMD_SET_PARAM_REQ is 
invalid. Invalid means, abEthernetAddr is 
equal to the broadcast address FF-FF-FF- 
FF-FF-FF.  

TLR_E_IP_ERR_ARP_CACHE_FULL_IP_CMD_S
ET_PARAM  

0xC0070083 The command 
TCPIP_IP_CMD_SET_PARAM_REQ 
could not be executed, because the ARP 
cache is full. The ARP cache has per 
default configuration 64 entries.  

TLR_E_IP_ERR_ARP_ENTRY_ 
NOT_FOUND_IP_CMD_SET_ PARAM  

0xC0070086 The specified ARP entry in command 
TCPIP_IP_CMD_SET_PARAM_REQ 
could not be deleted. The ARP entry was 
not found in ARP cache.  

TLR_E_IP_ERR_ARP_ENTRY_ 
NOT_FOUND_IP_CMD_GET_ PARAM  

0xC0070087 The requested ARP information in 
command 
TCPIP_IP_CMD_GET_PARAM_REQ 
could not be delivered. The ARP entry was 
not found in ARP cache.  

TLR_E_IP_ERR_DELAYED  0xC00700FE Special internalIpStart function.  
TLR_E_IP_ERR_GENERIC  0xC00700FF Special internalIpStart function.  
TLR_E_TCPIP_TCP_TASK_ COMMAND_INVALID 0xC0080001 Invalid command received.  
TLR_E_TCPIP_TCP_TASK_ 
PROCESS_CANCELED  

0xC0080002 Cancel process is in progress, command 
can not be executed.  

TLR_E_TCP_ERR_INIT_IP_ TASK_NOT_READY  0xC0080032 The IP layer is not ready.  
TLR_E_TCP_ERR_INIT_IP_ TASK_FAILED  0xC0080034 The initialization of IP layer has failed.  
TLR_E_TCP_ERR_INIT_ CREATE_INFO_FIELD  0xC0080040 The creation of an information field (task 

state) has failed.  
TLR_W_TCP_ERR_INIT_TPIF_ INIT_REQ_PCKT 0x80080043 Warning: A pending application packet has 

discarded (because of a new application 
packet).  

TLR_E_TCP_ERR_INIT_OS_ CYCLETIME  0xC0080044 The configured operating system cycle 
time is out of range (0.1 ms ... 20 ms).  
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_INIT_OS_ 
AND_TCPUDP_CYCLETIME  

0xC0080045 The combination of configured operating 
system cycle time and TCP/IP stacks cycle 
time (startup-parameter ulTcpCycleEvent) 
is not possible. The operating system cycle 
time must be smaller or equal than the 
TCP/IP stacks cycle time.  

TLR_E_TCP_ERR_SOCKET_ INVALID  0xC0080070 The socket handle ulDestId is invalid. A 
further reason for this error: The command 
(Mode) is not applicable on this socket 
type (TCP/UDP).  

TLR_E_TCP_ERR_OPTION_ 
NOT_SUPPORTED_TCP_ CMD_SEND  

0xC0080074 The option parameter ulOptions in 
command TCPIP_TCP_CMD_SEND_REQ 
is invalid.  

TLR_E_TCP_ERR_ PARAMETER_INVALID_ 
TCP_UDP_CMD_SET_ SOCK_OPTION  

0xC0080075 The parameter ulTtl (ulMode = 
TCP_SOCK_TTL) or ulMulticastTtl 
(ulMode = TCP_SOCK_MULTICAST_TTL) 
or ulMulticastLoop (ulMode = 
TCP_SOCK_MULTICAST_LOOP) in 
command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid.  

TLR_E_TCP_ERR_CONN_ CLOSED  0xC0080078 The connection has closed (Graceful 
close).  

TLR_E_TCP_ERR_CONN_ RESET  0xC0080079 The Connection has closed by reset (Hard 
close).  

TLR_E_TCP_ERR_PROTOCOL 
_UNKNOWN_TCP_UDP_CMD_ OPEN  

0xC008007A The protocol parameter ulProtocol in 
command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid.  

TLR_E_TCP_ERR_NO_ SOCKETS_TCP_UDP_ 
CMD_OPEN  

0xC008007B Command 
TCPIP_TCP_UDP_CMD_OPEN_REQ: 
There are no socket handles available. 

TLR_E_TCP_ERR_MAX_ 
PCKT_CNT_EXCEEDED_ UDP_CMD_SEND  

0xC0080084 Command 
TCPIP_UDP_CMD_SEND_REQ: The 
maximum number of queued packets ( = 
TCPHDL_RCX_PCKT_QUEUED_MAX (6) 
) has exceeded. The request command 
was rejected. The application must wait for 
at least one confirmation command from 
stack before sending the next request 
command.  

TLR_E_TCP_ERR_MAX_ 
GROUP_EXCEEDED_TCP_ 
UDP_CMD_SET_SOCK_ OPTION  

0xC0080085 Command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ, ulMode = 
TCP_SOCK_ADD_MEMBERSHIP: The 
maximum number of IP multicast groups 
has exceeded (Default configuration = 64).  

TLR_E_TCP_ERR_DISCARD_ KEPT_REQ_CMD  0xC0080086 A kept request command has discarded. 
This confirmation has no further meaning 
for the application, unless the application 
must give back this packet to their 
resource pool!  

TLR_E_TCP_ERR_UNEXP_ ANSWER  0xC0080095 An unexpected/unknown confirmation 
command has received.  

TLR_E_TCP_TASK_F_ MESSAGESIZE  0xC0080097 The packet length parameter ulLen is 
invalid. The correct packet length depends 
on the command parameter ulCmd.  
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_TASK_F_ MESSAGECOMMAND 0xC0080098 The command ulCmd is unknown.  
TLR_E_TCP_TASK_F_ 
MESSAGECOMMANDRUNNING  

0xC008009E The command cannot be executed, 
because the previous command is still 
running.  

TLR_E_TCP_TASK_F_NOT_ INITIALIZED  0xC00800C8 The task is not initialized.  
TLR_E_TCP_TASK_F_BUSY 0xC00800C9 The task is busy (intern).  
TLR_E_TCP_TASK_F_ DATABASE  0xC00800D2 The configuration database is not 

available.  
TLR_E_TCP_TASK_F_ DATABASE_READ  0xC00800D4 Error while reading configuration database.  
TLR_E_IP_ERR_IP_ADDR_ 
INVALID_IP_CMD_PING 

0xC0070100 The IP address parameter ulIpAddr in 
command TCPIP_IP_CMD_PING_REQ is 
invalid. This means, the IP address 
ulIpAddr is equal to the TCP/IP stacks own 
IP address.  

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_TCP_UDP_CMD_ OPEN  

0xC0080101 The IP address parameter ulIpAddr in 
command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid. The parameter ulIpAddr must be 
zero (0.0.0.0) or equal to the TCP/IP 
stacks own IP address.  

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_TCP_CMD_ CONNECT  

0xC0080102 The IP address parameter ulIpAddr in 
command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid. The parameter ulIpAddr must be 
unequal to the TCP/IP stacks own IP 
address.  

TLR_E_TCP_ERR_IP_ADDR_ 
INVALID_UDP_CMD_SEND  

0xC0080103 The IP address parameter ulIpAddr in 
command 
TCPIP_UDP_CMD_SEND_REQ is invalid 
or doesn't match to the local sub network. 
This error occurs, if the IP address is zero 
(0.0.0.0) or equal to the address of the 
local subnet.  

TLR_E_TCP_ERR_IP_ADDR_I 
NVALID_TCP_UDP_CMD_ SET_SOCK_OPTION 

0xC0080104 The parameter ulMulticastGroup (ulMode 
= TCP_SOCK_ADD_MEMBERSHIP or 
TCP_SOCK_DROP_MEMBERSHIP) in 
command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid. The parameter 
ulMulticastGroup must be a valid Multicast 
address. Valid Multicast addresses are 
224.0.0.1 ... 239.255.255.255 (224.0.0.0 is 
reserved as Base-multicast address).  

TLR_E_TCP_ERR_PORT_ 
INVALID_TCP_UDP_CMD_ OPEN  

0xC0080110 The port parameter ulPort in command 
TCPIP_TCP_UDP_CMD_OPEN_REQ is 
invalid or not available. The parameter 
ulPort must be in range 0 ... 65535.  

TLR_E_TCP_ERR_PORT_ INVALID_TCP_CMD_ 
CONNECT  

0xC0080111 The port parameter ulPort in command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid or not available. The parameter 
ulPort must be in range 1 ... 65535.  

TLR_E_TCP_ERR_PORT_ 
INVALID_UDP_CMD_SEND 

0xC0080112 The port parameter ulPort in command 
TCPIP_UDP_CMD_SEND_REQ is invalid 
or not available. The parameter ulPort 
must be in range 0 ... 65535.  
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_IP_ERR_TIMEOUT_ 
INVALID_IP_CMD_PING  

0xC0070120 The timeout parameter ulTimeout in 
command TCPIP_IP_CMD_PING_REQ is 
invalid.  

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ CLOSE  

0xC0080121 The timeout parameter ulTimeout in 
command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ is 
invalid. Consider the distinction between 
TCP and UDP sockets! For UDP sockets, 
ulTimeout must be zero.  

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ CLOSE_ALL  

0xC0080122 The timeout parameter ulTimeout in 
command 
TCPIP_TCP_UDP_CMD_CLOSE_ALL_ 
REQ is invalid.  

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_CMD_WAIT_ CONNECT  

0xC0080123 The timeout parameter ulTimeoutSend 
and/or ulTimeoutListen in command 
TCPIP_TCP_CMD_WAIT_CONNECT_RE
Q is invalid.  

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_CMD_ CONNECT  

0xC0080124 The timeout parameter ulTimeoutSend 
and/or ulTimeoutConnect in command 
TCPIP_TCP_CMD_CONNECT_REQ is 
invalid.  

TLR_E_TCP_ERR_TIMEOUT_ 
INVALID_TCP_UDP_CMD_ SET_SOCK_OPTION  

0xC0080125 The timeout parameter ulTimeoutSend 
(ulMode = TCP_SOCK_SEND_TIMEOUT) 
or ulTimeoutInactive (ulMode = TCP_ 
SOCK_INACTIVE_TIMEOUT) or 
ulTimeoutKeepAlive (ulMode = 
TCP_SOCK_KEEPALIVE_TIMEOUT) in 
command TCPIP_TCP_UDP_CMD_ 
SET_SOCK_OPTION_REQ is invalid.  

TLR_E_IP_ERR_MODE_ 
UNKNOWN_IP_CMD_SET_ PARAM  

0xC0070130 The mode parameter ulMode in command 
TCPIP_IP_CMD_SET_PARAM_REQ is 
invalid.  

TLR_E_IP_ERR_MODE_ 
UNKNOWN_IP_CMD_GET_ PARAM  

0xC0070131 The mode parameter ulMode in command 
TCPIP_IP_CMD_GET_PARAM_REQ is 
invalid.  

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_TCP_UDP_CMD_ 
SET_SOCK_OPTION 

0xC0080132 The mode parameter ulMode in command 
TCPIP_TCP_UDP_CMD_SET_SOCK_ 
OPTION_REQ is invalid.  

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_TCP_UDP_CMD_ 
GET_SOCK_OPTION 

0xC0080133 The mode parameter ulMode in command 
TCPIP_TCP_UDP_CMD_GET_SOCK_ 
OPTION_REQ is invalid.  

TLR_E_TCP_ERR_MODE_ 
UNKNOWN_FATAL_DUMMY  

0xC0080134 Internal fatal error in module 
TcpipTcphdlPckt.c!  

TLR_E_TCP_ERR_MAX_ 
DATA_LEN_EXCEEDED_ TCP_CMD_ SEND  

0xC0080140 The maximum TCP data count n in 
command TCPIP_TCP_CMD_SEND_ 
REQ has exceeded. See parameter ulLen. 
The maximum value for n is 
TCPIP_MAX_TCP_DATA_CNT (1460).  

TLR_E_TCP_ERR_MAX_ 
DATA_LEN_EXCEEDED_ UDP_CMD_ SEND  

0xC0080141 The maximum UDP data count n in 
command TCPIP_UDP_CMD_SEND_ 
REQ has exceeded. See parameter ulLen. 
The maximum value for n is 
TCPIP_MAX_UDP_DATA_CNT (1472).  

TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_WAIT _CONNECT  

0xC0080200 The command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ cannot be executed, because the 
socket is in an inappropriate state.  
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_CONNECT  

0xC0080201 The command 
TCPIP_TCP_CMD_CONNECT_REQ 
cannot be executed, because the socket is 
in an inappropriate state.  

TLR_E_TCP_ERR_SOCKET_ 
STATE_TCP_CMD_SEND 

0xC0080202 The command 
TCPIP_TCP_CMD_SEND_REQ cannot be 
executed, because the socket is in an 
inappropriate state.  

TLR_E_TCP_ERR_NO_FREE_ 
QUEUE_ELEMENT_TCP_ CMD_ SEND  

0xC0080210 The TCP send command 
TCPIP_TCP_CMD_SEND_REQ must be 
rejected, because the list of free queue 
elements is empty. Remark: Per default 
configuration, the initial size of this list is 
128. Every send command 
(TCPIP_TCP_CMD_SEND_REQ or 
TCPIP_UDP_CMD_SEND_REQ) occupy 
one queue element, until the confirmation 
command is given back to the application. 
To avoid this resource problem, the 
application must reduce the count of open 
send jobs over all sockets.  

TLR_E_TCP_ERR_NO_FREE_ 
QUEUE_ELEMENT_UDP_ CMD_SEND 
 

0xC0080211 The UDP send command 
TCPIP_UDP_CMD_SEND_REQ must be 
rejected, because the list of free queue 
elements is empty. Remark: Per default 
configuration, the initial size of this list is 
128. Every send command 
(TCPIP_TCP_CMD_SEND_REQ or 
TCPIP_UDP_CMD_SEND_REQ) occupy 
one queue element, until the confirmation 
command is given back to the application. 
To avoid this resource problem, the 
application must reduce the count of open 
send jobs over all sockets.  

TLR_E_TCP_ERR_NO_ETH_ 
OUT_BUFFER_UDP_CMD_ SEND  

0xC0080212 The UDP send command 
TCPIP_UDP_CMD_SEND_REQ must be 
rejected, because all outgoing Ethernet 
buffers are occupied.  

TLR_E_TCP_ERR_MCAST_ CREATE  0xC0080220 Failed to create an IP Multicast group.  
TLR_E_IP_ERR_DEST_ 
UNREACHABLE_IP_CMD_ PING  

0xC0070300 The target IP address ulIpAddr in 
command TCPIP_IP_CMD_PING_REQ is 
not reachable.  

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_UDP_ CMD_CLOSE  

0xC0080301 Command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ: 
The destination (host, network, or port) is 
unreachable.  

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_UDP_ CMD_CLOSE_ALL  

0xC0080302 Command 
TCPIP_TCP_UDP_CMD_CLOSE_ALL_ 
REQ: The destination (host, network, or 
port) is unreachable.  

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_CMD_ WAIT_CONNECT  

0xC0080303 Command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ: The destination (host, network, or 
port) is unreachable.  

TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_TCP_CMD_ CONNECT  

0xC0080304 Command 
TCPIP_TCP_CMD_CONNECT_REQ: The 
destination (host, network, or port) is 
unreachable.  
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Status & Error Codes TCP_IP-Task 
Error Code (Definition) Value Description 
TLR_E_TCP_ERR_DEST_ 
UNREACHABLE_UDP_CMD_ SEND  

0xC0080305 Command 
TCPIP_UDP_CMD_SEND_REQ: The 
destination (host, network, or port) is 
unreachable.  

TLR_E_IP_ERR_TIMEOUT_ IP_CMD_PING  0xC0070310 The specified timeout ulTimeout in 
command TCPIP_IP_CMD_PING_REQ 
has expired. The specified host is not 
reachable.  

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_UDP_CMD_CLOSE  

0xC0080311 The TCP Close timeout has expired. A 
connection to the remote host could not be 
closed gracefully within this time. For this 
timeout, see command 
TCPIP_TCP_UDP_CMD_CLOSE_REQ, 
parameter ulTimeout.  

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_UDP_CMD_CLOSE_ALL  

0xC0080312 The TCP Close timeout has expired. One 
or more connections to remote host(s) 
could not be closed gracefully within this 
time. For this timeout, see command 
TCPIP_TCP_UDP_CMD_CLOSE_ 
ALL_REQ, parameter ulTimeout.  

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_CMD_WAIT_CONNECT 

0xC0080313 The TCP Connect timeout has expired. No 
remote host has connected within this 
time. For this timeout, see command 
TCPIP_TCP_CMD_WAIT_CONNECT_ 
REQ, parameter ulTimeoutListen.  

TLR_E_TCP_ERR_TIMEOUT_ 
TCP_CMD_CONNECT  

0xC0080314 The TCP Connect timeout has expired. A 
connection to the specified remote host 
could not be established within this time. 
For this timeout, see command 
TCPIP_TCP_CMD_CONNECT_REQ, 
parameter ulTimeoutConnect.  

TLR_E_TCP_ERR_TIMEOUT_ TCP_CMD_SEND  0xC0080315 The TCP Send timeout has expired by 
sending TCP data with command 
TCPIP_TCP_CMD_SEND_REQ. The 
remote host has not answered within the 
Send Timeout. The TCP Send timeout is 
set in command TCPIP_TCP_CMD_ 
WAIT_CONNECT_REQ or 
TCPIP_TCP_CMD_CONNECT_REQ, 
parameter ulTimeoutSend (Default = 31 s).  

Table 64: Status & Error Codes TCP_IP-Task 
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11.5 General Error CIP Codes 
The following table contains the possible General Error Codes defined 
within the CIP standard. 
 

 

General CIP Error Codes 
General Error 
Codes (hexa 
dezcimal) 

Status Name Description 

00 Success  The service has successfully been performed by the specified object. 
01 Connection failure   A connection-elated service failed. This happened at any location along 

the connection path. 
02 Resource unavailable   Some resources which where required for the object to perform the 

requested service were not available.  
03 Invalid parameter value   See status code 0x20, which is usually applied in this situation. 
04 Path segment error   A path segment error has been encountered. Evaluation of the supplied 

path information failed. 
05 Path destination 

unknown   
The path references an unknown object class, instance or structure 
element  causing the abort of path processing. 

06 Partial transfer   Only a part of the expected data could be transferred. 
07 Connection lost   The connection for messaging has been lost. 
08 Service not supported   The requested service has not been implemented or has not been 

defined for this object class or instance. 
09 Invalid attribute value   Detection of invalid attribute data 
0A Attribute list error   An attribute in the Get_Attribute_List or Set_Attribute_List response 

has a status not equal to 0. 
0B Already in requested 

mode/state 
The object is already in the mode or state which has been requested by 
the service 

0C Object state conflict   The object is not able to perform the requested service in the current 
mode or state 

0D Object already exists   It has been tried to create an instance of an object which already 
exists. 

0E Attribute not settable   It has been tried to change an non-modifiable attribute. 
0F Privilege violation   A check of permissions or privileges failed. 
10 Device state conflict The current mode or state of the device prevents the execution of the 

requested service. 
11 Reply data too large The data to be transmitted in the response buffer requires more space 

than the size of the allocated response buffer 
12 Fragmentation of a 

primitive value 
The service specified an operation that is going to fragment a primitive 
data value, i.e. half a REAL data type. 

13 Not enough data The service did not supply all required data to perform the specified 
operation. 

14 Attribute not supported An unsupported attribute has been specified in the request 
15 Too much data More data than was expected were supplied by the service. 
16 Object does not exist The specified object does not exist in the device. 
17 Service fragmentation 

sequence not in 
progress 

Fragmentation sequence for this service is not currently active for this 
data. 

18 No stored attribute 
data 

The attribute data of this object has not been saved prior to the 
requested service. 

19 Store operation failure The attribute data of this object could not  be saved due to a failure 
during the storage attempt. 
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General CIP Error Codes 
General Error 
Codes (hexa 
dezcimal) 

Status Name Description 

1A Routing failure, request 
packet too large 

The service request packet was too large for transmission on a network 
in the path to the destination. The routing device was forced to abort 
the service. 

1B Routing failure, 
response packet too 
large 

The service response packet was too large for transmission on a 
network in the path from the destination. The routing device was forced 
to abort the service. 

1C Missing attribute list 
entry data  

The service did not supply an attribute in a list of attributes that was 
needed by the service to perform the requested behavior. 

1D Invalid attribute value 
list  

The service returns the list of attributes containing status information 
for invalid attributes. 

1E Embedded service 
error  

An embedded service caused an error. 
 

1F Vendor specific error A vendor specific error has occurred. This error should only occur when 
none of the other general error codes can correctly be applied. 

20 Invalid parameter A parameter which was associated with the request was invalid. The 
parameter does not meet the requirements of the CIP specification 
and/or the requirements defined in the specification of an application 
object. 

21 Write-once value or 
medium already written 

An attempt was made to write to a write-once medium for the second 
time, or to modify a value that cannot be changed after being 
established once. 

22 Invalid reply received An invalid reply is received. Possible causes can for instance be 
among others a reply service code not matching the request service 
code or a reply message shorter than the expectable minimum size. 

23-24 Reserved Reserved for future extension of CIP standard 
25 Key failure in path The key segment (i.e. the first segment in the path) does not match the 

destination module. More information about which part of the key check 
failed can be derived from the object specific status. 

26 Path size Invalid Path cannot be routed to an object due to lacking information or 
too much routing data have been included. 

27 Unexpected attribute in 
list 

It has been attempted to set an attribute which may not be set in the 
current situation. 

28 Invalid member ID The Member ID specified in the request is not available within the 
specified class/ instance or attribute 

29 Member cannot be set A request to modify a member  which cannot be modified has occurred 
2A Group 2 only server 

general failure 
This DeviceNet-specific error cannot occur in EtherNet/IP 

2B-CF Reserved Reserved for future extension of CIP standard 
D0-FF Reserved for object 

class and service 
errors 

An object class specific error has occurred. 

Table 65: General CIP Error Codes 
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11.5.1 CIP Connection-Manager-Object-Instance Codes zum 
Erweiterten Status  

Additionally to the General CIP Error Codes the CIP Connection Manager 
Object Instance Extended Status Codes are valid.  
 

 

CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x00  Service completed successfully 
0x01 0x0000 

through 
0x00FF 

Obsolete 

0x01 0x0100  CONNECTION IN USE OR DULTPLICATE FORWARD OPEN 
This extended status code shall be returned when an originator is trying to make 
connection to a target with which the originator may have already established a 
connection (Non-Null/matching Forward_Open — see section 3-5.5.2.1.2). 
[Ref.] THE CIP NETWORKS LIBRARY, Volume 1 

0x01 0x0101 
through 
0x0102 

Reserved by CIP 

0x01 0x0103 TRANSPORT CLASS AND TRIGGER COMBINATION NOT SUPPORTED 
A transport class and trigger combination has been specified which is not 
supported by the target. Routers shall not fail the connection based on the 
transport class and trigger combination. Only targets shall return this extended 
status code. 

0x01 0x0104 
through 
0x0105 

Reserved by CIP 

0x01 0x0106 OWNERSHIP CONFLICT 
The connection cannot be established since another connection has exclusively 
allocated some of the resources required for this connection. An example of this 
would be that only one exclusive owner connection can control an output point on 
an I/O Module. If a second exclusive owner connection (or redundant owner 
connection) is attempted, this error shall be returned. This extended status code 
shall only be returned by a target node. 

0x01 0x0107 TARGET CONNECTION NOT FOUND 
This extended status code shall be returned in response to the forward_close 
request, when the connection that is to be closed is not found at the target node. 
This extended status code shall only be returned by a target node. Routers shall 
not generate this extended status code. If the specified connection is not found at 
the intermediate node, the close request shall still be forwarded using the path 
specified in the Forward_Close request. 

0x01 0x0108 INVALID NETWORK CONNECTION PARAMETER 
This extended status code shall be returned as the result of specifying a 
connection type, connection priority, redundant owner or fixed / variable that is not 
supported by the target application. Only a target node shall return this extended 
status code. 

0x01 0x0109 INVALID CONNECTION SIZE 
This extended status code is returned when the target or router does not support 
the specified connection size. This could occur at a target because the size does 
not match the required size for a fixed size connection. It could occur at a router if 
the requested size is too large for the specified network. 
An additional status may follow indicating the maximum connection size supported 
by the responding node. The additional status word is required when issued in 
response to the Large_Forward_Open. 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x01 0x010A 
through 
0x010F 

Reserved by CIP 

0x01 0x0110 TARGET FOR CONNECTION NOT CONFIGURED 
This extended status code shall be returned when a connection is requested to a 
target application that has not been configured and the connection request does 
not contain a data segment for configuration. Only a target node shall return this 
extended status code. Reference section C-1.4.5 — DATA SEGMENT 
[Ref.] THE CIP NETWORKS LIBRARY, Volume 1 

0x01 0x0111 RPI NOT SUPPORTED. 
This extended status code shall be returned if the device can not support the 
requested O->T or T->O RPI. This extended status code shall also be used if the 
connection time-out multiplier produces a time-out value that is not supported by 
the device or the production inhibit time is not valid. 
Note: it is highly recommended to use Extended Status 0x112 when the RPI 
values(s) are not acceptable. 

0x01 0x0112 RPI VALUE(S) NOT ACCEPTABLE 
This error is to be returned when the RPI value(s) in the forward open request are 
outside the range required by the application in the target device or the target is 
producing at different interval, The target shall include information with acceptable 
RPI(s). for this error, the extended status size is 6 16-bit words and is formatted 
as follows: 

  Data Type Value Explanation of field 
  UINT 0x0112 Extended status code 
  USINT variable Acceptable Originator to Target RPI (see below) type, 

values: 
0 — the RPI specified in the forward open was 
acceptable (the Originator to Target RPI value is 
ignored).1 
1 — unspecified (used to suggest an alternate RPI, 
e. g. default) 
2— minimum acceptable RPI (used when RPI was 
too fast for range) 
3 — maximum acceptable RPI (used when RPI was 
too slow for range) 
4— required RPI to correct mismatch (used when 
data already being consumed at a different interval) 
5-255 — reserved 

  UDSINT variable Acceptable Target to Originator RPI (see below) type, 
values: 
0— the RPI specified in the forward open was 
acceptable (the Target to Originator RPl value is 
ignored).1 
1 — unspecified (used to suggest an alternate RPI, 
e.g. default) 
2— minimum acceptable RPI (used when RPI was 
too fast for range) 
3 — maximum acceptable RPI (used when RPI was 
too slow for range) 
4— required RPI to current mismatch (used when 
data already being produced at a different interval, 
typically multicast) 
5-255— reserved 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

  UDINT variable Value of Originator to Target RPI that is within the 
acceptable range for the application. This field is 
defined the same as the RPI parameter in the forward 
open request. 

  UDINT variable Value of Target to Originator RPI that is within the 
acceptable range for the application. This field is 
defined the same as the RPI parameter in the forward 
open request. 

  1  The value of the Originator to Target and Target to Originator type shall not 
both be 0. 

0x01 0x0113 OUT OF CONNECTIONS 
Connection Manager cannot support any more connections. The maximum 
number of connections supported by the Connection Manager has already been 
created. 

0x01 0x0114 VENDOR OR PRODUCT CODE MISMATCH 
The Product Code or Vendor Id specified in the electronic key logical segment 
does not match the Product Code or Vendor Id of the target device. 

0x01 0x0115 PRODUCT TYPE MISMATCH 
The Product Type specified in the electronic key logical segment does not match 
the Product Typ of the target device. 

0x01 0x0116 REVISION MISMATCH 
The major and minor revision specified in the electronic key logical segment does 
not correspond to a -valid revision of the target device, 

0x01 0x0117 INVALID PRODUCED OR CONSUMED APPLICATION PATH 
The produced or consumed application path specified in the connection path does 
not correspond to a valid produced or consumed application path within the target 
application. This error could also be returned if a produced or consumed 
application path was required, but not provided by a connection request. 

0x01 0x0118 INVALID OR INCONSISTENT CONFIGURATION APPLICATION PATH 
An application path specified for the configuration data does not correspond to a 
configuration application or is inconsistent with the consumed or produced 
application paths. For example the connection path specifies float configuration 
data while the produced or consumed paths specify integer data. 

0x01 0x0119 NON-LISTEN ONLY CONNECTION NOT OPENED 
Connection request fails since there are no non-listen only connection types 
currently open. Refer to Section 3.6 for a description of application connection 
types. 
The extended status code shall be returned when an attempt is made to establish 
a listen only connection type to a target, which has no non-listen only connection 
already established. 
[Ref.] THE CIP NETWORKS LIBRARY, Volume 1 

0x01 0x011A TARGET OBJECT OUT OF CONNECTIONS 
The maximum number of connections supported by this instance of the target 
object has been exceeded. 
For example, the Connection Manager could support 20 connections while the 
target object can only support 10 connections, On the 11th Connection Request to 
the target object, this extended status code would be used to signify that the 
maximum number of connections already exist to the target object. 

0x01 0x011B RPI IS SMALLER THAN THE PRODUCTION INHIBIT TIME 
The Target to Originator RPI is smaller than the Target to Originator Production 
Inhibit Time. 

0x01 0x011B 
through 
0x0202 

Reserved by CIP 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x01 0x0203 CONNECTION TIMED OUT 
This extended status code shall occur when a client tries to send a connected 
message over a connection that has been timed-out, This extended status code 
shall only occur locally at the producing node. 

0x01 0x0204 UNCONNECTED REQUEST TIMED OUT 
The Unconnected Request Timed Out error shall occur when the UCMM times out 
before a reply is received. This may occur for an Unconnceted_Send, 
Forward_Open, or Forward_Close service. This typically means that the UCMM 
has tried a link specific number of times using a link specific retry timer and has 
not received an acknowledgement or reply. This may be the result of congestion 
at the destination node or may be the result of a node not being powered up or 
present. This extended status code shall be returned by the originating node or 
any intermediate node. 

0x01 0x0205 PARAMETER ERROR IN UNCONNECTED REQUEST SERVICE 
For example, this shall be caused by a Connection Tick Time (see section 3-
5.5.1.3) and Connection time-out combination in an Unconnected_Send, 
Forward_Open, or Forward_Close service that is not supported by an 
intermediate node. 

0x01 0x0206 MESSAGE TOO LARGE FOR UNCONNECTED_SEND SERVICE 
This shall be caused when the Unconnected_Send is too large to be sent out on a 
network. 

0x01 0x0207 UNCONNECTED ACKNOWLEDGE WITHOUT REPLY 
The message was sent via the unconnected message service and an 
acknowledge was received but a data response message was not received. 

0x01 0x0208 
through 
0x0300 

Reserved by CIP 

0x01 0x0301 NO BUFFER MEMORY AVAILABLE 
The extended status code shall occur when insufficient connection buffer memory 
is available in the target or any router devices. Routers and target nodes shall 
return this error. 

0x01 0x0302 NETWORK BANDWIDTH NOT AVAILABLE FOR DATA 
This extended status code shall be returned by any device in the path that is a 
producer and can not allocate sufficient bandwidth for the connection on its link, 
This can occur at any node. This can only occur for connections that are specified 
a scheduled priority 

0x01 0x0303 NO CONSUMED CONNECTION ID FILTER AVAILABLE 
Any device in the path that contains a link consumer for the connection and does 
not have an available consumed_connection_id filter available shall return this 
extended status code. 

0x01 0x0304 NOT CONFIGURED TO SEND SCHEDULED PRIORITY DATA 
If requested to make a connection that specifies scheduled priority, any device 
that is unable to send packets during the scheduled portion of the network update 
time interval shall return this extended status code. For example, on ControlNet 
this code shall be returned by a node whose MAC is greater than maximum 
scheduled node (SMAX). 

0x01 0x0305 SCHEDULE SIGNATURE MISMATCH 
This extended status code shall be returned when the connection scheduling 
information in the originator device is not consistent with the connection 
scheduling information on the target network. 

0x01 0x0306 SCHEDULE SIGNATURE VALIDATION NOT POSSIBLE 
This extended status code shall be returned when the connection scheduling 
information in the originator device can not be validated on the target network. For 
example, on ControlNet this code shall be returned when there is no keeper in the 
master state. 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x01 0x0307 
through 
0x0310 

Reserved by CIP 

0x01 0x0311 PORT NOT AVAILABLE 
A Port specified in a Port Segment is Not Available or does not exist. 

0x01 0x0312 LINK ADDRESS NOT VALID 
Link Address specified in Port Segment Not Valid 
This extended status code is the result of a port segment that specifies a link 
address that is not valid for the target network type. This extended status code 
shall not he used for link addresses that are valid for the target network type but 
do not respond. 

0x01 0x0313 
through 
0x0314 

Reserved by CIP 

0x01 0x0315 INVALID SEGMENT IN CONNECTION PATH 
Invalid Segment Type or Segment Value in Connection Path 
This extended status code is the result of a device being unable to decode the 
connection path. This could be caused by an unrecognized path type, a segment 
type occurring unexpectedly, or a myriad of other problems in the connection path. 

0x01 0x0316 FORWARD CLOSE SERVICE CONNECTION PATH MISMATCH 
The connection path in the Forward_Close Service does not match the connection 
path in the connection being closed. 

0x01 0x0317 SCHEDULING NOT SPECIFIED 
Either the Schedule Network Segment was not present or the Encoded Value in 
the Schedule Network Segment is invalid (0). 

0x01 0x0318 LNK ADDRESS TO SELF INVALILD 
Under some conditions (depends on the device), a link address in the Port 
Segment which points to the same device (loopback to yourself) is invalid. 

0x01 0x0319 SECONDARY RESOURCES UNAVAILABLE 
In a dual chassis redundant system, a connection request that is made to the 
primary system shall be duplicated on the secondary system. If the secondary 
system is unable to duplicate the connection request, then this extended status 
code shall be returned. 

0x01 0x031A RACK CONNECTION ALREADY ESTABLISHED 
A request for a module connection has been refused because part of the 
corresponding data is already included in a rack connection. 

0x01 0x031B MODULE CONNECTION ALREADY ESTABLISHED 
A request for a rack connection has been refused because part of the 
corresponding data is already included in a module connection. 

0x01 0x031C MISCELLANEOUS 
This extended status is returned when no other extended status code applies for a 
connection related error. 

0x01 0x031D REDTUNDANT CONNECTION MISMATCH 
This extended status code shall be returned when the following fields do not 
match when attempting to establish a redundant owner connection to the same 
target path: 
- O->T_RPI 
- O->T_connection_parameters 
- T->O_RPI 
- T->O_connection_parameters 
- xport_type_and_trigger. 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x01 0x031E NO MORE USER CONFIGURABLE LINK CONSUMER RESOURCES 
AVAILABLE IN THE PRODUCING MODULE 
A target shall return this extended status when the configured number of 
consumers for a producing application is already in use. 

0x01 0x031F NO MORE USER CONFIGURABLE LINK CONSUMER RESOURCES 
AVAILABLE IN THE PRODUCING MODULE  
A target shall return this extended status when there are no consumers configured 
for a producing application to use. 

0x01 0x0320 
0x07FF 

Vendor specific 

0x01 0x0800 Network link in path to module is offline 
0x01 0x0801 

through 
0x080F 

Reserved by CIP 

0x01 0x0810 NO TARGET APPLICATION DATA AVAILABLE 
This extended status code is returned when the target application does not have 
valid data to produce for the requested connection, Only the target side of a 
connection shall return this extended status code. 

0x01 0x0811 NO ORIGNATOR APPLICATION DATA AVAILABLE 
This extended status code is returned when the originator application does not 
have valid data to produce for the requested connection. Only the originator side 
of connection shall indicate this extended status code. 

0x01 0x0812 NODE ADDRESS HAS CHANGED SINCE THE NETWORK WAS SCHEDULED 
A router on a scheduled network (e.g.: ControlNet) has a different node address 
than the value configured in the connection originator. 

0x01 0x0813 NOT CONFIGURED FOR OFF-SUBNET MULTICAST 
A multicast connection has been requested between a producer and a consumer 
that are on different subnets, and the producer is not configured for off-subnet 
multicast. 

0x01 0x0814 INVALID PRODUCE/CONSUME DATA FORMAT 
Information in the data segment indicates that the format of the produced and/or 
consumed data is not valid. 

0x01 0x0815 
through 
0xFCFF 

Reserved by CIP 

0x09 Index to 
Element 

ERROR IN DATA SEGMENT 
This general status code shall be returned when there is an error in the data 
segment of a forward open. 
The Extended Status shall be the index to where the error was encountered in the 
Data Segment (Reference section C-1.4.5 — DATA SEGMENT). 
[Ref.] THE CIP NETWORKS LIBRARY, Volume 1 

0x0C Optional OBJECT STATE ERROR 
This general status code shall be returned when the state of the target object of 
the connection prevents the service request from being handled. The Extended 
Status reports the object’s present state. The extended status is optional. 
For example, a target (application) object of the connection may need to be in an 
edit mode before attributes can be set. This is different from a service being 
rejected due to the state of the device. 
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CIP Connection Manager Object Instance Extended Status Codes 
General Status 
(hexa decimal) 

Extended 
Status  

Description 

0x10 Optional DEVICE STATE ERROR 
This general status code shall be returned when the state of the device prevents 
the service request from being handled. The Extended Status reports the device‘s 
present state. The extended status is optional. 
For example, a controller may have a key switch which when set to the “hard run“ 
state causes Service Requests to several different objects to fail (i.e. program 
edits). This general status code would then be returned. 

0x13 None Not enough data. The service did not supply enough data to perform the specified 
operation.  

0x15 None Ton much data. The service supplied more data than was expected. 

Table 66: CIP Connection Manager Object Instance Extended Status Codes 

[Ref.] THE CIP NETWORKS LIBRARY, Volume 1, Common Industrial Protocol (CIPTM), 
Edition 3.8, April 2010 on page 119 to 127 
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11.6 ODM Error Codes 
 

11.6.1 General ODM Error Codes 
 

Error Code (Definition) Value Description 

CODM3_E_INTERNALERROR 0x8004C700 Internal ODM Error 

ODM3_E_DESCRIPTION_NOTFOUND 0x8004C701 Description not found in ODM database 

CODM3_E_WRITEREGISTRY 0x8004C710 Error writing to the registry 

CODM3_E_BAD_REGULAR_EXPRESSION 0x8004C711 Invalid regular expression 

CODM3_E_COMCATEGORIE_MANAGER_ 
FAILED 

0x8004C712 Component Category Manager could not 
be instantiated 

CODM3_E_COMCATEGORIE_ENUMERATION_
FAILED 

0x8004C713 Driver could not be enumerated by the 
Category Manager 

CODM3_E_CREATE_LOCAL_BUFFER 0x8004C714 Error creating local buffers 

CODM3_E_UNKNOWNHANDLE 0x8004C715 Unknown handle 

CODM3_E_QUEUE_LIMIT_REACHED 0x8004C717 Queue size limit for connection reached 

CODM3_E_DATASIZE_ZERO 0x8004C718 Zero data length passed 

CODM3_E_INVALID_DATA 0x8004C719 Invalid data content 

CODM3_E_INVALID_MODE 0x8004C71A Invalid mode 

CODM3_E_DATABASE_READ 0x8004C71B Error reading database 

CODM3_E_CREATE_DEVICE_THREAD 0x8004C750 Error creating device thread 

CODM3_E_CREATE_DEVICE_THREAD_STOP_
EVENT 

0x8004C751 Error creating device thread stop event 

CODM3_E_CLIENT_NOT_REGISTERED 0x8004C752 Client is not registered at the ODM 

CODM3_E_NO_MORE_CLIENTS 0x8004C753 Maximum number of clients reached 

CODM3_E_MAX_CLIENT_CONNECTIONS_ 
REACHED 

0x8004C754 Maximum number of client connections 
reached 

CODM3_E_ENTRY_NOT_FOUND 0x8004C755 Driver/device not found 

CODM3_E_DRIVER_NOT_FOUND 0x8004C757 The requested driver is unknown to the 
ODM 

CODM3_E_DEVICE_ALREADY_LOCKED 0x8004C758 Device is locked by another process 

CODM3_E_DEVICE_UNLOCKED_FAILED 0x8004C759 Device could not be unlocked, lock was 
set by another process 

CODM3_E_DEVICE_LOCK_NECCESSARY 0x8004C75A Operation requires a device lock to be set 

CODM3_E_DEVICE_SUBSCRIPTIONLIMIT 0x8004C75B Maximum number of servers registered for 
this device reached 

CODM3_E_DEVICE_NOTSUBSCRIBED 0x8004C75C Process is not registered as a server on 
this device 

CODM3_E_DEVICE_NO_MESSAGE 0x8004C75D No message available 

CODM3_E_TRANSFERTIMEOUT 0x8004C760 Message transfer timeout 

CODM3_E_MESSAGE_INSERVICE 0x8004C761 Message in service 

Table 67: ODM Error Codes - General ODM Error Codes 
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11.6.2 General ODM Driver Error Codes 
 

Error Code (Definition) Value Description 
CODM3_E_DRV_OPEN_DEVICE 0x8004C7A0 Packet type unsupported by driver 
CODM3_E_DRV_INVALID_IDENTIFIER 0x8004C7A1 Invalid device identifier 
CODM3_E_DRV_DEVICE_PARAMETERS_ 
MISMATCH 

0x8004C7A3 Parameters differ from requested device 

CODM3_E_DRV_BROWSE_NO_DEVICES 0x8004C7A4 No devices found 
CODM3_E_DRV_CREATE_DEVICE_INST 0x8004C7A5 Device instance could not be created 
CODM3_E_DRV_DEVICE_NOMORE_TX 0x8004C7A6 Device connection limit reached 
CODM3_E_DRV_DEVICE_DUPLICATE_TX 0x8004C7A7 Duplicate transmitter ID 
CODM3_E_DRV_DEVICE_NOT_CONFIGURED 0x8004C7A8 Device is not configured 
CODM3_E_DRV_DEVICE_COMMUNICATION 0x8004C7A9 Device communication error 
CODM3_E_DRV_DEVICE_NO_MESSAGE 0x8004C7AA No message available 
CODM3_E_DRV_DEVICE_NOT_READY 0x8004C7AB Device not ready 
CODM3_E_DRV_INVALIDCONFIGURATION 0x8004C7AC Invalid driver configuration 
CODM3_E_DRV_DLINVALIDMODE 0x8004C7C0 Invalid download mode 
CODM3_E_DRV_DLINPROGRESS 0x8004C7C1 Download is active 
CODM3_E_DRV_ULINPROGRESS 0x8004C7C2 Upload is active 

Table 68: ODM Error Codes - General ODM Driver Error Codes 
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11.6.3 cifX Driver Specific ODM Error Codes 
 

 

cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_BOARD_NOT_INITIALIZED 0x8004C001 DRIVER Board not initialized 
DRV_E_INIT_STATE_ERROR 0x8004C002 DRIVER Error in internal init state 
DRV_E_READ_STATE_ERROR 0x8004C003 DRIVER Error in internal read state 
DRV_E_CMD_ACTIVE 0x8004C004 DRIVER Command on this channel is 

active 
DRV_E_PARAMETER_UNKNOWN 0x8004C005 DRIVER Unknown parameter in function 
DRV_E_WRONG_DRIVER_VERSION 0x8004C006 DRIVER Version is incompatible with DLL 
DRV_E_PCI_SET_CONFIG_MODE 0x8004C007 DRIVER Error during PCI set configuration 

mode 

DRV_E_PCI_READ_DPM_LENGTH 0x8004C008 DRIVER Could not read PCI dual port 
memory length 

DRV_E_PCI_SET_RUN_MODE 0x8004C009 DRIVER Error during PCI set run mode 
DRV_E_DEV_DPM_ACCESS_ERROR 0x8004C00A DEVICE Dual port ram not 

accessable(board not found) 
DRV_E_DEV_NOT_READY 0x8004C00B DEVICE Not ready (ready flag failed) 
DRV_E_DEV_NOT_RUNNING 0x8004C00C DEVICE Not running (running flag failed) 
DRV_E_DEV_WATCHDOG_FAILED 0x8004C00D DEVICE Watchdog test failed 
DRV_E_DEV_OS_VERSION_ERROR 0x8004C00E DEVICE Signals wrong OS version 
DRV_E_DEV_SYSERR 0x8004C00F DEVICE Error in dual port flags 
DRV_E_DEV_MAILBOX_FULL 0x8004C010 DEVICE Send mailbox is full 
DRV_E_DEV_PUT_TIMEOUT 0x8004C011 DEVICE PutMessage timeout 
DRV_E_DEV_GET_TIMEOUT 0x8004C012 DEVICE GetMessage timeout 
DRV_E_DEV_GET_NO_MESSAGE 0x8004C013 DEVICE No message available 
DRV_E_DEV_RESET_TIMEOUT 0x8004C014 DEVICE RESET command timeout 
DRV_E_DEV_NO_COM_FLAG 0x8004C015 DEVICE COM-flag not set. Check if Bus is 

running 
DRV_E_DEV_EXCHANGE_FAILED 0x8004C016 DEVICE I/O data exchange failed 
DRV_E_DEV_EXCHANGE_TIMEOUT 0x8004C017 DEVICE I/O data exchange timeout 
DRV_E_DEV_COM_MODE_UNKNOWN 0x8004C018 DEVICE I/O data mode unknown 
DRV_E_DEV_FUNCTION_FAILED 0x8004C019 DEVICE Function call failed 
DRV_E_DEV_DPMSIZE_MISMATCH 0x8004C01A DEVICE DPM size differs from 

configuration 
DRV_E_DEV_STATE_MODE_UNKNOWN 0x8004C01B DEVICE State mode unknown 
DRV_E_DEV_HW_PORT_IS_USED 0x8004C01C DEVICE Output port already in use 
DRV_E_USR_OPEN_ERROR 0x8004C01E USER Driver not opened (device driver not 

loaded) 
DRV_E_USR_INIT_DRV_ERROR 0x8004C01F USER Can't connect to device 
DRV_E_USR_NOT_INITIALIZED 0x8004C020 USER Board not initialized (DevInitBoard 

not called) 
DRV_E_USR_COMM_ERR 0x8004C021 USER IOCTRL function failed 
DRV_E_USR_DEV_NUMBER_INVALID 0x8004C022 USER Parameter DeviceNumber invalid 
DRV_E_USR_INFO_AREA_INVALID 0x8004C023 USER Parameter InfoArea unknown 
DRV_E_USR_NUMBER_INVALID 0x8004C024 USER Parameter Number invalid 
DRV_E_USR_MODE_INVALID 0x8004C025 USER Parameter Mode invalid 
DRV_E_USR_MSG_BUF_NULL_PTR 0x8004C026 USER NULL pointer assignment 
DRV_E_USR_MSG_BUF_TOO_SHORT 0x8004C027 USER Message buffer too small 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_USR_SIZE_INVALID 0x8004C028 USER Parameter Size invalid 
DRV_E_USR_SIZE_ZERO 0x8004C02A USER Parameter Size with zero length 
DRV_E_USR_SIZE_TOO_LONG 0x8004C02B USER Parameter Size too long 
DRV_E_USR_DEV_PTR_NULL 0x8004C02C USER Device address null pointer 
DRV_E_USR_BUF_PTR_NULL 0x8004C02D USER Pointer to buffer is a null pointer 
DRV_E_USR_SENDSIZE_TOO_LONG 0x8004C02E USER Parameter SendSize too large 
DRV_E_USR_RECVSIZE_TOO_LONG 0x8004C02F USER Parameter ReceiveSize too large 
DRV_E_USR_SENDBUF_PTR_NULL 0x8004C030 USER Pointer to send buffer is a null 

pointer 
DRV_E_USR_RECVBUF_PTR_NULL 0x8004C031 USER Pointer to receive buffer is a null 

pointer 

DRV_E_DMA_INSUFF_MEM 0x8004C032 DMA Memory allocation error 
DRV_E_DMA_TIMEOUT_CH4 0x8004C033 DMA Read I/O timeout 
DRV_E_DMA_TIMEOUT_CH5 0x8004C034 DMA Write I/O timeout 
DRV_E_DMA_TIMEOUT_CH6 0x8004C035 DMA PCI transfer timeout 
DRV_E_DMA_TIMEOUT_CH7 0x8004C036 DMA Download timeout 
DRV_E_DMA_DB_DOWN_FAIL 0x8004C037 DMA Database download failed 
DRV_E_DMA_FW_DOWN_FAIL 0x8004C038 DMA Firmware download failed 
DRV_E_CLEAR_DB_FAIL 0x8004C039 DMA Clear database on the device failed 
DRV_E_DEV_NO_VIRTUAL_MEM 0x8004C03C DMA USER Virtual memory not available 
DRV_E_DEV_UNMAP_VIRTUAL_MEM 0x8004C03D DMA USER Unmap virtual memory failed 
DRV_E_GENERAL_ERROR 0x8004C046 DRIVER General error 
DRV_E_DMA_ERROR 0x8004C047 DRIVER General DMA error 
DRV_E_WDG_IO_ERROR 0x8004C048 DRIVER I/O WatchDog failed 
DRV_E_WDG_DEV_ERROR 0x8004C049 DRIVER Device Watchdog failed 
DRV_E_USR_DRIVER_UNKNOWN 0x8004C050 USER Driver unknown 
DRV_E_USR_DEVICE_NAME_INVALID 0x8004C051 USER Device name invalid 
DRV_E_USR_DEVICE_NAME_UKNOWN 0x8004C052 USER Device name unknown 

DRV_E_USR_DEVICE_FUNC_NOTIMPL 0x8004C053 USER Device function not implemented 

DRV_E_USR_FILE_OPEN_FAILED 0x8004C064 USER File could not be opened 

DRV_E_USR_FILE_SIZE_ZERO 0x8004C065 USER File size zero 

DRV_E_USR_FILE_NO_MEMORY 0x8004C066 USER Not enough memory to load file 

DRV_E_USR_FILE_READ_FAILED 0x8004C067 USER File read failed 

DRV_E_USR_INVALID_FILETYPE 0x8004C068 USER File type invalid 

DRV_E_USR_FILENAME_INVALID 0x8004C069 USER Invalid filename 

DRV_E_FW_FILE_OPEN_FAILED 0x8004C06E USER Firmware file could not be opened 

DRV_E_FW_FILE_SIZE_ZERO 0x8004C06F USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_NO_MEMORY 0x8004C070 USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_READ_FAILED 0x8004C071 USER Firmware file read failed 

DRV_E_FW_INVALID_FILETYPE 0x8004C072 USER Firmware file type invalid 

DRV_E_FW_FILENAME_INVALID 0x8004C073 USER Firmware file name not valid 

DRV_E_FW_DOWNLOAD_ERROR 0x8004C074 USER Firmware file download error 

DRV_E_FW_FILENAME_NOT_FOUND 0x8004C075 USER Firmware file not found in the 
internal table 

DRV_E_FW_BOOTLOADER_ACTIVE 0x8004C076 USER Firmware file BOOTLOADER active 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_FW_NO_FILE_PATH 0x8004C077 USER Firmware file no file path 

DRV_E_CF_FILE_OPEN_FAILED 0x8004C078 USER Configuration file could not be 
opend 

DRV_E_CF_FILE_SIZE_ZERO 0x8004C079 USER Configuration file size zero 

DRV_E_CF_FILE_NO_MEMORY 0x8004C07A USER Not enough memory to load 
configuration file 

DRV_E_CF_FILE_READ_FAILED 0x8004C07B USER Configuration file read failed 

DRV_E_CF_INVALID_FILETYPE 0x8004C07C USER Configuration file type invalid 

DRV_E_CF_FILENAME_INVALID 0x8004C07D USER Configuration file name not valid 

DRV_E_CF_DOWNLOAD_ERROR 0x8004C07E USER Configuration file download error 

DRV_E_CF_FILE_NO_SEGMENT 0x8004C07F USER No flash segment in the 
configuration file 

DRV_E_CF_DIFFERS_FROM_DBM 0x8004C080 USER Configuration file differs from 
database 

DRV_E_DBM_SIZE_ZERO 0x8004C083 USER Database size zero 

DRV_E_DBM_NO_MEMORY 0x8004C084 USER Not enough memory to upload 
database 

DRV_E_DBM_READ_FAILED 0x8004C085 USER Database read failed 

DRV_E_DBM_NO_FLASH_SEGMENT 0x8004C086 USER Database segment unknown 

DEV_E_CF_INVALID_DESCRIPT_VERSION 0x8004C096 CONFIG Version of the descript table 
invalid 

DEV_E_CF_INVALID_INPUT_OFFSET 0x8004C097 CONFIG Input offset is invalid 

DEV_E_CF_NO_INPUT_SIZE 0x8004C098 CONFIG Input size is 0 

DEV_E_CF_MISMATCH_INPUT_SIZE 0x8004C099 CONFIG Input size does not match 
configuration 

DEV_E_CF_INVALID_OUTPUT_OFFSET 0x8004C09A CONFIG Invalid output offset 

DEV_E_CF_NO_OUTPUT_SIZE 0x8004C09B CONFIG Output size is 0 

DEV_E_CF_MISMATCH_OUTPUT_SIZE 0x8004C09C CONFIG Output size does not match 
configuration 

DEV_E_CF_STN_NOT_CONFIGURED 0x8004C09D CONFIG Station not configured 

DEV_E_CF_CANNOT_GET_STN_CONFIG 0x8004C09E CONFIG Cannot get the Station 
configuration 

DEV_E_CF_MODULE_DEF_MISSING 0x8004C09F CONFIG Module definition is missing 

DEV_E_CF_MISMATCH_EMPTY_SLOT 0x8004C0A0 CONFIG Empty slot mismatch 

DEV_E_CF_MISMATCH_INPUT_OFFSET 0x8004C0A1 CONFIG Input offset mismatch 

DEV_E_CF_MISMATCH_OUTPUT_OFFSET 0x8004C0A2 CONFIG Output offset mismatch 

DEV_E_CF_MISMATCH_DATA_TYPE 0x8004C0A3 CONFIG Data type mismatch 

DEV_E_CF_MODULE_DEF_MISSING_NO_SI 0x8004C0A4 CONFIG Module definition is missing,(no 
Slot/Idx) 

Table 69: cifX Driver Specific ODM Error Codes 

 

 



Error Codes 141/155 

DTM for EtherNet/IP Adapter Devices | Configuration of EtherNet/IP Adapter Devices  
DOC061202OI13EN | Revision 13 | English | 2020-01 | Released | Public  © Hilscher, 2006-2020 

11.7 Error Codes cifX Device Driver and netX Driver 
 

11.7.1 Generic Error Codes 
 
 

Error Code (Definition) Value Description 
CIFX_INVALID_POINTER  0x800A0001 Invalid pointer (NULL) passed to driver 
CIFX_INVALID_BOARD  0x800A0002 No board with the given nameindex 

available 
CIFX_INVALID_CHANNEL  0x800A0003 No channel with the given index available 
CIFX_INVALID_HANDLE 0x800A0004 Invalid handle passed to driver 
CIFX_INVALID_PARAMETER  0x800A0005 Invalid parameter 
CIFX_INVALID_COMMAND 0x800A0006 Invalid command 
CIFX_INVALID_BUFFERSIZE  0x800A0007 Invalid buffer size 
CIFX_INVALID_ACCESS_SIZE 0x800A0008 Invalid access size 
CIFX_FUNCTION_FAILED  0x800A0009 Function failed 
CIFX_FILE_OPEN_FAILED  0x800A000A File could not be opened 
CIFX_FILE_SIZE_ZERO 0x800A000B File size is zero 
CIFX_FILE_LOAD_INSUFF_MEM  0x800A000C Insufficient memory to load file 
CIFX_FILE_CHECKSUM_ERROR  0x800A000D File checksum compare failed 
CIFX_FILE_READ_ERROR  0x800A000E Error reading from file 
CIFX_FILE_TYPE_INVALID  0x800A000F Invalid file type 
CIFX_FILE_NAME_INVALID 0x800A0010 Invalid file name 
CIFX_FUNCTION_NOT_AVAILABLE 0x800A0011 Driver function not available 
CIFX_BUFFER_TOO_SHORT 0x800A0012 Given buffer is too short 
CIFX_MEMORY_MAPPING_FAILED  0x800A0013 Failed to map the memory 
CIFX_NO_MORE_ENTRIES 0x800A0014 No more entries available 
CIFX_CALLBACK_MODE_UNKNOWN  0x800A0015 Unkown callback handling mode 
CIFX_CALLBACK_CREATE_EVENT_FAILED  0x800A0016 Failed to create callback events 
CIFX_CALLBACK_CREATE_RECV_BUFFER  0x800A0017 Failed to create callback receive buffer 

Table 70: Generic Error Codes 
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11.7.2 Generic Driver Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DRV_NOT_INITIALIZED  0x800B0001 Driver not initialized 
CIFX_DRV_INIT_STATE_ERROR 0x800B0002 Driver init state error 
CIFX_DRV_READ_STATE_ERROR 0x800B0003 Driver read state error 
CIFX_DRV_CMD_ACTIVE 0x800B0004 Command is active on device 
CIFX_DRV_DOWNLOAD_FAILED  0x800B0005 General error during download 
CIFX_DRV_WRONG_DRIVER_VERSION 0x800B0006 Wrong driver version 
CIFX_DRV_DRIVER_NOT_LOADED  0x800B0030 CIFx driver is not running 
CIFX_DRV_INIT_ERROR 0x800B0031 Failed to initialize the device 
CIFX_DRV_CHANNEL_NOT_INITIALIZED  0x800B0032 Channel not initialized (xOpenChannel not 

called) 
CIFX_DRV_IO_CONTROL_FAILED  0x800B0033 IOControl call failed 
CIFX_DRV_NOT_OPENED( 0x800B0034 Driver was not opened 
CIFX_DRV_DOWNLOAD_STORAGE_UNKNOWN 0x800B0040 Unknown download storage type 

(RAMFLASH based) found 
CIFX_DRV_DOWNLOAD_FW_WRONG_CHANNE
L 

0x800B0041 Channel number for a firmware download 
not supported 

CIFX_DRV_DOWNLOAD_MODULE_NO_BASEOS  0x800B0042 Modules are not allowed without a Base 
OS firmware 

Table 71: Generic Driver Error Codes 
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11.7.3 Generic Device Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DEV_DPM_ACCESS_ERROR 0x800C0010 Dual port memory not accessable (board 

not found) 
CIFX_DEV_NOT_READY  0x800C0011 Device not ready (ready flag failed) 
CIFX_DEV_NOT_RUNNING  0x800C0012 Device not running (running flag failed) 
CIFX_DEV_WATCHDOG_FAILED  0x800C0013 Watchdog test failed 
CIFX_DEV_SYSERR 0x800C0015 Error in handshake flags 
CIFX_DEV_MAILBOX_FULL 0x800C0016 Send mailbox is full 
CIFX_DEV_PUT_TIMEOUT  0x800C0017 Send packet timeout 
CIFX_DEV_GET_TIMEOUT  0x800C0018 Receive packet timeout 
CIFX_DEV_GET_NO_PACKET  0x800C0019 No packet available 
CIFX_DEV_MAILBOX_TOO_SHORT  0x800C001A Mailbox too short 
CIFX_DEV_RESET_TIMEOUT  0x800C0020 Reset command timeout 
CIFX_DEV_NO_COM_FLAG  0x800C0021 COM-flag not set 
CIFX_DEV_EXCHANGE_FAILED  0x800C0022 IO data exchange failed 
CIFX_DEV_EXCHANGE_TIMEOUT 0x800C0023 IO data exchange timeout 
CIFX_DEV_COM_MODE_UNKNOWN 0x800C0024 Unknown IO exchange mode 
CIFX_DEV_FUNCTION_FAILED  0x800C0025 Device function failed 
CIFX_DEV_DPMSIZE_MISMATCH 0x800C0026 DPM size differs from configuration 
CIFX_DEV_STATE_MODE_UNKNOWN 0x800C0027 Unknown state mode 
CIFX_DEV_HW_PORT_IS_USED  0x800C0028 Device is still accessed 
CIFX_DEV_CONFIG_LOCK_TIMEOUT  0x800C0029 Configuration locking timeout 
CIFX_DEV_CONFIG_UNLOCK_TIMEOUT  0x800C002A Configuration unlocking timeout 
CIFX_DEV_HOST_STATE_SET_TIMEOUT 0x800C002B Set HOST state timeout 
CIFX_DEV_HOST_STATE_CLEAR_TIMEOUT  0x800C002C Clear HOST state timeout 
CIFX_DEV_INITIALIZATION_TIMEOUT 0x800C002D Timeout during channel initialization 
CIFX_DEV_BUS_STATE_ON_TIMEOUT 0x800C002E Set Bus ON Timeout 
CIFX_DEV_BUS_STATE_OFF_TIMEOUT  0x800C002F Set Bus OFF Timeout 
CIFX_DEV_MODULE_ALREADY_RUNNING 0x800C0040 Module already running 
CIFX_DEV_MODULE_ALREADY_EXISTS  0x800C0041 Module already exists 

Table 72: Generic Device Error Codes 
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11.8 Error Codes netX Driver 
 

11.8.1 CIFX API Transport Error Codes 
 

Error Code (Definition) Value Description 
CIFX_TRANSPORT_SEND_TIMEOUT 0x800D0001 Time out while sending data 
CIFX_TRANSPORT_RECV_TIMEOUT 0x800D0002 Time out waiting for incoming data 
CIFX_TRANSPORT_CONNECT  0x800D0003 Unable to communicate to the deviceno 

answer 
CIFX_TRANSPORT_ABORTED  0x800D0004 Transfer has been aborted due to keep 

alive timeout or interface detachment 
CIFX_CONNECTOR_FUNCTIONS_READ_ERRO
R  

0x800D0010 Error reading the connector functions from 
the DLL 

CIFX_CONNECTOR_IDENTIFIER_TOO_LONG  0x800D0011 Connector delivers an identifier longer 
than 6 characters 

CIFX_CONNECTOR_IDENTIFIER_EMPTY 0x800D0012 Connector delivers an empty dentifier 
CIFX_CONNECTOR_DUPLICATE_IDENTIFIER  0x800D0013 Connector identifier already used 

Table 73: CIFX API Transport Error Codes 

 

 

11.8.2 CIFX API Transport Header State Error Codes 
 

Error Code (Definition) Value Description 
CIFX_TRANSPORT_ERROR_UNKNOWN  0x800E0001 Unknown error code in transport header 
CIFX_TRANSPORT_CHECKSUM_ERROR 0x800E0002 CRC16 checksum failed 
CIFX_TRANSPORT_LENGTH_INCOMPLETE  0x800E0003 Transaction with inclomplete length 

detected 
CIFX_TRANSPORT_DATA_TYPE_UNKOWN 0x800E0004 Device does not support requested data 

type 
CIFX_TRANSPORT_DEVICE_UNKNOWN 0x800E0005 Device not availableunknown 
CIFX_TRANSPORT_CHANNEL_UNKNOWN  0x800E0006 Channel not availableunknown 
CIFX_TRANSPORT_SEQUENCE 0x800E0007 Sequence error detected 
CIFX_TRANSPORT_BUFFEROVERFLOW 0x800E0008 Buffer overflow detected 
CIFX_TRANSPORT_RESOURCE 0x800E0009 Device signals out of resources 
CIFX_TRANSPORT_KEEPALIVE  0x800E000A Device connection monitoring error (Keep 

alive) 
CIFX_TRANSPORT_DATA_TOO_SHORT( 0x800E000B Received transaction data too short 

Table 74: CIFX API Transport Header State Error Codes 
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11.9 ODM Error Codes DBM V4 
 

 

ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_MD5_INVALID 0XC004C810 Checksum invalid 
CDBM_E_INTERNALERROR 0XC004C811 Internal Error 
CDBM_W_WRITEREGISTRY 0X8004C812 Error writing to the registry 
CDBM_E_UNEXPECTED_VALUE_ 
IN_OLD_HEADER_FORMAT 

0XC004C813 Error in a file containing the old DBM 
Header format. 

CDBM_E_CHECKSUM_INVALID 0XC004C814 The Checksum of the old Header is invalid 
CDBM_E_DB_ALREADY_LOADED_ FORMAT 0XC004C815 A database is already loaded 
CDBM_E_NO_VALID_TRANSACTION 0XC004C816 No valid transaction handle given 
CDBM_E_STD_STRUCT_ERROR 0XC004C817 An error occurred during validation of data 
CDBM_E_UNSUPPORTED_ 
DATA_TYPE_FORMAT 

0XC004C818 Unsupported DataType 

CDBM_W_CLASS_DELETED_ FORMAT 0X8004C819 
(Warning) 

Using an Object which is marked as 
deleted 

CDBM_W_CLIENT_DISCONNECTED 0X8004C81A 
(Warning) 

A Client has already an outstanding 
connection to a Table. The connection is 
now destroyed. 

CDBM_E_STRUCTURE_DEFINITION_ INVALID 0XC004C81B A structure definition of an Element in a 
Table is invalid 

CDBM_E_NO_DATA_AVAILABLE 0XC004C81C No data available for this operation 
CDBM_E_NO_VALID_STRUCTURE 0XC004C81D No valid structure available for this 

operation 
CDBM_E_NO_TOGGLE_STRING_ FOUND 0XC004C81E No Toggle string found for this number 
CDBM_E_ELEMENT_OUT_OF_RANGE 0XC004C81F An element wasn’t found in the Record of 

a Table 
CDBM_E_ELEMENT_NOT_IN_ TABLE 0XC004C820 The element is not part of the Table 
CDBM_E_CANNOT_CONVERT_ 
INTO_CLIENT_TYPE 

0XC004C821 The data can't be converted into the Client 
type 

CDBM_E_TRANSACTION_ ALREADY_OPEN 0XC004C822 A transaction is already open. Please 
close this one first before opening a new 
one. 

CDBM_I_OLD_WITHOUT_HEADER 0X4004C823 
(Informational) 

Use of an old DBM file Format without 
Header 

CDBM_E_HR_FROM 0XC004C824 An HRESULT was received from a 
Subroutine 

CDBM_E_PARAMETER 0XC004C825 A Parameter is invalid 
CDBM_E_NOTIMPL 0XC004C826 Method is currently not implemented 
CDBM_E_OUTOFMEMORY 0XC004C827 Out of memory 
CDBM_E_NO_OPEN_TRANSACTION 0XC004C828 No transaction open 
CDBM_E_NO_CONTENTS 0XC004C829 No contents available 
CDBM_REC_NO_NOT_FOUND 0XC004C82A Record not found 
CDBM_STRUCTURE_ELEMENT_ NOT_FOUND 0XC004C82B Element of the Structure not found 
CDBM_E_NO_MORE_RECORDS_ IN_TABTYPE 0XC004C82C Table type 3 can contain only one record 
CDBM_E_WRITE 0XC004C82D The data in the VARIANT must be given in 

a SafeArray 
CDBM_E_WRITE_NO_PARRAY 0XC004C82E The VARIANT contains no valid [parray] 

element 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_WRITE_CANT_ ACCESS_DATA 0XC004C82F Unable to access SafeArray Data in the 

VARIANT 
CDBM_E_WRITE_DATA 0XC004C830 To write the data of this Element it must be 

given as a BSTR, or as an Array of 
VT_UI1/VT_I1 

CDBM_E_WRITE_BSTR_E1 0XC004C831 The BSTR string must have an even 
length. 

CDBM_E_WRITE_BSTR_E2 0XC004C832 The BSTR string must contain only hex 
digits (0..9 and a/A..f/F). 

CDBM_E_WRITE_CANT_ INTERPRET_ARRAY 0XC004C833 Unable to interpret data in the SafeArray. 
CDBM_E_WRITE_VT_ERROR 0XC004C834 Data type in the SafeArray is not VT_UI1 

or VT_I1. 
CDBM_E_WRITE_LENGTH 0XC004C835 Data length is invalid for write operation of 

this type. 
CDBM_WRITE_ELEMENT 0XC004C836 Element not found in the Record of the 

Table 
CDBM_MIN_MAX_ERROR 0XC004C837 Can't write data because of min underflow 

or max overflow 
CDBM_TABLE_EXIST 0XC004C838 Table already exist in the database 
CDBM_MIN_MAX_INVALID 0XC004C839 The Min value is greater than the Max 

Value 
CDBM_DEF_MIN_MAX_INVALID 0XC004C83A The Default Value is not in the range 

between the Min value and the Max Value 
CDBM_CANT_CHANGE_STRUCTURE_ 
WHILE_RECORDS_EXIST 

0XC004C83B It's not allowed to change the structure 
while Records exist in the Table 

CDBM_NEW_STRUCT_NEEDS_TYPE 0XC004C83C In a newly added structure the data type 
must be set also 

CDBM_VALUE_ERROR 0XC004C83D Range error while validating a value 
CDBM_DATATYPE_ UNSUPPORTED_IN_RCS 0XC004C83E The data type is unsupported in the RCS 

file format 
CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_RCS_RANGE 

0X4004C83F 
(Informational) 

The count of Tables exceeds the RCS 
range of Tables. This can cause problems 
if the file is downloaded to RCS Systems 

CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_OLDDBM_RANGE 

0X4004C840 
(Informational) 

The count of Tables exceeds the 
DBM32.DLL range of Tables. This can 
cause problems if the file is used with older 
Tools using the DBM32.DLL 

CDBM_UNSUPPORTED_DATATYPE_ 
IN_RCS_MODE 

0XC004C841 The Data type is not compatible with the 
old database format 

CDBM_WRITE_UNSTRUCTURED_1 0XC004C842 The data of an unstructured record can 
only be written with the 'Write' Method not 
with 'WriteElement'. 

CDBM_READ_UNSTRUCTURED_1 0XC004C843 The data of an unstructured record can 
only be read with the 'Read' Method not 
with 'ReadElement' 

CDBM_WRITE_DATA_LENGTH_ INVALID 0XC004C844 The given data length doesn’t correspond 
with the expected data length. 

CDBM_UNKNOWN_VIEW_MODE 0XC004C845 The View Mode is unknown. 
CDBM_E_DIAG_TABLE 0XC004C846 It doesn’t make much sense to add or 

delete records from a diagnostic table 
because those changes are never saved. 

CDBM_E_ADR_STRING_ERROR 0XC004C847 The given Address string doesn’t fit the 
required format of this type where all 
address bytes must be in the range 
between 0 and FF 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_ERROR_FROM_VAR_ CHANGE_TYPE 0XC004C848 Function VariantChangeType return an 

error when trying to convert the Parameter 
CDBM_E_MINERROR 0XC004C849 Error while comparing the Value with the 

lower range 
CDBM_E_MAXERROR 0XC004C84A Error while comparing the Value with the 

upper range 
CDBM_E_RANGE_ERROR 0XC004C84B Value out of Range 
CDBM_E_TABLE_TYPE1 0XC004C84C Table type 1 doesn’t have a unique record 

length over all records 
CDBM_E_TABLE_TYPE3_ ADDREC 0XC004C84D Table type 3 doesn’t allow to insert more 

than one Record 
CDBM_E_TABTYPE1 0XC004C84E It's not allowed to insert more Records 

than structure definitions in Table Type 1 
CDBM_E_TOGGLE_NOT_FOUND 0XC004C84F Could not find the string for this value in 

the list of valid toggle strings 
CDBM_E_TOGGLE_VALUE_IS_ EMPTY_STRING 0XC004C850 The toggle string for this value is empty. 
CDBM_VARIANT2BYTEARRAY_ ERROR 0XC004C851 Error during conversion of Variant to byte 

array 
CDBM_E_SET_ELEM_PROP_ DEPENDENCY 0XC004C852 The Toggle Type needs also the additional 

string and the additional number  entries in 
the Method 

CDBM_E_TABTYPE1_REC_ 
DOESNT_CORRESPOND_ WITH_ELEMENT 

0XC004C853 When reading the records of Table type 1 
elementwise the record number must 
correspond with the element number 

CDBM_TABTYPE1_NO_DATA_ 
FOUND_FOR_RECORD 

0XC004C854 When reading the records of Table type 1 
and structure definitions are present it's 
assumed that for each structure element a 
corresponding record must exist 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NE_RECORD 

0XC004C855 When writing the records of Table type 1 
elementwise and structure definitions are 
present it's only allowed to write the 
corresponding element number in each 
record 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NOT_FOUND 

0XC004C856 When writing the records of Table type 1 
with an array and structure definitions are 
present it's assumed that a corresponding 
element number of this record exist 

CDBM_I_TABLE_NAME_EXCEEDS_ 
RCS_RANGE 

0X4004C857 
(Informational) 

The Table name exceeds the maximum 
length of RCS compatible Table names 

CDBM_W_CUT_STRING 0X8004C858 
(Warning) 

The string exceeds the maximum length 
and will be limited to the maximum length 

CDBM_I_STRING_TOO_SHORT 0X4004C859 
(Informational) 

The string is below the minimum length. 
The minimum length will be reduced. 

CDBM_I_STRING_TOO_LONG 0X4004C85A 
(Informational) 

The string is exceeding the maximum. The 
maximum length will be extended. 

CDBM_E_STRING_TOO_SHORT 0XC004C85B 
(Error) 

The string is below the minimum length. 

CDBM_E_STRING_TOO_LONG 0XC004C85C 
(Error) 

The string is exceeding the maximum 
length 

CDBM_E_WRONG_TYPE_ FOR_WRITE 0XC004C85D Writing on the Element type with the given 
Data type is not implemented 

CDBM_E_NO_APPEND_IN_ 
STRUCTURED_RECORDS 

0XC004C85E Method IDbmRecord::AppendData is not 
allowed for structured records 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_DATA_UNAVAILABLE 0XC004C85F No data available 
CDBM_E_CANT_CONVERT_ INTO 0XC004C860 Unable to convert the value into the 

Element type 
CDBM_E_DBM_FILE_OVERFLOW 0XC004C861 You try to write a RCS like database which 

needs too much bytes 
CDBM_E_PW_ERROR 0XC004C862 Password not correct 
CDBM_E_FILELENGTH_CORRUPT 0XC004C863 The file length doesn’t correspond to the 

length given in the Header. 
CDBM_E_STRUCT_TYPE 0XC004C864 Error in the file. 
CDBM_E_MD5SUM_INVALID 0XC004C865 MD5 sum invalid 
CDBM_E_STRUCT_LENGTH 0XC004C866 Error in the expected and given structure 

length at a specific offset in the file. 
CDBM_E_APPEND 0XC004C867 Append of data is only allowed if the 

Record contains only one data field and 
the field type will support this 

CDBM_APPEND_NOT_ SUPPORTED 0XC004C868 Append of Data not supported by this filed 
type 

CDBM_DATA_TYPE_APPEND_ ERROR 0XC004C869 Can't append Data of this type. 
CDBM_E_UNSTRUCTURED_TABLE_ 
DOESNT_SUPPORT_LENGTH 

0XC004C86A A Table without structure information 
doesn’t support a record length 

CDBM_E_DISABLED_WHILE_ 
TRANSACTION_IS_OPEN 

0XC004C86B The Method is disabled while a transaction 
is open. Please close this one first and call 
the Method again. 

CDBM_E_UNABLE_TO_CALL_ 
READ_ON_LINKED_LIST 

0XC004C86C The Method is disabled on a LinkedList 
type. Please use the IRecordCollection on 
this type. 

CDBM_E_ELEMENT_HAS_NO_ 
SUBSTRUCTURE 

0XC004C86D An Element from a Table has no 
substructure 

CDBM_STRUCT_ERROR_FROM_ 
VAR_CHANGE_TYPE 

0XC004C86E Error from calling VariantChangeType 

CDBM_E_FOREIGNKEY_DEF 0XC004C86F The definition of a FOREIGNKEY must 
contain the name of the related Table in 
the description and this Table must exist at 
this time 

CDBM_E_FOREIGNKEY_ REF_TAB 0XC004C870 The description of a FOREIGNKEY must 
refer to a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_E_KEY 0XC004C871 To create a Record Collection with a KEY 
it's necessary to have the data type KEY at 
the first position in all Records of the 
searched Table 

CDBM_E_KEY_TABLE_TYPE 0XC004C872 This Method needs a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_DATATYPE_NOT_ IMPLEMENTED 0XC004C873 This data type is currently not implemented 
CDBM_INSERT_POS_NOT_ FOUND 0XC004C874 The position of the Record where the new 

one should be inserted wasn’t found 

CDBM_E_INSERT_REC_QI 0XC004C875 Error during insertion of a Record 
CDBM_E_TAB_PROP 0XC004C876 Invalid Property in Table 
CDBM_E_KEY_NOT_FOUND 0XC004C877 The KEY wasn’t found in the Table 
CDBM_E_KEY_INVALID 0XC004C878 The KEY is invalid for this operation 

Table 75: ODM Error Codes DBM V4 
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12 Appendix 
12.1 User Rights 

User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Settings, Configuration, Description and Diagnosis 
panes of the EtherNet/IP Adapter DTM you do not need special user rights. 
Also all users can select the decimal or hexadecimal Display mode or sort 
table entries. 
 

 
Note: To edit, set or configure the parameters of the Settings and 
Configuration panes, you need user rights for Maintenance, for Planning 
Engineer or for Administrator. 

 

The Device Description panes do not contain any editable elements. The 
indicated values in are only for information purposes. 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

12.1.1 Settings 
 Observer Operator Maintenanc

e 
Planning 
Engineer 

Adminis-
trator 

Driver D D X X X 
 Verify or adapt Driver Settings  - - X X X 
 Configuring netX Driver - - X X X 
Device Assignment D D X X X 
 Scanning for Devices - - X X X 
Selecting the Device (with or 
without firmware) 

- - X X X 

Selecting the Device once more 
(with Firmware) 

- - X X X 

Firmware Download D D X X X 

Table 76: Settings (D = Displaying, X = Editing, Configuring) 

 

12.1.2 Configuration 
 Observer Operator Maintenance Planning 

Engineer 
Administrator 

Configuration D D X X X 

     General D D X X X 
     Connection D D X X X 

     Electronic Keying D D X X X 

     Assembly D D X X X 

     Device Settings D D X X X 

Table 77: Configuration (D = Displaying, X = Editing, Configuring) 
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12.5 Glossary 
Assembly 

Connection Point 

CIP 

Common Industrial Protocol  (Control and Information Protocol) 

DHCP 

Dynamic Host Configuration Protocol 

DLR 

Device Level Ring 

Protocol that helps in redundant communication with EtherNet / IP to 
increase system stability in a ring topology. 

DNS 

Domain Name Service. 

DTM 

Device Type Manager. 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration or for diagnosis of device. 

EDS 

An Electronic Data Sheet (EDS) provides information necessary to access 
and alter the configurable parameters of a device. An Electronic Data Sheet 
(EDS) is an external file that contains information for the device.  

EtherNet/IP 

EtherNet/Industrial Protocol (CIP on Ethernet) 

EtherNet/IP Scanner 

A Scanner exchanges real-time I/O data with Adapters and Scanners. This 
type of node can respond to connection requests and can also initiate 
connections on its own. 

EtherNet/IP-Adapter 

An Adapter emulates functions provided by traditional rack-adapter 
products. This type of node exchanges real-time I/O data with a Scanner 
Class product. It does not initiate connections on its own. 

FDT 

Field Device Tool 
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FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers.  

MDI 

Medium-dependent interface 

The media-dependent interface is in the information technology part of the 
transmitter/receiver unit of a network device. It forms the mechanical 
connection between the physical interface (PHY) and the transport medium 
(cable). In general, the connection of a network adapter for the network 
cable - this means the network socket - is named this way. Especially in 
distribution devices (hubs, switches) this term has prevailed for the 
individual connections (ports). [Source: Wikipedia] 

ODMV3 

The Online-Data-Manager Version 3 (ODMV3) is an application interface. 
The ODMV3 works as a server, which can be run as an out-proc server or 
system service. Its task is to provide different applications (e. g. 
SYCON.net), access to multiple devices and even share one device 
amongst several applications. 

TCP/IP 

Transmission Control Protocol / Internet Protocol 

UDP 

User Datagram Protocol. 
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